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Introduction

 

SOFTmax

 

¨

 

 PRO is designed for use with Molecular DevicesÕ MAXline 
Microplate Readers (Emax

 

ª

 

, Vmax

 

¨

 

, UVmax

 

ª

 

, THERMOmax

 

ª

 

, and 
VERSAmax

 

ª

 

), Microplate Spectrophotometers (SPECTRAmax

 

¨

 

), and 
Microplate Spectroßuorometers (SPECTRAmax GEMINI or GEMINI XS). 
SOFTmax PRO allows you to create Þles containing all of the parameters 
required for acquiring and analyzing data from any MAXline instrument. 
SOFTmax PRO is available in either a Macintosh or Windows format. The 
Macintosh version of the software is a fat binary application that includes 
native code for both 68K and Power Macintosh computers. The Windows ver-
sion is a 32-bit application that is Windows 95/98/2000 and Windows NT 4.0 
compliant.

SOFTmax PRO is powerful, yet easy to use. It performs three major functions:

¥

 

Instrument Control

 

ÑSOFTmax PRO allows you to set up and run a com-
plete assay. Instrument settings can be saved as a protocol Þle and used 
repeatedly for reading different microplates. All stand-alone instrument 
functions can be controlled using the software. In addition, SOFTmax PRO 
provides capabilities that are not available when using MAXline instru-
ments in stand-alone mode (for example, user-deÞned kinetic run times, 
read intervals, Automix

 

ª

 

 parameters, and more).

¥

 

Data Collection

 

ÑSOFTmax PRO collects and stores all raw data received 
from the instrument. Data is displayed on the computer screen in a grid for-
mat that corresponds to the wells in a microplate (all instruments) or indi-
vidual cuvettes (SPECTRAmax 

 

PLUS 

 

or

 

 PLUS

 

384

 

 only). How the data is 
shown depends on other settings made using the software.

¥

 

Data Reduction and Plotting

 

ÑYou can reduce the data using built-in for-
mulas or you can deÞne custom reduction formulas. More than one reduc-
tion can be shown and results from different microplates and/or cuvettes 
can be compared within the same experiment.

Four read modes are possible using SOFTmax PRO. Three may be performed 
in either a microplate (Plate section) or in a cuvette (CuvetteSet section); the 
last may be performed only in a microplate. Which read modes are available 
depend upon which instrument you are using.

¥

 

Endpoint

 

ÑA single reading is made at one or more wavelengths (up to six 
separate wavelengths can be chosen using SPECTRAmax instruments). 
Default values reported are optical density (OD), relative ßuorescence units 
(RFU), or relative luminescence units (RLU), depending on the instrument 
type.

¥

 

Kinetic

 

ÑData is collected over time and the default display is OD or RFU 
or RLU vs. time. Multiple readings are made at regular intervals which you 
deÞne. Default data reductions for kinetic data are Vmax, Vmax per Sec, 
Time to Vmax, or Onset Time.

¥

 

Spectrum

 

Ñ(SPECTRAmax instruments) Absorbance or ßuorescence data is 
collected across a spectrum of wavelengths and displayed as OD, RFU, or 
RLU versus wavelength. The default reduction displays the wavelength 
that corresponds to the maximum signal.
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¥

 

Well Scan

 

Ñ(SPECTRAmax GEMINI and GEMINI XS only) Fluorescence 
data is collected from a single well in a microplate using one of several 
scan patterns up to a maximum number of points. Data is displayed in gray 
scale by default; readings from multiple wavelength pairs can be shown 
separately or together (if together, they are displayed in different col-
ors). 

In addition to these read modes, SOFTmax PRO handles data from either 
absorbance instruments or those using ßuorescence/luminescence.

For optical density mode instruments, data reduction may be cus-
tomized with any read mode and any of the read modes can display 
data as %Transmittance or OD.

SOFTmax PRO can collect data from one or more microplates and/or one or 
more cuvettes and store it in a single data Þle, using the same or different 
instrument settings for different microplates or cuvettes. For example, micro-
plates containing different samples could be read using the same or different 
modes, all within the same experiment Þle.

 

New to SOFTmax PRO?

 

If you have not used SOFTmax PRO before, Molecular Devices recommends 
that you install the software and then proceed to Chapter 7 which provides a 
tutorial that will guide you through the basics of using SOFTmax PRO.

 

WhatÕs New in SOFTmax PRO Version 3.1

 

SPECTRAmax 
GEMINI and 
GEMINI XS Features

 

¥ SOFTmax PRO version 3.1 supports all the features of the new 
SPECTRAmax GEMINI XS instrument, including an AutoPMT setting for 
spectrum readings (also applies to GEMINI).

¥ A well scanning mode has been added, allowing maximum surface area 
detection for whole cell assays. Readings can be made in different patterns, 
with a user-deÞned number of points. Multiple readings can be made to 
accommodate non-conßuent patterns of cells grown in tissue culture plates.

¥ Minimum kinetic interval calculations have been updated, as have calcula-
tions for large-well plates.

¥ For excitation scans, excitation Þlters can be chosen automatically or you 
can choose no Þlter.

NOTE:
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SPECTRAmax 

 

PLUS

 

384

 

 

 

Features

 

¥ SOFTmax PRO version 3.1 supports all the features of the new 
SPECTRAmax 

 

PLUS

 

384

 

 instrument. The main feature enhancement for this 
instrument is the ability to read 384-well plates.

¥ The ability to choose between wavelength or column (default) priority 
readings has been added to endpoint mode (chosen via Instrument 
Settings)

 

.

 

¥ These instruments can now use Speed Read in endpoint mode (chosen via 
Instrument Settings)

 

.

 

¥ Minimum kinetic interval calculations have been updated, as have calcula-
tions for large-well plates.

 

Interprocess Messaging 
Update

 

¥ One command has been added to the interprocess messaging repertoire: 
ÒexportasÓ which allows information to be exported from SOFTmax PRO 
3.1 in the standard SOFTmax PRO format for use in other programs.

 

Password Protection 
Update

 

¥ Password protection has been updated to further encrypt passwords within 
Þles.

 

Macintosh OS 9 
Support

 

¥ The methods for Þnding, opening, and saving Þles have changed with 
Macintosh OS 9. These navigation services are supported by SOFTmax PRO 
version 3.1 while maintaining compatibility with earlier OS versions.
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About the Documentation

 

The SOFTmax PRO documentation set consists of this manual, an on-line 
help system, a written tutorial, and a formula reference manual. Additional 
documents on disk may also be provided to cover the latest information 
regarding the software. An outline of the contents of this manual follows, 
along with introductory information that should help you get started using 
SOFTmax PRO.

Screens and parts of screens represented in this manual may depict 
either the Macintosh or the Windows version of the software. The 
two interfaces are quite similar, but bear subtle differences such as 
where the Help menu is located, etc. Depending upon which com-
puter platform you are using, which operating system you are using, 
and the type of screen that is depicted, your screen may look differ-
ent from the one shown. Note that Macintosh screens are depicted 
using OS versions 7 through 9.

¥ The rest of this chapter, ÒWelcome to SOFTmax PRO,Ó provides introduc-
tory information regarding the program and its features. A glossary of 
terms is included at the end of this chapter.

¥ Chapter 2, ÒInstallation,Ó contains basic information about installing the 
program on your computer and making sure the correct connections are 
made between the computer and the instrument.

¥ Chapter 3, ÒSOFTmax PRO Overview,Ó explains how SOFTmax PRO is 
organized and how it is used with the MAXline instrument.

¥ Chapter 4, ÒReading Microplates and Cuvettes,Ó contains instructions 
regarding how to prepare for and conduct a reading using SOFTmax PRO. 

¥ Chapter 5, ÒDisplaying and Analyzing Data,Ó describes how the data is dis-
played during and after a reading and how this data display can be custom-
ized. Additionally it describes data reduction and the different means for 
analyzing the raw data received from the MAXline instrument.

¥ Chapter 6, ÒFile Management and Printing,Ó explains the printing options 
available within SOFTmax PRO, along with how to customize reports. 
Other topics include managing Þles and importing, exporting, copying, 
pasting, and duplicating data, both within SOFTmax PRO as well as to and 
from other external programs.

¥ Chapter 7, ÒTutorials,Ó provides a written tutorial that will help you learn 
the basics of working with SOFTmax PRO if you are a new user.

¥ Chapter 8, ÒTroubleshooting,Ó describes alert messages that may appear 
while using SOFTmax PRO and what to do if they occur. Other information 
in this chapter pertains to possible communication problems with the 
MAXline instrument and other computer-related issues.

This manual assumes that you are familiar with the basic operating environ-
ment of your computer. We recommend that you become familiar with 
your computerÕs operating environment prior to installing and using 
SOFTmax PRO.

NOTE:
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Conventions Used in This Manual

 

This manual uses visual cues and standard text formats as follows.

 

Visual Cues

 

The following typographic conventions are used in this manual.

 

Format Meaning

 

Menu Item

 

Menu titles and menu items.

 

Text Entry/Key Name

 

Entries that you type from the keyboard or keys that 
you press on the keyboard. Information shown in this 
font should be entered exactly as it appears.

 

Text Entry

 

Placeholders for information you must provide. for 
Example, if you are asked to type 

 

filename

 

, you would 
type the actual name for the Þle instead of the word 
shown in this italic font.

 

[Drawer]

 

Buttons shown on the screen. Note that sometimes an 
actual representation of the button may be shown.

The accompanying text applies only to SOFTmax PRO for Macintosh.

The accompanying text applies only to SOFTmax PRO for Windows.

 

Keyboard Formats

 

Key designations, combinations, and sequences appear in the following 
formats.

 

Format Meaning

 

z

 

Key

 

Selections on the Macintosh can be made using the mouse, but 
often shortcuts are available using the keyboard. Shortcuts com-
monly use the command (

 

z

 

) key in conjunction with another key 
and are shown with the command key symbol (

 

z

 

) followed by 
the accompanying key. To use a shortcut, you must 

 

press and hold

 

 
the command key while pressing the second key.

 

Key1+Key2

 

A plus sign (+) between key names means to 

 

press and hold down 
the Þrst key while you press the second key

 

 (within Windows). For 
example, Òpress 

 

ALT+ESC

 

Ó means to press and hold down the 

 

ALT

 

 
key and press the 

 

ESC

 

 key. Then release both keys.

 

Key1, Key2

 

A comma (,) between key names means to 

 

press and release the keys 
one after the other

 

. For example, Òpress 

 

ALT, F

 

Ó means to press and 
release the 

 

ALT

 

 key, and then press and release the 

 

F 

 

key.

The names of keys found on different Windows-compatible PC 
computer keyboards may vary somewhat from machine to machine. 
The key names shown in this manual reßect typically used key 
names. Yours should be similar but may not be exactly like those 
shown. For example, the Òprint screenÓ key may be shown on some 
keyboards as ÒPrt ScrnÓ; other keyboards may spell out the complete 
key name.

NOTE:
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Messages

 

The following types of messages may appear in this manual:

Calls attention to information that should be followed during instal-
lation, use, and/or servicing of the instrument or software.

Indicates a potentially hazardous situation which, if not 
avoided, might result in minor or moderate injury, loss of data, or 
mechanical damage. It is also used to alert against unsafe practices.

Used whenever an action or condition might potentially 
cause serious injury to yourself or to others who might use the instru-
ment or computer.

NOTE:

! CAUTION:

WARNING:
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Getting Help

 

Macintosh On-Line Help

 

On-line help is available while working with SOFTmax PRO for the Macin-
tosh by clicking the Help menu at the far right of the menu bar.

 

Figure 1.1: Help Menu for SOFTmax PRO for the Macintosh

Choosing either of the two help options at the bottom of this menu (SOFTmax 
PRO Help or Formula Help) causes a Help window to appear. This window 
provides a list of topics on the left and information about the selected topic on 
the right. Figure 1.2 shows the window for Formula Help. In this Þgure, the 
topic ÒMath FunctionsÓ has been selected (on the left) and the corresponding 
information about that topic appears on the right.

Figure 1.2: Formula Help Window

Click here

SOFTmax PRO Help Options

for the Help Menu



Chapter 1: Welcome to SOFTmax PRO

1-10 SOFTmax PRO UserÕs Manual

Windows On-Line Help
You can access on-line help within SOFTmax PRO for Windows by selecting 
the Help menu in the menu bar. Three types of help are immediately avail-
able: you can view the contents of the help Þle, seek speciÞc help about for-
mulas, or get general information about how to use the help function.

Figure 1.3: Help Menu for SOFTmax PRO for Windows

Choosing Contents (by clicking on the menu item with the mouse or pressing 
ALT, H, C) brings up the SOFTmax PRO help Contents window, showing the 
general organization of the help that is available.

Figure 1.4: Help Contents for SOFTmax PRO for Windows

Click here

SOFTmax PRO Help Options

for the Help Menu
or press ALT, H

Help

Contents of the

Window
Menu

SOFTmax PRO
Help File
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Help Options from the Contents Window
¥ You can search for a particular item or subject by clicking the [Search] but-

ton (located in the tool bar at the top of the Contents window).

Figure 1.5: Using the Search Function within Help in SOFTmax PRO for Windows

After entering a search subject, clicking the [Show Topics] button will cause 
a list of related topics to appear in the box below.

Figure 1.6: Choose a Topic within Help in SOFTmax PRO for Windows

¥ You can return to the window viewed previously by clicking the [Back] 
button.

¥ Clicking the [History] button will provide a list of all areas you have 
viewed within the Help function.

Enter the
subject you
are searching
for in this
box

Choose a
topic from
this list
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¥ Text that appears in green with an underline contains a hypertext link to 
more detailed information about that item. Figure 1.7 below shows some 
examples of hypertext links.

Figure 1.7: Hypertext Links within SOFTmax PRO for Windows

Additional options are available, depending upon where you are within the 
Help function. More information about Windows Help can be found in the 
Microsoft Windows UserÕs Guide that accompanies your Windows software.

Troubleshooting and Technical Support
If you encounter a problem while using SOFTmax PRO, refer Þrst to Chapter 
8, "Troubleshooting," and try to locate a remedy for the problem. 
For problems with SOFTmax PRO that are not listed there, or if you need 
additional assistance, in the U.S., call Molecular Devices Technical Services 
group at 800-635-5577 or 408-747-1700; elsewhere, call your local representa-
tive.

Hypertext linked
item (clicking here
will give more
information about
this item)
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Glossary of Terms

Absorbance, A
The amount of light absorbed by a solution. To measure absorbance accu-
rately, it is necessary to eliminate light scatter. In the absence of turbidity, 
absorbance = optical density - reßection.

A = log [I0/I] 

I0 = incident light 

I = transmitted light

In this manual, we use the terms absorbance and optical density 
interchangeably. 

Active
The window or icon that you are currently using or that is currently selected. 
The active section is the section in which you are currently working. The title 
bar for the active section or window will be highlighted (gray); inactive sec-
tions are not highlighted (white). Only one section or window can be active at 
a time. To make a section or window active, click anywhere within it. If you 
scroll past the bottom or top of the active section, the tool bar for that section 
ÒsticksÓ to the top of the window (you can always tell which section is active 
in this way and can always access the items in its tool bar).

ANSI Character Set
The American National Standards Institute 8-bit character set. It contains 256 
characters.

Area Under Curve
Reduction formula for a kinetic or spectral scan that determines the area 
under the kinetic or spectral plot, or under a plot in a Graph section. First the 
area under the curve is divided into a series of trapezoids; then the area 
deÞned by each trapezoid is computed and all areas are summed.

ASCII Character Set
The American Standard Code for Information Interchange 7-bit character set. 
It consists of the Þrst 128 (0Ð127) characters of the ANSI character set (and 
most other 8-bit character sets). The ASCII character set is the most universal 
character-coding set.

Autocalibration
For optical density instruments, an air reference reading is taken before runs 
(and sometimes between kinetic readings during a run) as determined by the 
type of instrument and read settings. For the SPECTRAmax GEMINI or 
GEMINI XS, the internal reference standard is measured before reads (and 
sometimes between kinetic reads if the read interval is long enough). Cali-
bration data is stored in volatile memory and is used by SOFTmax PRO until 
the instrument is powered down or the wavelength is changed. Autocalibra-
tion can be turned off (see ÒAutocalibrationÓ on page 4-25 for more informa-
tion).
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Automix
The Automix function determines how often, if at all, automated shaking of 
the microplate is performed during a reading. This feature is covered by U.S. 
Patent Number 5,112,134.

BlankingÑCuvetteSet Section (SPECTRAmax PLUS or PLUS384 only)
Three types of blanking are available in the CuvetteSet section for the SPEC-
TRAmax PLUS or PLUS384: Ref Blanking, Template Blanking, and Group 
Blanking.

A Ref Blank is created when you click the [Ref] button or choose Ref from 
the Control menu. This command causes the SPECTRAmax PLUS or PLUS384 
to read the cuvette in the cuvette port and applies the reading as a reference 
to all cuvettes in the CuvetteSet section.

Template Blanks are created by entering a Blank group in the CuvetteSet 
template. After a reading, the average of the blank values obtained from the 
Blank group is subtracted from all cuvettes.

Group-Associated Blanks are created by placing blank cuvettes within a 
group in the template. The values of group blanks are averaged and sub-
tracted from the values of the cuvettes within that group only.

BlankingÑPlate Section
Three types of blanking are available in the Plate section: Pre-Read Blanking, 
Plate Blanking, and Group Blanking.

Pre-Read Blanking subtracts background signal caused by the microplate 
itself, as well as by solvents, reagents, or samples. The individual blank read-
ing from each well can be subtracted from the Þnal reading from the same 
individual wells (choose ÒPre-read plateÓ from within the Instrument Settings 
dialog box). This is usually used for measurement in the deep UV or for path-
length correction.

Pre-read blanking is generally NOT used with kinetic assays. When 
used with kinetics, it will complete a pre-read kinetic run and then 
subtract these values on a point-by-point basis from the ÒnormalÓ 
kinetic run.

Plate Blanks are created by entering a Blank group in the template. After a 
reading, the average of the blank values obtained from the Blank group is 
subtracted from all wells in the plate.

Group-Associated Blanks are created by placing blank wells within a group 
in the template. The values of group blanks are averaged and subtracted from 
the values of the wells within that group only.

Checkbox
A small, square box that appears in a dialog box and that can be selected or 
cleared. When the checkbox is selected, an X appears in the box. A checkbox 
represents an option that you can turn on or off.

Clear
Within the Template Editor, Clear removes information that was designated 
previously for selected wells. By highlighting wells and then choosing Clear, 
any information regarding those wells will be erased (the wells will return to 
their default status of empty). Note that if you clear the entire template, the 

NOTE:
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groups themselves will not be deleted and are still selectable. Keeping the 
groups allows you to reassign wells without having to recreate groups.

Click
You click an object on the screen by pressing and quickly releasing the mouse 
button while the pointer is on that object. When you click once on an object, 
such as an icon or Þle name, it becomes highlighted, which means it is 
selected. Whatever action you choose next will affect a selected object.

Clipboard
A temporary storage location within the operating system used to transfer 
data within and between Þles and applications.

Concentration
The amount of a substance present per unit volume. Used as the default sam-
ple descriptor for a series of samples.

Control
A sample that is run as an internal check of the assay. The control has a pre-
dictable or known assay result against which other results can be compared.

Control Menu Box (Windows)
The icon that opens the Control menu for the window. It is located at the left 
of the SOFTmax PRO title bar. The Control menu can be activated by clicking 
in this box with the mouse or by pressing ALT, SPACEBAR.

Copy
A function common to most software applications that duplicates the selected 
text or item and places this duplicate on the clipboard. The copy function is 
enabled by pressing zC on the Macintosh and CTRL+C in Windows.

Copy-and-Paste
A method of copying selected text or graphics from one location and pasting 
them to a different location in the same Þle or into another Þle (which could 
be in an application other than SOFTmax PRO).

Cubic Spline (Curve Fit)
This curve Þtting option generates a Þt to a cubic equation between each pair 
of data points. The cubic equations are computed such that these equations 
and their Þrst two derivatives are continuous everywhere.

More information regarding curve Þts can be found in Chapter 5, ÒDisplaying 
and Analyzing Data.Ó

Curve Fit
SpeciÞes the type of curve (linear, logarithmic, quadratic, and so on) that is 
applied to the data points in a plot. The curve is a graphic representation of 
the mathematical relationship between the data points in the plot. More infor-
mation regarding curve Þts can be found in Chapter 5, ÒDisplaying and Ana-
lyzing Data.Ó
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Cutoff
A Þlter used to condition the light entering or exciting the monochromators. 
In automatic mode, the instrument sets the cutoffs automatically based upon 
the wavelength(s) chosen for reading; with some read modes and types, how-
ever, you can choose a different Þlter wavelength (manual setting) for the 
emission monochromator.

CuvetteSet Section
The CuvetteSet sections determine how the cuvettes will be read, display data 
as it is acquired from the instrument, and define how the data will be dis-
played and used in reduction. CuvetteSet sections can display samples in 
three different ways: three samples per row, one sample per row, and in a 
grid of cells which corresponds to a microplate format.

Cut
A function common to most software applications that removes a selection of 
text or graphics and places it on the clipboard. The cut function is enabled by 
pressing zX on the Macintosh and CTRL+X in Windows.

Cut-and-Paste
A method of moving selected text or graphics from one location to a different 
location in the same Þle or into another Þle (which could be in an application 
other than SOFTmax PRO).

Data Display
Located in the Plate section or CuvetteSet section, the data display is a grid 
that corresponds to the layout of the wells in the microplate (for specialized 
cuvette displays, see ÒCuvetteSet Section,Ó above). This display can show the 
results of the reading in various formats [for example: raw signal data (OD, 
RFU, RLU), raw %Transmittance, reduced data (number or plot), Threshold, 
Ranged, and Gray Scale].

Data File
Contains the raw data collected from the instrument, as well as any associated 
sections or settings (Notes, Graphs, Groups, Instrument Setup, Display 
Options, and Data Reductions).

Data Mode
Reduction option to view data as OD (absorbance) or %Transmittance.

Default Protocol
A protocol Þle, included with the SOFTmax PRO program or created by a 
user. The Default Protocol Þle deÞnes the initial information that will appear 
when you open SOFTmax PRO or when you create a new Þle from within the 
program.

Desktop
The background on which windows and icons appear.

Dialog Box
A rectangular window that appears temporarily to request information. 
Some dialog boxes have options you must choose before SOFTmax PRO can 
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carry out a command and must be closed before you can continue in the soft-
ware.

Dilution Factor
SpeciÞes the amount of dilution for a given sample. This factor can be multi-
plied against interpolated values to determine concentration of undiluted 
sample.

Dimmed
Unavailable or disabled. A dimmed button or command is displayed in light 
gray instead of black and it cannot be chosen.

Double-Click
To rapidly press and release the mouse button twice while the pointer is on an 
object. Double-clicking carries out an action, such as opening an icon.

Drag
To move an object on the screen by clicking it, holding down the mouse but-
ton, and then moving the mouse. Also to select an item in a list by dragging 
through the list or to select multiple items by dragging across them.

Duplicate
A command available in the Edit menu that allows you to create identical cop-
ies (except data) of all sections and experiments. The name of the duplicated 
item will be the same as the previously active item with the word ÒCopyÓ 
appended.

Emission Spectral Scan
Measures ßuorescence or luminescence across a spectrum of wavelengths for 
emitted light for a Þxed excitation wavelength. The default value reported for 
each well is the wavelength of maximum emission (ßuorescence or lumines-
cence).

Endpoint
A single reading of optical density made at one or more wavelengths.

End Time
Reduction parameter used to omit the end of a kinetic run from data reduc-
tion.

Excitation Spectral Scan
Measures ßuorescence at a single emission wavelength across a spectrum of 
excitation wavelengths. The default value reported for each well is the excita-
tion wavelength of maximum ßuorescence.

Export
Data from SOFTmax PRO is copied to a new Þle that can be opened by 
another program such as a spreadsheet or word processing application. Data 
from some or all Plate, CuvetteSet, or Group sections may be exported as tab-
delimited ASCII Þles.
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Exponential (Curve Fit)
The exponential function used to generate this curve Þt is:

y = A + B * (1 - exp^(-x / C))
More information regarding curve Þts can be found in Chapter 5, ÒDisplaying 
and Analyzing Data.Ó

Fluorescence
The light emitted by certain substances resulting from the absorption of inci-
dent radiation. To measure ßuorescence accurately, it is necessary to reduce 
light scatter. The governing equation for ßuorescence is:

Fluorescence = extinction coefÞcient * concentration * quantum yield * exci-
tation intensity * pathlength * emission collection efÞciency

Fluorophore
A material which absorbs light energy of a characteristic wavelength, 
undergoes an electronic state change, and instantaneously emits light of a 
longer wavelength.

Four Parameter Logistic (Curve Fit)
The equation used to generate this curve Þt is:

y = ((A - D) /(1 + (x /C)B)) + D
More information regarding curve Þts can be found in Chapter 5, ÒDisplaying 
and Analyzing Data.Ó

Gain
The amount of increase in signal power expressed as the ratio of output to 
input for a photomultiplier tube.

Gray Scale Data Display
Raw or reduced data is displayed proportionally in a plate format using 
seven shades of gray, ranging from light shading at the low end to dark 
shading at the high end, based on user-deÞned high and low limits.

Group
Wells can be assigned to group types using the Template Editor. Depending 
on the default protocol used, certain group types (such as Standard or 
Unknown) may be created automatically; you can create others as required.

Highlighted
Indicates that an object or piece of text is selected and will be affected by 
your next action. Highlighted text appears in reverse video or in color. High-
lighted objects may change color or be surrounded by a selection cursor.

Icon
A graphical representation of an element of the computer or software such 
as a disk drive, application, or Þle.

Import
Bringing information or data from another application into SOFTmax PRO. 
Information can be brought into SOFTmax PRO in two ways: by copying tab-
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delimited text to the clipboard and then pasting this information into the 
Plate section or CuvetteSet section within SOFTmax PRO; or by using the 
Import command under the File menu to import ASCII text Þles having spe-
ciÞc formats.

Incubator
Choosing Incubator from the Control menu or clicking the incubator button 
opens a dialog box allowing you to start or stop temperature regulation and 
to select an elevated temperature for the microplate chamber on instruments 
that have temperature control capability.

Instrument Icon
Located in the status bar, the instrument icon shows the status of the connec-
tion between the computer and the instrument. If the icon has an ÒXÓ 
through it, the connection is not functioning or no instrument is connected; if 
the instrument icon appears without an ÒX,Ó the connection is working prop-
erly.

Instrument Setup
DeÞnes the parameters (mode, wavelengths, automatic mixing, run time, 
read interval, etc.) used to read the microplate or cuvette.

Interleaved Display
A display choice available with 384-well plates is useful when four 96-
well daughter plates are combined into one 384-well plate.

Interprocess Messaging
Messages that can be sent to and received from other applications. This fea-
ture is very useful for interfacing MAXline instrument with robotic systems 
and for sending and receiving data from LIMS systems.

Kinetic (Not available for Emax)
During kinetic readings, data is collected over time, with multiple readings 
made at regular intervals. The values calculated based on raw kinetic data 
are Vmax, Vmax per Sec, Time to Vmax, and Onset Time. Kinetic readings 
can be single- or multiple-wavelength readings (up to six, if using a SPEC-
TRAmax instrument other than the SPECTRAmax GEMINI or GEMINI XS 
which have a maximum of four).

Lag Time
Lag time is the period of time in a kinetic assay of very slow growth (micro-
organisms) or rate of reaction that may precede the rapid (or linear) phase 
of reaction. When a lag time is speciÞed in SOFTmax PRO, data collected 
prior to the lag time is not included in data reduction.

Large Display
A display choice available with 384-well plates. This setting is useful 
when looking at large numbers if you have a larger (17-inch or greater) mon-
itor.
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Linear (Curve Fit)
The linear function Þts the best straight line to the data. The equation for 
this Þt has the form of:

y = A + Bx
where A is the y-intercept of the line and B is the slope. A linear Þt should 
be used whenever the values appear to lie on or scattered around a straight 
line.

More information regarding curve Þts can be found in Chapter 5, ÒDisplaying 
and Analyzing Data.Ó

Log-Logit (Curve Fit)
The Log-Logit is also called a two-parameter curve Þt. The equation used to 
generate this curve Þt is:

y = ((A - D) / (1 + (X /C)B)) + D
More information regarding curve Þts can be found in Chapter 5, ÒDisplaying 
and Analyzing Data.Ó

Luminescence
The emission of light by processes that derive energy from essentially non-
thermal changes, the motion of subatomic particles, or the excitation of an 
atomic system by radiation.

Mask
Lets you ÒhideÓ the data in selected wells of the Plate display so that the 
data stored there will not be used for calculations and will not be reported. 
The Mask function is commonly used to suppress outliers.

Maximum
Reduction for a spectral scan that reports the maximum signal within the 
reduction parameters.

MaxOD or MaxRFU or MaxRLU
The limit for the maximum value you wish to use for displaying and ana-
lyzing kinetic data or spectral scan data. The default is 100 OD or 20,000 
RFU or RLU. Any values that are above these limits will not be shown and 
will be excluded from data reduction.

Maximize Button (Windows)
The small box containing an up arrow at the right of the title bar. Mouse 
users can click the Maximize button to enlarge a window to its maximum 
size. Keyboard users can use the Maximize command on the Control menu.

Menu
A list of items, most of which are commands. Menu item names appear in the 
menu bar at the top of the window.

To choose an item in a menu, place the pointer on the menu heading and drag 
to the selection you desireÑthen release the mouse button.
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Menu Bar
A list of items, most of which are commands. Menu item names appear in the 
menu bar (the horizontal bar that appears below the title bar at the top of the 
window).

Minimum
Reduction for a spectral scan that reports the minimum signal within the 
reduction parameters.

MinOD or MinRFU or MinRLU
The limit for the minimum value you wish to use for display and analysis of 
kinetic or spectral scan data. Any values that are under this limit will not 
be shown and will be excluded from data reduction. The default is 0. To dis-
play negative Kinetics, the value should be set below 0 (zero).

Minimize Button (Windows)
The small box containing a down arrow at the right of the title bar. Mouse 
users can click the Minimize button to reduce a window to its icon. Keyboard 
users can use the Minimize command on the Control menu. A minimized 
application continues running and you can select the icon to make it the 
active application.

Modem Port (Macintosh)
A serial communication port on the back panel of the Macintosh marked 
with the icon of a telephone handset (Ê).

Normal Display
The default display for 384-well plates.

NVRAM
Refers to the Non-Volatile Random Access Memory of the instrument. Infor-
mation stored in the NVRAM is not lost when power to the instrument is 
turned off.

Onset OD or Onset RFU or Onset RLU
The change in signal required to compute the onset time (for kinetic read-
ings).

Onset Time
The time it takes for a given increase in signal, called the onset OD (or RFU 
or RLU), to occur.

Open/Close Triangle
A small triangle located on the left-hand side of section and experiment 
tool bars. Used to open/close sections and experiments within a SOFTmax 
PRO Þle.

Optical Density, OD
The amount of light passing through a sample to a detector relative to the 
total amount of light available. Optical Density includes absorbance of the 
sample plus light scatter from turbidity.
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Option Button (Radio Button)
A small, round button that appears in a dialog box or window. Within a 
group of related option buttons, you can select only one.

Parallel Port (Windows)
A connection on a computer, usually LPT1, to plug in the cable for a parallel 
printer. Windows supports parallel ports LPT1 through LPT3.

Paste
A function that copies the contents of the clipboard and inserts this copied 
information at the current selection or cursor position. The paste function is 
enabled by pressing zV on the Macintosh and CTRL+V in Windows.

Path (Windows)
SpeciÞes the location of a Þle within the directory tree. For example, to 
specify the path of a Þle named ASSAY.BAT located in the SOFTMAX 
directory on drive C, you would type c:\softmax\assay.bat.

PathCheck

Instrument setup option within SOFTmax PRO for the SPECTRAmax PLUS, 
PLUS384, 190, or 340PC that allows data collected in a Plate section to be 
normalized to a 1-cm pathlength.

Photomultiplier Tube (PMT)
A vacuum tube that detects light especially from dim sources through the 
use of photoemission and successive instances of secondary emission to pro-
duce enough electrons to generate a useful current.

Plate Section
The Plate section is used to display data, to specify how microplates will be 
read, and to deÞne how the data received from the instrument should be 
reduced. The data display in this section is a matrix that corresponds to the 
well format of the microplate in use.

Plate Type
A choice in the Instrument Settings dialog that determines the type of 
microplate being read. The speciÞcation of the plate type depends on the 
well format and manufacturer of the microplate.

Point (Using the Mouse)
You point to an object on the screen by moving the mouse so that the pointer is 
positioned on that object. When the pointer is an arrow, the tip of the arrow 
must be on the object.

Point-to-Point
This curve-Þtting option Þts a linear equation to each pair of data points.

Port
A connection or socket on the computer. Ports are common used for connecting 
devices, such as printers or monitors, to your computer, and for sending infor-
mation to and/or from your computer to such devices.
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Protocol File
Contains the template(s), instrument settings, and reduction parameters. 
Protocol Þles are useful if you repeat a particular type of assay frequently.

Quadratic (Curve Fit)
A mathematical description of a parabola:

y = A + Bx + Cx2

RAM (Random Access Memory)
The memory that can be used by applications to perform necessary tasks 
while the computer is on. When you turn the computer off, all information in 
RAM is lost.

Ranged Data Display
Raw or reduced data is assigned proportionally to integer values from 0 
through 9 based on user-deÞned limits. Values above the high limit are 
displayed as plus (+) and values below the low limit are displayed as 
minus (-).

Raw Data
Signal reported from the MAXline instrument with no alteration. This will 
be reported as OD, RFU, or RLU, depending on the instrument type.

Read Interval
The interval of time between the start of one reading and the start of the 
next reading during a kinetic run.

Read Button or Command
Starts the reading process and shows the endpoint, kinetic, spectrum, or 
well scan data in the data display of the Plate section.

Read Mode
The method used to read the microplate or cuvette: endpoint, kinetic, 
spectrum or well scan.

Read Type (SPECTRAmax GEMINI or GEMINI XS only)
The type of reading performed in the instrument: ßuorescence, time-
resolved ßuorescence, or luminescence.

Readings per Well
The number of times (settable by the user) that readings are taken on a well 
in ßuorescence and time-resolved ßuorescence modes. This setting also 
determines the amount of time that data is collected in luminescence mode.

Reduced Data
Data reduction causes the raw signal values reported by the instrument to be 
calculated and displayed according to user-deÞned formula settings.

Reduction Limits
Sets limits on data to be included in data reduction for kinetic or spectrum 
readings.
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Reference
A reading of buffer or water taken in the cuvette that is used as I0 to calcu-
late Absorbance or %Transmittance of sample read in the cuvette port.

Restore Box (Windows)
The small box containing both an up and a down arrow at the right of the 
title bar. The Restore box appears only after you have enlarged a window to 
its maximum size. Mouse users can click the Restore box to return the window 
to its previous size. Keyboard users can use the Restore command on the Con-
trol menu.

Rotated Display
A display option for 384-well plates that shows the plate rotated 90 
degrees.

Scroll
To move up, down, right, or left through text or graphics in order to see parts 
of the Þle or list that cannot Þt on the screen. A scroll bar appears at the 
bottom and/or right edge of a window whose contents are not entirely visi-
ble. Each scroll bar contains a scroll box and two scroll arrows. A scroll box is 
a small box that shows the position of information currently in the window 
or list box relative to the contents of the entire window. A scroll arrow is an 
arrow on either end of a scroll bar that you can use to scroll through the con-
tents of the window or list box.

Semi-Log (Curve Fit)
The semi-log function Þts the best straight line to a set of data for log(X) 
plotted against Y. The resulting curve displayed will be a straight line 
with the X-axis drawn in logarithmic scale. 

Serial Port (PC/Windows)
A connection on a computer, usually COM1, where you plug in the cable for a 
serial device such as a plate reader, a printer, or a modem. Serial, asyn-
chronous, and RS232 interfaces are all the same type by which the computer 
sends single bits of information to the connected device, one after the other. 
Windows supports COM1 through COM4. MAXline instruments require 
COM1 or COM2.

Series
Lets you assign a set of wells within groups in the Template so that the stan-
dard value or dilution factor increases or decreases in speciÞed steps and 
the name increments as well.

Slope
A reduction option for a kinetic run that determines the slope of the com-
bined plot (i.e., the slope of the line using linear regression after the wave-
length combination reduction). This reduction uses all timepoints visible in 
the reduction window. Slope is the same as Vmax Rate when Vmax Rate is 
set to the same number of points as the run (i.e., the default). Slope is not the 
same as Vmax Rate if you have modiÞed the number of Vmax Points.
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Standard Curve
A mathematically idealized representation of the relationship between the 
concentration of a standard calibrator (X-value) and the optical density (Y-
value). The standard curve may be set to a linear, semi-log, log-log, quadratic, 
4-parameter logistic, log-logit (2-parameter logistic), exponential, cubic 
spline, or point-to-point curve Þts.

Status Bar
Shown above the SOFTmax PRO window, the Status Bar contains 
the instrument icon, the current temperature within the microplate chamber 
of the microplate reader (THERMOmax, SPECTRAmax, VERSAmax), and 
buttons allowing you to activate the Read function, the incubator, Automix, 
and to open or close the microplate drawer of the instrument (note: not all 
functions are available with all instruments).

Stokes Shift
The difference between the wavelengths of the excitation and emission 
peaks.

Template Editor
A representation of the microplate or a set of cuvettes (in microplate for-
mat), shown as a grid of wells, which can be used to designate the location 
of blanks, standards, controls, unknowns, empty wells, or to assign wells to 
other groups you create. The template is a map of the microplate. It tells 
the software what is in the microplate and where it is located.

Threshold Data Display
Data is displayed as plus (+) for values above, asterisk (*) for values 
within, and minus (-) for values below user-deÞned limits.

Time at Half Maximum
Reduction for a kinetic run that reports the time at half the maximum sig-
nal within the reduction limits as follows: SOFTmax PRO Þrst determines 
the kinetic point (within the reduction limits) that has the maximum sig-
nal level. It then scans the kinetic plot from left to right until it Þnds two 
points that have signals bracketing one-half of that signal value. A linear 
interpolation between these two points is used to estimate the Time at Half 
Maximum.

Time at Maximum
Reduction for a kinetic run that reports the time at the maximum signal 
within the reduction limits.

Time at Minimum
Reduction for a kinetic run that reports the time at the minimum signal 
within the reduction limits.

Time-Resolved Fluorescence
Most ßuorescence substances are not suitable for this type of reading. How-
ever, the ßuorescence emitted by lanthanide dyes is delayed long enough to 
measure ßuorescence after the lamp is turned off. Time-resolved ßuores-
cence is used to reduce the amount of background noise which interferes with 
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ßuorescence. The excitation lamp ßashes and, after it is off, the delayed 
emission is collected for a set period of time before the lamp is ßashed 
again.

Time to Vmax
The elapsed time until the maximum reaction rate of a kinetic reading is 
reached, reported in seconds.

Title Bar
The horizontal bar (at the top of a window) that contains the title of the 
window or dialog box. On many windows within the Windows environment, 
the title bar also contains the Control-menu box and Maximize and Mini-
mize buttons. On the Macintosh, the title bar also contains the Close box and 
Zoom box.

Transmittance, T
The ratio of transmitted light to the incident light.

%T = (I/I0) x 100

Undo
Cancels the previous operation (if possible). The paste function is enabled 
by choosing Undo from the File menu, pressing zV on the Macintosh, or press-
ing CTRL+V in Windows.

Vertical Display
A display option for 384-well plates which shows the plate as two 8 × 12 
arrays stacked vertically.

Vmax Points
The number of points in the kinetic curve included in each of a series of 
regressions to calculate the maximum rate, Vmax, or the time segment used 
to calculate the Time to Vmax.

Vmax
The kinetic rate reported as signal/min (milli-OD [or RFU or RLU] units per 
minute). It is calculated using a linear curve Þt, y = Ax + B. A creeping itera-
tion is performed using Vmax Points and the slope of the steepest line seg-
ment is reported as Vmax Rate. It may also be reported as units per second 
(the default for ßuorescence and luminescence).

Wavelength(s)
SpeciÞes the wavelength(s) that will be used to read the microplate.

Well Graph
One or more wells in a plate section (showing spectral or kinetic data) may 
be expanded by selecting them and clicking the Graph button on the Plate 
section tool bar.

Well Scanning Mode
Some applications involve the detection of whole cells in large-area tissue cul-
ture plates. Well scanning mode can be used with such microplates to allow 
maximum surface area detection in whole-cell assays. Since many cell lines 
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tend to grow as clumps or in the corners of microplate wells, you can choose 
from several patterns and deÞne the number of points to be scanned to work 
best with your particular application.

Zoom Box (Macintosh)
A small box containing a smaller box at the right of the title bar. You can 
click the Zoom box to return the window to its previous size.
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Connect the Hardware

Turn OFF the power to both the instrument and the com-
puter before connecting or disconnecting any components or cables. 
Not doing so could potentially result in damage to components in 
either or both instruments.

Connecting to the SPECTRAmax and VERSAmax

Macintosh
If your Macintosh has a single serial port, refer to Chapter 8, ÒTrou-

bleshooting,Ó for information regarding connection to the MAXline 
instrument.

Serial Port Connection

Use an 8-pin DIN to 8-pin DIN Macintosh straight-through serial cable to con-
nect the Macintosh to the SPECTRAmax instrument (note that this cable is 
NOT the same as a Macintosh printer cable). Connect one connector to the Mac-
intosh (to either the printer or modem port) and the other connector to the 
SPECTRAmax. Connecting to the modem port of the Macintosh is preferred, 
allowing the printer port to remain available. If you do connect the SPEC-
TRAmax to the Macintosh printer port, Þrst inactivate AppleTalk using 
the AppleTalk Control Panel or the Chooser desk accessory in the Apple 
(ð) menu.

Figure 2.1: 8-Pin DIN to 8-Pin DIN Serial Cable (not the same as a Macintosh printer 
cable)

If you are running other applications that use AppleTalk, it may be 
necessary to quit them before making AppleTalk inactive.

USB Connection

Although the SPECTRAmax requires a serial connection, through the use of a 
USB-to-serial converter, you can connect a serial cable to the Macintosh and 
the SPECTRAmax instrument. Connect the USB connector of the converter to 
the Macintosh. Connect the serial cable end to the SPECTRAmax instrument. 
(Note that some converters have a USB cable end and a receptacle into which 
you can connect a standard serial cable.)

! CAUTION:

NOTE:

NOTE:
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Figure 2.2: 8-Pin DIN Serial to USB Cable

Windows-Compatible Computer
The type of cable required to connect your computer and the SPECTRAmax 
instrument will depend upon the type of serial port(s) available on your com-
puter. The end of the cable that will attach to the SPECTRAmax must be an 
8-pin DIN connector. The cable itself should be a straight-through serial cable. 
The connector for your computer may be a 9-pin or 25-pin connector (or you 
can use an adapter that converts from 9-pins to 25-pinsÑsee Figure 2.3). 

Figure 2.3: 8-Pin DIN to 9-Pin Serial Cable

Connecting to Emax, Vmax, UVmax, or THERMOmax

Macintosh
If your Macintosh has a single serial port, refer to Chapter 8, ÒTrou-

bleshooting,Ó for information regarding connection to the MAXline 
instrument.

Use an 8-pin DIN to DB-25 Macintosh modem cable to connect the Macintosh 
to the MAXline instrument. Connect the 8-pin, round DIN connector to the 
Macintosh (to either the printer or modem port) and the 25-pin connector to 
the MAXline instrument. Connecting to the modem port of the Macintosh is 
preferred, allowing the printer port to remain available. If you do connect the 
MAXline instrument to the Macintosh printer port, Þrst inactivate AppleTalk 
using the Chooser desk accessory in the Apple (ð) menu.

9-pin to 25-pin
adapter

9-pin
connector

NOTE:
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Figure 2.4: 8-Pin DIN to DB-25 Macintosh Modem Cable

If you are running other applications that use AppleTalk, it may be 
necessary to quit them before making AppleTalk inactive.

NOTE:
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Windows-Compatible Computer
The type of cable required to connect your computer and the MAXline instru-
ment will depend upon the type of serial port(s) available on your computer. 
The end of the cable that will attach to the MAXline instrument must be a 25-
pin connector. The cable itself should be a straight-through serial cable. The 
connector for your computer may be a 9-pin or 25-pin connector (or you can 
use an adapter that converts from 9-pins to 25-pinsÑsee Figure 2.5).

Figure 2.5: 25-Pin DIN to 25-Pin or 9-Pin Serial Cable

9-pin to 25-pin
adapter25-pin connector 9-pin connector
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Computer System Requirements

The following computer hardware and operating system software speciÞca-
tions are recommended to ensure proper operation of SOFTmax PRO. The 
minimum conÞguration required is also given.

Macintosh Computer

Either conÞguration requires an 8-pin DIN to 8-pin DIN straight-through 
serial cable (for SPECTRAmax) or 8-pin DIN to DB 25 straight-through 
modem cable (for Emax, Vmax, UVmax, or THERMOmax). Molecular 
Devices recommends using only high-quality, double-shielded cables.

Recommended System ConÞguration

¥ Apple Power Macintosh G3

¥ Operating software System 8.6

¥ Sony 17-inch Multisync Color Monitor

¥ 64 MB RAM, 6 GB hard disk drive

¥ CD-ROM drive

¥ Extended keyboard

¥ Keyspan USB Serial Adapter

¥ Epson 740I color printer

Minimum System ConÞguration

¥ Apple Macintosh with 68040 processor

¥ Operating software System 7.1.1 (must include System Upgrade 3.0)

¥ Apple 14-inch color monitor

¥ 24 MB RAM, 270 MB hard disk drive

¥ 1.44 MB HD (high-density) 3.5-inch ßoppy disk drive

¥ Access to a CD-ROM drive

¥ Available serial communications port
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Windows-Compatible Computer

Any of these conÞgurations requires an 8-pin DIN to either 9-pin or 25-pin 
straight-through serial cable or USB converter (for SPECTRAmax or 
VERSAmax) or 25-pin to either 9-pin or 25-pin straight-through serial cable or 
serial-to-USB converter (for Emax, Vmax, UVmax, or THERMOmax). Molec-
ular Devices recommends using only high-quality, double-shielded cables.

Windows 95/98
Recommended System ConÞguration

Windows NT/2000
Recommended System ConÞguration

¥ Pentium III, 450 MHz computer
¥ Microsoft Windows 95 or 98
¥ 17-inch color SVGA monitor
¥ Video adapter and software driver capable of 

displaying 800 x 600 minimum resolution set to 
16-bit high color and small fonts or better

¥ 64 MB RAM or greater
¥ 6 GB hard disk drive
¥ 1.44 MB HD (high-density) 3.5-inch ßoppy disk 

drive
¥ CD-ROM drive
¥ Bus mouse
¥ Serial port (COM1 or COM2)

¥ Pentium III, 450 MHz computer
¥ Microsoft Windows NT 4.0 or 2000
¥ 17-inch color SVGA monitor
¥ Video adapter and software driver capable of 

displaying 800 x 600 minimum resolution set to 
16-bit high color and small fonts or better

¥ 128 MB RAM or greater
¥ 6 GB hard disk drive
¥ 1.44 MB HD (high-density) 3.5-inch ßoppy disk 

drive
¥ CD-ROM drive
¥ Bus mouse
¥ Serial port (COM1 or COM2)

Windows 95/98
Minimum System ConÞguration

Windows NT/2000
Minimum System ConÞguration

¥ 486 33 MHz computer
¥ Microsoft Windows 95 or 98
¥ Color monitor
¥ SVGA graphics adapter (set to 256 colors and 

small fonts or better)
¥ 24 MB RAM or greater
¥ 1 GB hard disk drive
¥ 1.44 MB HD (high-density) 3.5-inch ßoppy disk 

drive
¥ Access to a CD-ROM drive
¥ Bus mouse
¥ Serial port (COM1 or COM2)

¥ 486 33 MHz computer
¥ Microsoft Windows NT 4.0 or 2000
¥ Color monitor
¥ SVGA graphics adapter (set to 256 colors and 

small fonts or better)
¥ 32 MB RAM or greater
¥ 1 GB hard disk drive
¥ 1.44 MB HD (high-density) 3.5-inch ßoppy disk 

drive
¥ Access to a CD-ROM drive
¥ Bus mouse
¥ Serial port (COM1 or COM2)
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Install SOFTmax PRO

Follow these instructions to install SOFTmax PRO from the CD to your com-
puterÕs hard disk.

1) Insert the SOFTmax PRO CD into the CD-ROM drive.

2) Macintosh: Double-click the CD-ROM drive icon to open it.
Windows: Open ÒMy ComputerÓ and then double-click the CD-ROM drive icon 
to open it.

3) Double-click the Installer icon (Macintosh) or Setup icon (Windows) and follow 
the screen prompts.

4) The ÒWelcomeÓ screen suggests that you close all other programs before begin-
ning installation of SOFTmax PRO software. It is also recommended that you dis-
able any virus protection software you may have running before installing 
SOFTmax PRO. Click [Cancel] to exit the installer and close any programs 
and/or disable virus protection and then start the installer again from step 3 
above. To continue with installation, click [Next].

5) The screen named ÒChoose Destination LocationÓ asks you to select the drive 
where the software will be installed. A default location will be shown on the 
screen. If you have more than one hard drive in your computer, you may change 
the destination to the disk drive where you wish SOFTmax PRO to reside or 
accept the default location.

6) The ÒSetup TypeÓ screen asks you to choose between ÒCompleteÓ (the default) or 
ÒBasic.Ó Basic installation installs all but the tutorial Þles. If you wish to omit the 
tutorials, choose Basic. Otherwise, just click [Next] to continue.

The [Back] button is available on all but the Þrst screen, allowing 
you to go back to previous screens and review or change information 
that you have entered.

7) The installer will also ask whether or not you would like your default protocol to 
be optical density or ßuorescence. Choose the appropriate option.

8) Click [Next] to start the actual installation of SOFTmax PRO files.

9) When installation is complete, the ÒFinishedÓ screen will appear. Click [Close] to 
end the installer/setup program. On the Macintosh, remove the CD by dragging 
its icon to the Trash. On the PC, close the window for the CD and ÒMy ComputerÓ 
and then press the CD eject button on the CD-ROM drive. Replace the CD in its 
holder and store it in a safe place.

An open folder named ÒSOFTmax PRO x.xÓ (where Òx.xÓ is the version of software 
you are installing) will be visible on your screen. It will contain the SOFTmax PRO 
program. If you want SOFTmax PRO to be able to communicate with your MAXline 
instrument, be sure to turn the instrument on prior to starting the SOFTmax PRO 
program. After the instrument is powered on and has completed its start-up 
sequence, double-click the ÒSpfÓ icon (  ) to start SOFTmax PRO.

In Windows, a shortcut for the program will be available in the Start 
menu under ÒPrograms\SOFTmax PRO x.x\Spf.Ó

NOTE:

NOTE:



Chapter 2: Installation

2-10 SOFTmax PRO UserÕs Manual

What Is Installed
A folder called ÒSOFTmax PRO 3.1Ó will be installed in the area you speciÞed 
on your computerÕs hard drive. Within this folder are a number of different 
Þles and subfolders. The following folders and items within those folders will 
be visible (note that folder and Þlenames are the same for Windows and Mac-
intosh except that Windows Þles have the extension Ò.pprÓ appended to the 
Þle name).

Table 2.1: Files that Are Installed

Folder Files

[Main] Default Protocol

Basic Protocols Basic Endpoint Protocol 
Basic Kinetic Protocol 
Basic Luminescence 
Basic Pathcheck Protocol 
Basic Percent Binding 
Basic Percent Control 
Basic Spectrum 
Basic TRF Protocol 
Raw Optical Density 

Cytoproliferation CYQUANT

Endpt ELISA AP and pNPP 
Bgalactosidase w ONPG 
HRP and ABTS w Acid Stop 
HRP and ABTS w SDS Stop 
HRP and OPD w Acid Stop 
HRP and TMB 
Urease and Urea Bromocreosol 

Kinetic ELISA K ELISA with AP and pNPP 
K ELISA with HRP and ABTS 
K ELISA with HRP and OPD 
K ELISA with HRP and TMB

LAL Kinetic Chromogenic Analyst QualiÞcation 
Interference Screening 
Interference Validation 
Reagent QualiÞcation 
Routine Testing complete 
Routine Testing simple 
RSE CSE Standardization 
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An uninstall program is available for Windows computers. Should 
you need to remove older versions of SOFTmax PRO from your hard 
drive, using the uninstall program is recommended since it also 
removes information regarding SOFTmax PRO from the Windows 
Registry. To remove SOFTmax PRO from a Macintosh computer, sim-
ply drag the SOFTmax PRO folder and any other SOFTmax PRO Þles 
you may have on your hard drive to the trash.

LAL Kinetic Turbidimetric Analyst QualiÞcation 
Interference Screening 
Interference validation 
Reagent QualiÞcation 
Routine Testing complete 
Routine Testing simple 
RSE CSE standardization 

Nucleic Acids DS DNA OD 260 280 320 with CR 
DS DNA OD 260 280 320 with WC 
DS DNA SPECTRAmax 250 quant 
DS DNA SPECTRAmax 250 quartz 
DS DNA with CR 
DS DNA with WC 
Oligreen 
PicoGreen 
SS DNA or RNA with CR 
SS DNA or RNA with WC 
SS Oligonucleotide with CR 
SS Oligonucleotide with WC 

Other Michaelis Menten 
Multiple Peak Protocol 
Multiple Peak wavelength and OD 
parallel line Analysis 
Sample Associated Blank

Protein Assays A280 with cuvette ref 
A280 with water constant 
BCA 
Bradford 
Lowry 
NanoOrange 

Table 2.1: Files that Are Installed

Folder Files

NOTE:
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Enter Registration Information

Turn on the MAXline instrument and allow it to complete its start-up 
sequence (approximately 30-90 seconds, depending on the instrument type). 
Then double-click the SOFTmax PRO program icon (  ) inside the SOFT-
max PRO folder (Mac) or directory/folder (Windows) to start the computer 
program. The Þrst time you open SOFTmax PRO, a registration dialog box 
will appear, asking that you enter your name, company, and the serial num-
bers of the software program and MAXline instrument. The software serial 
number can be found on the original SOFTmax PRO CD, on the inside cover 
of this manual, and on the software Warranty Registration Card (please 
remember to Þll out this card and return it to Molecular Devices Corpora-
tion). The instrument serial number (S/N) is located on a label afÞxed to the 
back of the MAXline instrument. Type the information and then click [OK]. 
Note that the option to click [OK] will not be available until all information 
has been entered. Enter the software serial number exactly as it appears on 
the inside front cover of the software manual or on the back of diskette num-
ber 2. Enter the instrument serial number as it appears on the back of the 
instrument.

Figure 2.6: Registration Dialog Box

After all information has been entered correctly and you click [OK], a title 
screen will appear (see Figure 2.7) showing the registration information you 
entered. If you have difÞculty entering the registration information, refer to 
Chapter 8, ÒTroubleshooting,Ó for assistance.
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Figure 2.7: SOFTmax PRO Title Screen

After a few seconds, the title screen will be replaced by an untitled SOFTmax 
PRO window (see Figure 2.8).

Figure 2.8: SOFTmax PRO Default Protocol Untitled Window
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Communicating with the MAXline Instrument

After installation of SOFTmax PRO, you will note that the instrument icon in 
the upper left-hand corner of the window appears with an ÒXÓ and the words 
ÒNo port selectedÓ through it. You must access the Preferences settings (from 
the Edit menu, choose the Preferences command) to select the proper com-
munications port (modem or printer for the Macintosh, COM1 or COM2 for 
the PC). An additional setting, which is the factory default, is ÒNeitherÓ (used 
when you do not have an instrument connected to the computer and wish to 
use SOFTmax PRO or if the port connection must be disabled for other rea-
sons). Choose the appropriate setting for your computerÕs physical serial port 
connection and click [OK].

Figure 2.9: Preferences Dialog Box (Windows)

The instrument icon should now appear normally (without an X through it).

If the port setting is correct and the MAXline instrument is on, yet communi-
cation is still not functioning properly, quit SOFTmax PRO, turn off power to 
both the computer and the MAXline instrument, and check that the cable con-
nections between the instrument and computer are secure. Turn both 
machines on again and restart SOFTmax PRO. If an ÒXÓ still appears over the 
icon, refer to Chapter 8, ÒTroubleshooting,Ó for more information.

Set Preferences

It is a good idea to set the SOFTmax PRO preferences before proceeding to 
use the program. The preferences include certain conÞguration settings, such 
as which port is used for the connection to the instrument, Þlters for Emax, 
Vmax, UVmax, and THERMOmax, as well as settings for automatic printing 
and saving of Þles, and the format for exported data. To make these selec-
tions, choose Preferences from the Edit menu to bring up the Preferences dia-
log box (see Figure 2.9).
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Serial Port
Check that the setting for the serial port matches the physical port used to 
connect the computer and the instrument. The example dialog box shown at 
the top of Figure 2.9 shows the serial port set to the Macintosh modem port. 
The Windows dialog box example shows the serial port set to COM1.

A selection of ÒNeitherÓ can be made for the serial port which can 
be selected if communication with an instrument is not required or if 
no instrument is connected to the computer. When this option is 
selected, the Status Bar in SOFTmax PRO will reßect it by showing an 
instrument icon with an ÒXÓ through it, along with the words ÒNo 
port selected.Ó This selection allows you to use the serial ports for 
other purposes (modem connection, network connection, or printing, 
for example), but does not allow you to communicate with a MAX-
line instrument.

Export Format
The preferences settings regarding the Export Format allow you to choose 
whether to export the data as it appears in plate format or linearly (over time). 
The option to include text labels along with numerical data can be activated 
by clicking ÒInclude Labels.Ó For more information on the Export... function, 
refer to ÒFile Creation and ManagementÓ on page 6-3.

Reader
The Reader pop-up menu indicates which reader is currently connected to the 
computer. When the computer is connected to a MAXline instrument, the 
instrument type shown in the box will be set to that instrument type.

If the computer is not connected to an instrument, the Reader type defaults to 
the last reader connected, but you can choose a different instrument from the 
menu.

It is not required that you choose a particular MAXline instrument 
prior to writing a protocol using SOFTmax PRO when the computer 
is not connected to an instrument. Choosing an instrument Þrst can 
be useful, however, since the options available in the Instrument 
Setup dialog box depend on the choice of instrument (for example, 
with a SPECTRAmax you can choose up to six wavelengths but you 
cannot do this with a Vmax).

Filters
The use of this button applies only to Emax, Vmax, UVmax, and THERMO-
max instruments (this button is dimmed when a SPECTRAmax instrument is 
selected). Clicking the [Filters] button brings up a dialog box showing six 
Þlter positions.

NOTE:

NOTE:
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Figure 2.10: Filters Dialog Box

Check that the Þlter wavelength shown for each position 
accurately reßects the wavelength of the Þlter installed in each posi-
tion of the Þlter wheel. Highlight and change (type over) incorrect 
values. If the settings in this dialog box are not correct, subsequent 
readings will generate incorrect data.

While the SPECTRAmax 250 can also accept two optional Þlters, the 
wavelengths for these Þlters are entered differently, using the instru-
ment front panel. For additional information regarding the installation 
of optional Þlters in the SPECTRAmax 250, refer to the instrument 
manual.

Autosave
Enabling the Autosave feature in the Preferences dialog box will save a data 
Þle automatically each time a plate is read.

Autosave saves a copy of the Þle that is currently open. If the Þle that is open 
is a protocol Þle, note that the Þle will still be ÒUntitledÓ (i.e., not named) even 
after an autosave has occurred. This allows you to to autosave to a text Þle 
format and then save manually as a SOFTmax PRO Þle.

You can Autosave to one of two different Þle formats:

¥ SOFTmax PROÑused to save your data automatically in SOFTmax PRO for-
mat.

¥ Text FileÑused when you want to have the data available for use with a 
spreadsheet or other program for data analysis external to SOFTmax PRO.

If you autosave as a text Þle, the SOFTmax PRO version of the data 
will not be saved automatically and you will not be able to automati-
cally re-open the data Þle in SOFTmax PRO. If you choose to save to 
this format, you will need to save your data manually, using the Save 
or Save As... commands in the File menu if you also want to save a 
SOFTmax PRO Þle. If you attempt to quit SOFTmax PRO before sav-
ing a Þle containing data that has not yet been saved, a message box 
will appear asking if you want to save the Þle. You can assign any 
name to a Þle you save manually.

If your protocol contains more than one experiment section when 
you Autosave to SOFTmax PRO Þle format, each experiment will be 
saved to a separate data Þle.

! CAUTION:

NOTE:

NOTE:

NOTE:
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When Autosave is enabled, the box below the Autosave option becomes 
active, allowing you to choose the folder within which data Þles will be saved 
and the type of Þle to be saved. You may choose to autosave as a SOFTmax 
PRO Þle (default) or as a text Þle and, when saving as a text Þle, you may 
choose to append to the same Þle.

Figure 2.11: Autosave Information (Windows)

The default folder for saving Þles is the SOFTmax PRO 3.1 folder. To save data 
Þles in a different folder, click the [Set] button. A dialog box will open, allow-
ing you to choose a new location for saved Þles.

Figure 2.12: Autosave Location Dialog Box (Windows)

Select Button
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Highlight the folder within which you want Þles to be saved. The [Select] 
button at the bottom of the dialog box will reßect this choice; clicking the 
[Select] button will set this folder as the default location for saved data Þles. 
You can change the location at any time by repeating this process.

To change the Þle format from SOFTmax PRO to ASCII text, select the Text 
File format from the list.

If the Autosave function is reporting an error, or if Þles are saved in 
the wrong location, it may be that a previous version of SOFTmax 
PRO was not uninstalled prior to installing a newer version. Follow 
the instructions given above to choose the correct folder for saved 
Þles.

Create New File (Text only)
After each Plate section or CuvetteSet section is read, the data will be saved in 
a new Þle. This Þle will contain all the data from the current and previous read-
ings (for example, if you read a Plate section, then another Plate section, fol-
lowed by a CuvetteSet section, File1 will contain data for Plate1; File2 will 
contain data for Plate1 and Plate2; and File3 will contain data for both plates 
and the cuvette). This option is available for both Þle formats (SOFTmax PRO 
and ASCII text). 

If you Autosave to ASCII text format, you will not have a 
SOFTmax PRO version of the Þle unless you also manually save the 
Þle using the Save as... command.

Append to File (Text only)
If you are saving data to an ASCII text Þle, you may choose to save all data to 
a single Þle for all plates and/or cuvettes by choosing ÒAppend to File.Ó This 
option is dimmed (not available) if you are saving to a SOFTmax PRO Þle.

File PreÞx
The information entered into the ÒFile PreÞxÓ Þeld is automatically given to 
new Þles that are saved automatically. The default preÞx is ÒData.Ó Accepting 
this default saves Þles starting with the name ÒDataÓ followed by a sequential 
number beginning with Ò1.Ó For example, the Þrst microplate read would be 
saved under the Þle name ÒData 1.Ó

Figure 2.13: File Prefix Field (Windows)

You can change this default preÞx to any other preÞx, provided the entire Þle 
name will not exceed 31 characters. To change the preÞx, click within the File 
PreÞx Þeld, highlight the existing information, and type over the word to 
enter a new preÞx.

If the File PreÞx Þeld is left blank, the date of the run will be used as the Þle 
preÞx.

NOTE:

! CAUTION:

File Prefix Field
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Append Date
Enabling the checkbox for Append Date will cause the date to be included in 
the automatic Þle name for the saved data Þle. For example, using the Þle pre-
Þx ÒData,Ó the Þrst Þle saved on January 31, 2000, would have the name 
ÒData 01/31/2000 1.Ó

Autoprint
Checking this box will enable automatic printing of a report after each plate is 
read. This report will contain information from each section that is designated 
to be included in the report (the default is for all sections to be included). 
For more information on reports, and including or excluding sections, see 
Chapter 3, ÒSOFTmax PRO Overview.Ó

Assays Folder

The Assays menu is used to choose the folder that will contain protocol Þles 
you wish to access most often. After installation of SOFTmax PRO, the proto-
col Þles shown under the Assays menu will be the basic protocols shipped 
with the software. Other folders are installed with SOFTmax PRO that con-
tain different protocol Þles for endotoxin assays (all instruments) and for 
DNA measurement (only needed if you are using a SPECTRAmax 250)Ñyou 
can select one of these folders instead, if desired.

To change the default folder, choose Assays and then choose Set Folder... . 
A dialog box will appear, asking you to choose the folder or directory con-
taining the protocol Þles you wish to have appear in the Assays menu. Select 
one of the other folders within the SOFTmax PRO directory/folder or, if you 
have other protocol Þles in a different location, choose that location and then 
click [Select].

If you do not see any Þles in the Assays menu or if the Þles shown 
are not correct, it may be that a previous version of SOFTmax PRO 
was not uninstalled prior to installation of a newer version. This can 
cause SOFTmax PRO to default to using the old directory for assay 
Þles rather than the directory associated with the most current pro-
gram version. Follow the instructions given above to choose the cor-
rect folder for the default assays folder.

NOTE:



Chapter 2: Installation

2-20 SOFTmax PRO UserÕs Manual



Chapter 3: SOFTmax PRO Overview

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
The SOFTmax PRO Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
Window Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6
Status Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
Experiments and Sections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8

Experiments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
Sections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9
Notes Section. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13
Plate Section  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
CuvetteSet Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-17
Group Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-19
Graph Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-21

Instrument Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-23
Menus and Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-23

Apple Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-26
About SOFTmax PRO . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-26
File Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-26
Edit Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-28
View Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-30
Experiment Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-30
Control Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-31
Assays Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-32
Plate Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-32
CuvetteSet Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-34
Notes Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-35
Graph Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-36
Group Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-37
Window Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-38
Help MenuÑWindows . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-38
Help MenuÑMacintosh  . . . . . . . . . . . . . . . . . . . . . . . . . . 3-38

Interprocess Messaging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-39



Chapter 3: SOFTmax PRO Overview

3-2 SOFTmax PRO UserÕs Manual



Chapter 3: SOFTmax PRO Overview

SOFTmax PRO UserÕs Manual 3-3

Introduction

This chapter presents a general description of the features and use of 
SOFTmax PRO. It describes:

¥ the parts of the SOFTmax PRO window, including experiments 
and sections;

¥ the menus and tool bars found within the SOFTmax PRO program;
¥ the basic steps required to perform a reading (complete information regard-

ing reading using SOFTmax PRO can be found in Chapter 4, ÒReading 
Microplates and CuvettesÓ); and

¥ the basic types of data analysis (detailed information regarding data analy-
sis can be found in Chapter 5, ÒDisplaying and Analyzing DataÓ).

SOFTmax PRO employs standard Macintosh and Windows conventions for 
using menus, dialog boxes, windows, and the mouse. This manual assumes 
that you are familiar with the basic operation of your computer. While some 
general instructions are given here, and many of the terms used in SOFTmax 
PRO are deÞned in Chapter 1, ÒGlossary of Terms,Ó if you need additional 
assistance regarding the basic use of your computer, please review the docu-
mentation accompanying it.

The SOFTmax PRO Window

When you start SOFTmax PRO, a title screen will appear, showing the infor-
mation entered during registration, along with the SOFTmax PRO version, 
the instrument type (if connected), the ROM version installed in the instru-
ment (if available), and copyright information.

Figure 3.1: SOFTmax PRO Title Screen.
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After a few seconds, the title screen will be replaced by an untitled SOFTmax 
PRO window. The window for the Macintosh should now look similar to the 
one in Figure 3.2. The window for the PC should look similar to the one in 
Figure 3.3.

The SOFTmax PRO screen contains these major elements:

¥ A menu and status bar located at the top of the screen;

¥ An untitled window showing an experiment containing various sections, 
depending upon the conÞguration of the default protocol used and the type 
of instrument chosen in the Preferences or connected to the computer.

The menu and status bars are always visible while you are using SOFTmax 
PRO, no matter where you are within the program.

Figure 3.2: SOFTmax PRO Screen and Window for Macintosh.
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Figure 3.3: SOFTmax PRO Screen and Window for the PC (Windows).
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Window Size

You may change the size of the window shown on the Macintosh by dragging 
the size box (at the bottom right corner of the window) in any direction. You 
can expand the window to the full size of the screen by clicking the zoom box 
(in the upper right corner of the window). If you extend the bottom edge of 
the window beyond the last section or the right edge beyond the edge of the 
sections, the intervening space will be gray. To resize the window again, drag 
the size box to a different position or click the zoom box again. Clicking the 
zoom box will restore the previous window size.

If you move the SOFTmax PRO window such that the title bar is 
under the status bar, you will have to hide the status bar before you 
can move the window to see the title bar again.

You may change the size of the window shown in Windows by dragging the 
side, bottom, or corner of the window (when the cursor changes into a dou-
ble-headed arrow). You can expand the window to the full size of the screen 
by clicking the Maximize button in the upper right corner of the window. If 
you extend the bottom edge of the window beyond the last section or the 
right edge beyond the edge of the sections, the intervening space will be gray. 
You can also reduce the window to an icon by clicking the Minimize button in 
the upper right corner of the window. When the window is shown as an icon, 
it is still functional; double clicking the icon will restore the window to its pre-
vious size. Other options are available for resizing windowsÑrefer to the doc-
umentation that came with your Windows software for more information.

The width of the experiment and sections shown in the window is 
constrained by the width set for the printed page size. The dimen-
sions and orientation of the printed page (and, consequently, the dis-
play size) may be changed by selecting either Page Setup... 
(Macintosh) or Print Setup... (Windows) from the File menu.

NOTE:

NOTE:
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Status Bar

Near the top of the SOFTmax PRO window is a status bar that shows the type 
of instrument that is connected to the computer or selected as the Reader type 
via the Preferences menu (see Figure 3.4).

Figure 3.4: Status Bars for MAXline Instruments

The status bar shows some or all of the following items, depending on the 
type of instrument connected or chosen (from left to right):

Instrument icon. An icon such as that shown at the left indicates that the in-
strument is communicating properly with the computer. If an ÒXÓ appears on 
top of the icon, the computer is not making proper contact with the instru-
ment. 

Double-clicking on the instrument icon brings up the Preferences 
dialog box.

Temperature display. With THERMOmax, VERSAmax, or SPECTRAmax in-
struments, a small window after the instrument icon shows the current tem-
perature within the microplate/cuvette chamber in degrees Celsius.

The [Read] button. If a single Plate or CuvetteSet section has been created in 
the experiment window, clicking the [Read] button starts the reading. This 
reading is based on the settings chosen in the Instrument Settings dialog box 
(refer to ÒInstrument SetupÓ) for the plate.

If more than one Plate or CuvetteSet section has been created in the experiment 
window and no Plate or CuvetteSet section is currently active, clicking the 
[Read] button opens a dialog box asking you to select which plate (or cuvette) 
to read. If a CuvetteSet or Plate section is active when you click the [Read] but-
ton, that section is read automatically.

The [REF] button. If a CuvetteSet section has been created and is active, this 
button will be displayed. Clicking the [REF] button will reference the cuvette. 
The reference is based on information entered in the Instrument Settings dia-
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log box. The reference reading may be taken before or after the sample read-
ing.

The Incubator button. With THERMOmax, VERSAmax, and SPECTRAmax 
instruments, clicking the button that shows a thermometer causes the ÒIncu-
batorÓ dialog box to appear, allowing you to set and regulate the temperature 
of the microplate/cuvette chamber. The temperature setting can be left at the 
default or can be specified by typing a different value in the box.

The incubator setting is independent of the protocol being run. Run-
ning an assay does not automatically set the temperature set point. 
After a reading, however, the temperature set point, range, and aver-
age temperature are recorded in the saved Þle.

The Automix button. Clicking this button shakes the microplate. (Note: This 
is a ÒmanualÓ shaking of the plate as opposed to an ÒautomaticÓ shaking that 
can be chosen in the instrument settings and is not enabled for the Emax.)

Drawer button. Clicking this button opens or closes the microplate drawer.

The status bar can be hidden from view by selecting Hide Status 
from the View menu. Selecting Show Status from the view menu will 
restore it to view.

Experiments and Sections

Experiments
Each SOFTmax PRO Þle contains at least one experiment (and can contain 
more than one). Within an experiment are one or more sections (discussed 
below). Experiments deÞne a naming scope for the sections within them and 
provide you with quick access to different types of information without open-
ing or referring to multiple Þles.

An experiment can be selected by clicking its tool bar (the area that shows the 
experiment name) with the mouse. Selecting an experiment causes its tool bar 
to change from light gray to darker gray and the experiment title to be shown 
in boldface type. Selecting is different from activating an experiment. Selecting 
an experiment allows you to perform actions on the entire experiment (such 
as deleting or duplicating it). Multiple experiments can be selected by holding 
down the Shift key while clicking the individual tool bars of the experiments.

A single click anywhere within an inactive experiment activates it. Activating 
an experiment allows you to add new sections to it or to perform other opera-
tions within that experiment. (With sections, however, selecting and activating 
are identical functions. Clicking anywhere within an inactive section activates 
and selects it.)

Creating a new experiment by choosing either New or Duplicate from the Edit 
menu creates an identical copy of the experiment (excluding data). The new 
experiment retains the same name as the original, with the word ÒCopyÓ 
appended when you choose to Duplicate (e.g., the duplication of ÒExpt1Ó pro-
duces ÒExpt1 CopyÓ) and an increment of number when you choose New 
(e.g., ÒExpt1Ó becomes ÒExpt2Ó).

NOTE:

NOTE:
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An experiment can be deleted if it is no longer needed. The Delete command 
in the Edit menu changes depending upon which experiment is active. For 
example, if the experiment titled ÒExperiment #1Ó is active, the Edit menu 
will show Delete Experiment #1. Using the Macintosh, you can also delete 
the selected experiment by pressing z -; within Windows, you can press 
CTRL+-. Take care when deleting experiments that they do not contain infor-
mation you wish to save.

You may also choose to delete multiple experiments simultaneously by hold-
ing down the Shift key and activating the tool bars of the experiments you 
wish to delete. Having done this, the Edit menu will now show Delete Selec-
tion instead of Delete Experiment.

You can add new sections to the active experiment using the New Section 
command under the Edit menu.

Sections
There are Þve types of sections: Notes, Plate, Cuvette, Group, and Graph. A 
brief synopsis of these sections is given below.

Notes sections are used to record information pertaining to the experiment. 
You can enter text in this section as you desire; in addition, you can create sum-
maries containing formulas for displaying reduced data. Text in Notes sec-
tions can be formatted (font, size, and style any way you choose).

Each Plate section shows a grid of cells which corresponds to the wells of the 
microplate. To the right of or underneath this grid is a box showing the current 
instrument settings (except incubator settings, which are always shown at the 
bottom of the Plate section after data is acquired). In the Plate section, you de-
fine a template to be used for analysis, determine the instrument settings, 
choose how the data will be displayed, and define the type of reduction (if any) 
that will be performed on the raw data received from the instrument.

CuvetteSet sections (SPECTRAmax PLUS or PLUS384 only) determine how 
the cuvette will be read, define templates to be used for analysis, display 
data as it is acquired from the instrument, define how the data will be dis-
played, and define the type of data reduction. The CuvetteSet section can 
display samples in three different ways: three samples per row, one sample 
per row, and in a grid of cells which is similar to a microplate format. To the 
right of the data display in the section is a box showing the current instru-
ment settings, except incubator settings (these are shown at the bottom of the 
CuvetteSet section after the first cuvette in the set is read).

Group sections are created automatically when groups are defined in the 
Template Editor. The example shown at left is for a group named ÒStandard.Ó 
Protocol files generally contain default groups; you can create others as need-
ed. Each Group section contains default columns of data which can also be 
changed, if desired. Within a Group section, you can resize columns, modify 
existing columns to use different analysis formulas, add columns containing 
new formulas, and/or add one or more summaries at the bottom of the sec-
tion.

Graph sections are used to plot information from groups (defined in the Tem-
plate Editor). Values associated with the X- or Y-axes depend on the type of 
group selected for graphing. More about Graph sections can be found in Chap-
ter 5, ÒDisplaying and Analyzing Data.Ó
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General Information about Sections
Sections are either active or inactive. Multiple sections can be active at the 
same time. The tool bar of an active section is darker gray (not pastel colored). 
Inactive sections are color coded to make it easier to discern a sectionÕs type:

Inactive Experiment or Section  . . . . . . . Color (Pastel Shade)

Experiment . . . . . . . . . . . . . . . . . . . . . . . . . Gray
Plate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Purple
CuvetteSet . . . . . . . . . . . . . . . . . . . . . . . . . . Green
Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Yellow
Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pink
Graph. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Blue

Clicking anywhere in an inactive section makes it active. Selecting an experi-
ment deactivates any individual section within it that may have been active 
and vice versa. Activating a section also activates the experiment containing 
that section. To activate multiple sections at the same time, hold down the 
Shift key and click in the tool bars of the sections you wish to activate. Doing 
this allows you to move, copy, duplicate, print, and delete multiple sections 
simultaneously.

The last item (farthest right) in the SOFTmax PRO menu bar changes to reßect 
the section type that is currently active. If a Plate section is active, for example, 
the last menu item will be Plate. If an experiment is selected, this menu will 
not be shown.

New Plate, Cuvette, Notes, or Graph sections can be created whenever you 
need them and more than one of each type of section can exist in a single 
SOFTmax PRO experiment. (Group sections are created automatically when 
you deÞne new groups in the Template Editor or may be created with the 
Duplicate command.) 

A section can be deleted if it is no longer needed. The Delete command in the 
Edit menu changes depending upon which section is active. For example, if 
the section titled ÒPlate #1Ó is active, the Edit menu will show Delete Plate #1. 
Using the Macintosh, you can also delete the active section by pressing z-; 
within Windows, you can press CTRL+-. Take care when deleting sections that 
they do not contain information you wish to save. You may also delete multi-
ple sections simultaneously by making them activeÑthe Delete command in 
the Edit menu will change to show Delete Selection.

Deleting a Group section automatically deletes references to that 
group from the Template. See Chapter 4, ÒReading Microplates and 
Cuvettes,Ó for more information.

Section tool bars contain buttons and pull-down menus. Buttons in the tool 
bar are only enabled when that section is active (the section does not need to 
be open). Menu equivalents exist for all tool bar functions. Figure 3.5 shows 
the active tool bar from a Graph section. 

Figure 3.5: Tool Bar from an Active Graph Section

If you scroll the window vertically so that part of an open/active section is 
hidden, its tool bar ÒsticksÓ to the top of the window (See Figure 3.6). This fea-
ture prevents the active tool bar from becoming unavailable if you are view-

NOTE:
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ing the bottom of a section that is longer than the size of the window. When 
the next section scrolls to the top of the window, its tool bar replaces the pre-
vious one but is not active, even if the section is open. If you scroll back so that 
even a small part of the previous section is visible, its tool bar returns to the 
top of the window.

Figure 3.6: Example of a Tool Bar ÒStickingÓ to the Top of the Window.

Opening and Closing Sections
Newly created experiments and sections are initially shown in their full-size 
(open) form. You can close them, however, to show just their tool bars, if 
desired. Sections that are created automatically by SOFTmax PRO may be 
shown initially either open or closed, depending on the default protocol Þle in 
use.

To open or close a single section within SOFTmax PRO, click its indicator  
located in the top left corner of the tool bar. When an experiment or section is 
closed, the indicator points to the right ( ); when open, the indicator points 
down ( ). Figure 3.7 shows an open experiment containing three sectionsÑ
the Þrst two are closed, the last (CuvetteSet) is open.
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Figure 3.7: Closed and Open Sections. The Notes#1 and Plate#1 sections are closed; 
the CuvetteSet#1 section is open.

To open or close multiple sections within an experiment (or multiple experi-
ments in a Þle) simultaneously, use the Expand and Minimize commands in 
the View menu. Selecting Minimize (zM for Macintosh; CTRL+M for Windows) 
will close all sections (leaving experiments open) to show only section title 
bars. Selecting Expand (zE; CTRL+E) will open all sections.

If you close or minimize an experiment, the tool bars in that experi-
ment will be hidden (see Figure 3.8). If all sections are presently 
expanded, the Expand command is dimmed (unavailable).

Figure 3.8: Result of Minimizing an Experiment (Tool Bars Hidden)

You may also open a section in a separate window. Double-clicking the sec-
tion icon (in the tool bar) or selecting New Window from the active section 
menu (either Plate, CuvetteSet, Graph, Notes, or Group) causes the currently 
active section to open as a separate window (a copy of the tool bar still 
remains in the original experiment, but the section is closed; clicking the 
closed section places the new window behind the main window (the original 
section remains closed). Clicking on the triangle in the section tool bar closes 
the new window and causes the section in the experiment to open (and clos-
ing the separate window opens the section within the experiment again). All 
of the tool bar options applicable to the section are available in the separate 
window (except the triangle indicator).

Open

Closed

NOTE:
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Figure 3.9: Separate Section Window

Notes Section

Figure 3.10: Example Notes Section, Named ÒResults.Ó

Tool Bar

Body

Summaries
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The Notes section is used to record information that pertains to the experi-
ment. You can enter text of any kind and add summaries containing reduction 
formulas.

The Notes section is divided into two areas:

¥ The tool bar

¥ The body

You may create multiple Notes sections within the same experiment.

The tool bar contains the following items (shown with their tool bar or mouse 
equivalents). These menu items and buttons are active only when a Notes sec-
tion is active.

Table 3.1: Notes Section Menu Commands and Tool Bar Buttons

Menu Command/
Mouse Equivalent

Description Tool Bar Button

Notes section icon Opens the Notes section 
in a new window  (double-click)

Name of Notes section Opens the Section dia-
log box

 
(double-click)

New Window in the 
Notes menu

Opens the section in a 
new window

Section Name in the 
Notes menu

Opens the Section Name 
dialog box

Create Summary in the 
Notes menu

Opens the Calculation 
dialog box, allowing you 
to create a summary

Edit Summary in the 
Notes menu or double-
click the summary 
(pointer changes to dou-
ble-headed arrow)

Opens the Calculation 
dialog box, allowing you 
to edit the summary

Show/Hide Formulas in 
the Notes menu

Shows/hides the calcu-
lations used to derive 
summaries

Printer icon Includes/excludes sec-
tion from printed report
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Plate Section

Figure 3.11: Plate Section.

The Plate section is used to collect data from the instrument, deÞne how the 
data is displayed, and what the initial reduction of the data will be. In addi-
tion, the Template Editor in the Plate section is used to create a ÒmapÓ of the 
contents of the microplate.

Choosing a particular function or command in the Plate section can be done 
in several ways. You can use the mouse to click on a button, choose a com-
mand from one of the drop-down menus in the menu bar, or press a keystroke 
combination to activate a command or function.

The Plate section is divided into four areas:

¥ Tool bar

¥ Data display (shown in a microplate grid format)

¥ Instrument settings, shown to the right of or below the data display, 
depending on the plate type and printer settings

¥ Reduction settings, shown to the right of or below the data display, depend-
ing on the plate type and printer settings

When the grid in the Plate section shows colors, this means that a template 
has been deÞned for this Plate section. Each group deÞned in the template has 
a different color (the icon of the corresponding group table will have the same 
color).

If your experiment requires multiple plates, you can create as many Plate sec-
tions as needed.

The Plate menu contains the items shown in Table 3.2 (shown with their tool 
bar or mouse equivalents). These menu items and buttons are active only 
when a Plate section is active.

Tool Bar

Data Display

Instrument Settings

Reduction Settings
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Table 3.2: Plate Section Menu Commands and Tool Bar Buttons

Menu Command/
Mouse Equivalent

Description
Tool Bar 
Button

Plate section icon Opens the Plate section in a new window  
(double-click)

Name of Plate section Opens the Section dialog box  
(double-click)

Instrument Setup... in the Control 
menu

Opens the Instrument Settings dialog box for this 
plate

Template... in the Plate menu Opens the Template dialog box allowing you to 
create or edit the template

Reduction... in the Plate menu Opens the Reduction dialog box containing 
reduction settings

Double-click in a single well or 
when several wells are selected; 
Graph in the Plate menu

Enlarges selected well(s) to a Well Graph display 
(kinetic and spectrum modes only); choosing 
Graph again returns to regular display (toggle)

Display... in the Plate menu Opens the Display dialog box containing display 
choices

Mask in the Plate menu Masks the selected wells

Printer icon Includes/excludes section from printed report

Section Name... in the Plate menu Opens the Section dialog box, allowing you to 
rename the section

New Window in the Plate menu Opens the section in a new window

Copy Template in the Plate menu Copies the template, allowing it to be pasted to 
another Plate section

Paste Template in the Plate menu Pastes a previously copied template to a new 
Plate section

Export Template in the Plate 
menu

Opens the Export Template to... dialog, allowing 
you to export a template to an ASCII text Þle

Import Template in the Plate 
menu

Opens the Import Template to... dialog, allowing 
you to import a template from an ASCII text Þle
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CuvetteSet Section

Figure 3.12: CuvetteSet Section

The CuvetteSet section allows you to collect data from the cuvette port of the 
SPECTRAmax PLUS or PLUS384, deÞne a template to be used for analysis, 
define how the data will be displayed, and define the type of data reduc-
tion. The Template Editor in the CuvetteSet section is used to describe the 
contents of the Cuvette.

Choosing a particular function or command in the CuvetteSet section can be 
done in several ways. You can use the mouse to click on a button, choose a 
command from one of the drop-down menus in the menu bar, or press a key-
stroke combination to activate a command or function.

The CuvetteSet section is divided into four areas:

¥ Tool bar

¥ Data display (can be shown in three different ways: three samples per row, 
one sample per row, and in a grid of cells which is similar to a microplate 
format)

¥ Instrument settings, shown to the right of the data display

¥ Reduction settings, shown at the bottom of the data display

When colors appear in the name labels above individual cuvettes (when dis-
played as one or three cuvettes per row) or when colored areas appear when 
the CuvetteSet section is displayed as a grid, this means a template has been 
deÞned for the CuvetteSet section. Each group deÞned in the template has a 
different color (the icon of the corresponding group table will have the same 
color).

If your experiment requires multiple cuvettes, you can add up to 96 cuvettes 
in a single CuvetteSet section and/or create more than one CuvetteSet sec-
tion.

The CuvetteSet menu contains the items shown in Table 3.3 (shown with their 
tool bar or mouse equivalents). These menu items and buttons are active only 
when a CuvetteSet section is active.

Tool Bar

Data Display

Instrument Settings

Reduction Settings
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Table 3.3: CuvetteSet Section Menu Commands and Tool Bar Buttons

Menu Command/
Mouse Equivalent

Description
Tool Bar 
Button

CuvetteSet section icon Opens the CuvetteSet section in a new win-
dow

 
(double-click)

Name of CuvetteSet section Opens the Section dialog box  
(double-click)

Instrument Setup... in the Control 
menu

Opens the Instrument Settings dialog box for 
this CuvetteSet section

Template... in the CuvetteSet menu Opens the Template dialog box allowing you 
to create or edit the template

Reduction... in the CuvetteSet menu Opens the Reduction dialog box containing 
reduction settings

Double-click a single cuvette or several 
selected cuvettes; Graph in the Cuvette-
Set menu

Enlarges selected well(s) to a Well Graph dis-
play (kinetic and spectrum modes only); 
choosing Graph again returns to regular dis-
play (toggle)

 

Display... in the CuvetteSet menu Opens the Display dialog box containing dis-
play choices

Mask in the CuvetteSet menu Masks the selected cuvettes

Printer icon Includes/excludes section from printed 
report

Section Name... in the CuvetteSet 
menu

Opens the Section dialog box, allowing you 
to rename the section

New Window in the CuvetteSet menu Opens the section in a new window

Copy Template in the CuvetteSet 
menu

Copies the template, allowing it to be pasted 
to another CuvetteSet section

Paste Template in the CuvetteSet 
menu

Pastes a previously copied template to a new 
CuvetteSet section

Export Template in the CuvetteSet 
menu

Opens the Export Template to... dialog, 
allowing you to export a template to an 
ASCII text Þle

Import Template in the CuvetteSet 
menu

Opens the Import Template to... dialog, 
allowing you to import a template from an 
ASCII text Þle
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Group Section

Figure 3.13: Group Section

Group sections are created automatically when you create or select groups for 
the experiment in the Template Editor. A Group section is a table which 
shows all of the information for a particular group. A group is a set of associ-
ated samples which have been created in the Template. Depending on the 
default assay chosen, certain group types (such as Standard or Unknown) 
may have been created; you can create others as required. Group sections may 
also be created by duplicating existing Group sections.

The Group section is divided into three areas:

¥ The tool bar

¥ The body of the Group table

¥ The summaries

The Group menu contains the following items (shown with their tool bar or 
mouse equivalents). These menu items and buttons are active only when a 
Group section is active.

Tool Bar

Body

Summaries
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Table 3.4: Group Section Menu Commands and Tool Bar Buttons

Menu Command/
Mouse Equivalent

Description Tool Bar Button

New Window in the 
Group menu

Opens the Group section in 
a new window  (double-click)

Name of Group sec-
tion

Opens the Group settings 
dialog box

 
(double-click)

Group Settings in the 
Group menu

Opens the Group Settings 
dialog box

Create Summary in 
the Group menu

Opens the Calculation dia-
log box, allowing you to 
create a summary

Create Column in the 
Group menu

Opens the Calculation dia-
log box, allowing you to 
create a column

Edit Summary in the 
Group menu or dou-
ble-click the summary 
(pointer changes to 
double-headed arrow)

Opens the Calculation dia-
log box, allowing you to 
edit the summary

Edit Column in the 
Group menu or dou-
ble-click the column

Opens the Calculation dia-
log box, allowing you to 
edit the column

Show/Hide Formulas 
in the Group menu

Shows/hides the formulas 
used in columns and sum-
maries

Autosize in the Group 
menu

Enlarges or reduces col-
umn size to Þt the largest 
piece of text

Hide/Show All in the 
Group menu

Hides one or more selected 
columns or shows all col-
umns that were hidden

Hide Replicates in the 
Group menu

Hides data from all repli-
cates

Printer icon Includes/excludes section 
from printed report
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Graph Section

Figure 3.14: Graph Section

To create a graph section, choose New Graph from the Experiment menu. The 
Plots dialog box opens automatically and a default plot called ÒPlot#1Ó is 
selected. The plot will default to the Þrst group available in the experiment.

Once a graph has been created, new plots can be added and deleted, the axes 
can be customized, and the size (displayed area) of the graph can be changed. 
Grid lines can be enabled or disabled (default is enabled). Graphs may be dis-
played as bar graphs or scatter plots.

The Graph section is divided into three areas:

¥ The tool bar

¥ The body of the Graph section

¥ Plots information below the graph

Tool Bar

Body

Plot Information
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You may create more than one Graph section within an experiment. Plots in 
the Graph section must be deÞned from groups within the same experiment 
section as the graph, with one exception: if you duplicate an experiment that 
contains data in the Plate section and has a plot deÞned in a Graph section, 
that plot will remain in the duplicated Graph section (and new plots may be 
added).

The Graph menu contains the following items (shown with their tool bar or 
mouse equivalents). These menu items and buttons are active only when a 
Graph section is active.

Table 3.5: Graph Section Menu Commands and Tool Bar Buttons

Menu Command/
Mouse Equivalent

Description Tool Bar Button

New Window in the 
Graph menu

Opens the Graph section in 
a new window  (double-click)

Name of Graph sec-
tion

Opens the Section dialog 
box

 
(double-click)

Graph Settings in the 
Graph menu

Opens the Graph Settings 
dialog box

Drop-down menu allows 
you to choose a curve Þt

X Axis... in the Graph 
menu

Opens the X Axis Settings 
dialog box

Y Axis... in the Graph 
menu

Opens the Y Axis Settings 
dialog box

Printer icon Includes/excludes section 
from printed report

Graph Options in the 
Graph menu

Opens the Graph Options 
dialog box

Export Graph in the 
Graph menu

Opens the Export Graph 
As... dialog box
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Instrument Settings

You must specify the type of reading to be performed prior to actually read-
ing a microplate or a cuvette.

Instrument settings allow you to choose one of four read modes 
(endpoint, kinetic, spectrum, or well scan), a read type (ßuorescence, time-
resolved ßuorescence, or luminescence) if using the SPECTRAmax GEMINI 
or GEMINI XS, the number of wavelengths or the range of spectral data, 
timing for kinetic runs, and so on. Which settings are available depend upon 
the type of instrument connected or chosen in the Preferences and whether 
you are reading a Plate section or a CuvetteSet section.

Complete information regarding instrument settings can be found in Chapter 
4, ÒReading Microplates and Cuvettes.Ó

Menus and Commands

The menu bar for SOFTmax PRO is located at the top of the window (just 
beneath the title bar).

.

Figure 3.15: Menu Bar (Macintosh, top; Windows, bottom)

While working with SOFTmax PRO, you may access its tools and features 
through several means: menus, tool bars, dialog boxes, and keystrokes. Fig-
ure 3.16 shows all of the menu items that are available in SOFTmax PRO.

When menu items are unavailable, they are dimmed (shown as gray rather 
than black)Ñavailable choices depend on the action you are performing with 
the software. An ellipsis (three dots) following a menu item indicates that 
choosing this item will bring up a dialog box. Menu items followed by a trian-
gle are hierarchical menus: choosing such an item causes a submenu to 
appear to the right of the original item. Certain menu items can also be chosen 
by pressing keys on the keyboard. Within Windows, menu items contain an 
underlined letter in their names. Pressing the ALT key will activate the menu 
bar; pressing a letter key that corresponds to the underlined letter of a menu 
name will then activate that menu. Subsequent menu items can be activated 
(chosen) by simply pressing the underlined letter in their names (you do not 
need to press ALT again). For example, to open a Þle from within SOFTmax 
PRO using the keyboard shortcut, you would press ALT, F, O which will Þrst 
activate the menu bar, then select the File menu, then choose Open from the 
File menu.

When available, a shortcut key combination will be shown to the right of the 
command in the menu. On the Macintosh, begin by pressing and holding 
down the command (z) key followed by the key shown in the shortcut. Win-
dows users should press and hold the control (CTRL) key followed by the key 
shown in the shortcut.
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Some menus are divided into groups of items that perform related functions. 
Dividers are shows as thin, horizontal lines between menu items.

File. Items in this menu relate to entire SOFTmax PRO Þles. Commands to 
open, print, apply password protection, and save Þles are located here.

Edit. This menu contains features for changing items within SOFTmax PRO. 
Commands to select, copy/paste, delete and duplicate items are located here. 
This menu also contains the Preferences command, which allows you to set 
options regarding printing, communication with the MAXline instrument, 
and saving Þles.

View. Choices regarding what is shown and how it is shown are available 
here. The last section in this menu provides a navigational tool, allowing you 
to choose the particular section you would like to view (a section chosen in 
this manner will open if it was closed and will be brought into view within 
the window).

Experiment. Choices in this menu allow you to create new sections within the 
current experiment, as well as to create a completely new experiment.

Control. Items in this menu allow you to set up and activate MAXline instru-
ment functions.

Assays. This menu allows you to choose the folder containing the protocols 
you have saved and shows those protocols below the divider, making it easy 
to open one or more of them. A second level of folders can be stored within 
the Assays folder and will appear on the Assays menu, allowing you to sepa-
rate protocols further, as desired.

The last menu item (farthest right on the menu bar) changes to reßect the sec-
tion type that is currently active. If a Plate section is active, for example, the 
last menu item will be Plate. An active Graph section causes this menu to 
show Graph. If an experiment is selected, this menu will not be shown.

Menus function differently depending upon whether you are using Windows 
or the Macintosh (and can function differently depending on the OS in use). 
On the Macintosh, clicking and holding the mouse button down while the 
pointer is on any of the main menu items causes a drop-down list to appear. 
To choose a command from a list, drag the mouse until the choice is high-
lighted and then release the mouse button. Within Windows and with some 
versions of the Macintosh OS, clicking on the main menu item causes the 
drop-down menu to remain, allowing you to click once on any menu item to 
choose it.

Additionally, a number of buttons are available in different sections of the 
SOFTmax PRO experiment and section tool bars. Clicking these buttons 
accomplishes many of the same actions as choosing menu items.
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Figure 3.16: SOFTmax PRO Menus 

Menu
Title

Dimmed
Command

Keyboard
Shortcuts

Ellipsis (...)
indicates that
choosing this
command will
open a dialog box
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Apple Menu

About SOFTmax PRO
(Macintosh only) Displays the SOFTmax PRO version, registration informa-
tion, ROM version (if available from the instrument), and copyright informa-
tion. If an instrument is connected to the Macintosh running SOFTmax PRO, 
the instrument type will also be displayed. You will need to know this infor-
mation if you call for technical support. Other items in the Apple menu 
depend on the settings of your Macintosh.

File Menu
New... (zN; CTRL+N)ÑOpens a new Þle window, allowing you to begin a new 

or different data Þle. Information from each SOFTmax PRO window 
(which can consist of one or more experiments with their sub-sec-
tions) is saved to a separate Þle.

Open... (zO; CTRL+O)ÑOpens an existing SOFTmax PRO file (or an older 
SOFTmax file). When you choose Open from the File menu, a dialog 
box appears. To open a file from the list of available files, double-click 
the filename to be opened, or click once on the filename and then click 
the [Open] button.

Close (zW; CTRL+W)ÑCloses the front-most (active) window. If you have only 
one file open, this file will be closed. If you have changed the file in any 
way since it was opened, a dialog box will open asking if you want to 
save the file before closing. (This menu item is dimmed if no window 
is open.)

Save (zS; CTRL+S)ÑSaves the active window to a Þle. The active Þle name is 
shown at the top of the status window (protocol Þles are always 
shown as ÒUntitledÓ). To save the Þle in a different folder/subdirecto-
ry or under a different name, use Save As.... If the Þle has not yet been 
saved and given a name (is ÒUntitledÓ), the Save As... dialog box will 
appear and you will be asked to name the Þle. (This menu item is 
dimmed if the file has already been saved and no changes have been 
made.)

Save As...ÑSaves a file with a new file name or into a new folder or subdirec-
tory. See Chapter 6, ÒSaving Files Manually,Ó for more information 
about using the Save As... command for saving files.

Import/Export...ÑImport brings tab-delimited ASCII text file information 
into SOFTmax PRO and Export creates a file of Plate section, Cuvette-
Set section data, and/or Group table section data. All information 
from SOFTmax PRO can be saved as tab-delimited ASCII (or text) for-
mat, which is suitable for importing into word processing or spread-
sheet programs.

After choosing Import, a dialog box will appear asking you to choose 
the file you wish to import. Files to be imported must contain specific 
header information. For more information on importing files into 
SOFTmax PRO, see ÒExporting/ Importing InformationÓ on page 6-
17.


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After choosing Export, a dialog box will appear, asking you to name 
the file and choose a location where the file should reside. In addition, 
the dialog box will ask you to choose which sections should be export-
ed (you can choose to export all or some Plate, CuvetteSet, or Group 
table sections).

The data that is exported out of the Plate section or CuvetteSet section 
will be the same data currently displayed in that Plate section or Cu-
vetteSet section: either raw or reduced data.

One additional parameter that affects export function is located under 
Preferences in the Edit menu. You may choose to export the data in 
plate format (8 × 12 array of numbers for a 96-well plate, for example) 
or in time format (a single line or row). You may also choose for the 
exported file to be created with or without labels.

Page Setup/Print SetupÑYou should access this command after you select a 
different printer in the Chooser (Macintosh), if you choose a differ-
ent printer using Windows, or if you want to use a different paper size 
or printing option. Choosing Page Setup/Print Setup opens a dialog 
box with various options for printing. More about this function can be 
found in the documentation that accompanies your computer and/or 
printer.

The Page Setup/Print Setup command also controls how SOFTmax 
PRO sections are displayed on your monitor (the width of the display 
corresponds to the width of the page size).

Print (Section name/Selection)ÑAllows you to print just the active section(s).

Print... (zP; CTRL+P)ÑWith the Macintosh, choose this command and then 
click either ÒPrint allÓ or ÒPrint report.Ó Print all sends all sections to 
the printer in the order they appear in the window. Print report sends 
those sections selected to be in the report to the printer in the order 
they appear in the window. From Windows, choose Print and then 
specify a page range or leave the default to print all pages.

Make sure you have selected the correct printer prior to choosing 
one of the Print options in the File menu. If you start to print and dis-
cover the wrong printer is selected, choose [Cancel] to exit from the 
Print dialog box, select the correct printer (using the Chooser or the 
Print Setup command), and then repeat the printing process.

Quit (zQ; CTRL+Q)ÑCloses SOFTmax PRO as well as any SOFTmax PRO files 
you may have open. If you have open files that have changed and have 
not yet been saved, a dialog box will ask if you want to save them be-
fore quitting.

NOTE:

NOTE:
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Edit Menu
Undo (zZ; CTRL+Z)ÑRestores the last text operation to the condition that exist-

ed before the editing was done (used primarily when entering text in 
Notes sections). This menu item is dimmed if no actions have been 
taken or if undoing the last action is not possible.

Cut (zX; CTRL+X)ÑRemoves highlighted information (text or data) from the 
document and stores it on the clipboard so it can be pasted elsewhere. 
(This menu item is dimmed if no selection has been made or if the se-
lection cannot be cut.)

Copy (zC; CTRL+C)ÑCopies selected (highlighted) text or data and stores it on 
the clipboard so it can be pasted elsewhere. (This menu item is 
dimmed if no selection has been made or if the selection cannot be cop-
ied.)

Parts of an experiment can be copied within the same experiment or to 
another application using the Copy and Paste commands. You may 
also use this command to copy information from SOFTmax PRO into 
other programs.

Paste (zV; CTRL+V)ÑPastes information from the clipboard just to the right of 
the insertion point in the document. Can also be used to import tab-
delimited data into SOFTmax PRO. (This menu item is dimmed if 
nothing has been copied to the clipboard.)

ClearÑClears or erases highlighted text (or data) without storing it on the clip-
board. (This menu item is dimmed if nothing has been selected.) You 
can remove one or more columns from a Group table, or text or formu-
las from a Notes section, by highlighting the column or text/formula 
and then choosing Clear from the Edit menu. Columns and text or for-
mulas can also be removed by highlighting them and pressing the De-
lete key.

Select All (zA; CTRL+A)ÑThe Select All command can be used in Notes, Plate, 
Cuvette, and Group sections when a section is active (it is not available 
in Graph sections).
In a Notes section, if no summaries are present, it will select all text. If 
summaries are present at the top or bottom of the Notes section, this 
command will select all text but not the summaries (which must be se-
lected individually). If the text is broken up by summaries, this com-
mand will select the largest block of text that it can (bounded by 
summaries).
In a Plate section, this command will select all wells, if one or more 
wells in the grid array has already been selected. If no wells have been 
selected, this command will be dimmed.
In a CuvetteSet section, this command will select all cuvettes if one or 
more cuvettes has already been selected. If no cuvettes have been se-
lected, this command will be dimmed.
In a Group section, this command will select all columns in the group 
table but will not include any summaries at the bottom of the group 
table (summaries must be selected individually).

Delete Section/Selection (z – ; CTRL+ -)ÑDeletes the currently active sec-
tion(s) or experiment(s). A warning dialog box will appear asking if 
you really want to delete the section(s) or experiment(s).
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Duplicate Section/ExperimentÑCreates new section(s) or experiment(s) that 
are exactly like the active section(s) or experiment(s)and positions the 
duplicated selection(s) after the currently active section(s). The names 
of the new section(s) or experiment(s) will have the word ÒCopyÓ ap-
pended to their name(s). For example, if you duplicate a section 
named ÒPlate#1,Ó the duplicate section will be called ÒPlate#1Copy.Ó 
Subsequent duplications will append an incremented number after 
the name (e.g., ÒPlate#1Copy#2Ó). For more information about this 
command and what is included when a section is duplicated, see ÒDu-
plicate and NewÓ on page 6-25.

Text Style... (zT; CTRL+T)ÑAllows you to change the attributes of selected text. 
(This command is dimmed if no text has been selected.)

Preferences... (double-click the instrument icon)ÑThrough the Preferences 
dialog box, you can choose settings for the following options:

¥ Serial port connection (modem port or printer port for the Macin-
tosh; COM1 or COM2 for the PC) that will be used to connect to the 
MAXline instrument. A third option, ÒNeither,Ó should be used 
when no instrument is connected to the computer.

¥ Export format (Time versus Plate, and whether or not to include 
labels).

¥ The instrument connected to the computer or, if none is connected, 
the type of instrument for which the software should be conÞgured.

¥ Whether or not Þles will be saved automatically and the location 
where saved Þles will be stored (Autosave).

¥ Whether or not reports should be printed automatically (Auto-
print).

¥ Wavelengths of Þlters installed in the Emax, Vmax, UVmax, or 
THERMOmax instruments (not used with SPECTRAmax or VER-
SAmax instruments).

Suspend RecalculationÑStops SOFTmax PRO from performing calculations 
based on changes you make to the settings or other program informa-
tion. This command is used most often when you want to make a 
number of changes to the settings without having to wait while the re-
sults of each change are recalculated.

Recalculate Now (z=; CTRL+=)ÑCauses SOFTmax PRO to recalculate data 
based on the current settings. This command is used most often when 
you have suspended automatic recalculation.
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View Menu
The View menu provides three commands: Minimize (zM; CTRL+M), Expand 
(zE; CTRL+E), and Hide Status. In addition to these choices, the names of the 
experiments appear at the bottom of the menu (sections within experiments 
are shown as submenus), allowing you to go to a speciÞc experiment or sec-
tion within an experiment by choosing the item. If the section was closed, 
selecting it from the View menu will open and activate it. The currently active 
section is shown in the menu with a checkmark next to it.

Minimize (zM; CTRL+M)ÑIf you select Minimize while a section within an ex-
periment is active, the sections within that experiment are minimized. 
If you choose Minimize while an experiment tool bar is active, all ex-
periments will be minimized (sections within are hidden and only the 
experiment tool bars are visible).

Expand (zE; CTRL+E)ÑIf you select Expand while a section within an experi-
ment is active, the sections within that experiment are expanded. If 
you choose Expand while an experiment tool bar is active, all sections 
within all experiments become visible (the sections may be minimized 
or expanded).

Hide Status/Show StatusÑHides or displays the status bar.

Experiment Menu
The Experiment menu provides Þve commands: New, New Notes, New Plate, 
New CuvetteSet, and New Graph.

NewÑCreates a new experiment directly following the active experiment (the 
new experiment then becomes the active experiment). All sections 
shown in the experiment that was active when this command is cho-
sen are duplicated in the new experiment.

New NotesÑCreates a new Notes section below the active section.

New PlateÑCreates a new Plate section below the active section. The new 
Plate section will be a copy of the active Plate section or, if no Plate sec-
tion currently exists, the new Plate section will use SOFTmax PRO de-
fault settings.

New CuvetteSetÑCreates a new CuvetteSet section below the active section 
The new CuvetteSet section will be a copy of the active CuvetteSet sec-
tion or, if no CuvetteSet section currently exists, the new CuvetteSet 
section will use SOFTmax PRO default settings.

New GraphÑCreates a new Graph section below the active section and brings 
up the Plots dialog box, allowing you to select the graph options.
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Control Menu
Instrument Setup...ÑThis command is available only if a Plate section or Cu-

vetteSet section is active. Choosing Instrument Setup opens the In-
strument Settings dialog box which allows you to enter the mode for 
the run (endpoint, kinetic, spectrum, or well scan), the wavelength 
settings, Automix parameters, pre-read blanking, strips, Path-
Check, timing for kinetic runs, Speed Read for spectral scans, read 
type, and plate type.

Not all options are available for all instruments. The options that 
are visible depend on the type of instrument that is connected to the 
computer (or selected in the Preferences).
Button Equivalent:  in the Plate section or CuvetteSet 
section tool bar.

ReadÑIn a single plate experiment, the Read command reads the plate or cu-
vette immediately. If no Plate section or CuvetteSet section is active in 
an experiment containing multiple Plate sections or CuvetteSet sec-
tions, the Read command displays a dialog box asking you to select 
which Plate section or CuvetteSet section to read. The default Plate 
section or CuvetteSet section, selected by pressing the Return key, is 
chosen on these criteria:

¥ The selected Plate section or CuvetteSet section, if one is select-
ed.

¥ The next unread Plate section or CuvetteSet section.

¥ The first plate or cuvette, if all have been read.

Once a reading is in progress, menu items are no longer available until 
the reading is finished.

Button Equivalent:  in the Status bar.

RefÑAvailable only when a CuvetteSet section is active and a SPECTRAmax 
PLUS or PLUS384 is connected or chosen in the Preferences. This com-
mand causes the SPECTRAmax PLUS or PLUS384 to read the cuvette 
in the cuvette port and applies the reading as a reference to all cu-
vettes in the CuvetteSet section.

Button Equivalent:  in the Status bar.

Close DrawerÑCloses the drawer, at which time the menu item changes to 
Open Drawer. The drawer opens or closes immediately.

Button Equivalent:  in the Status bar.

IncubatorÑ(Available with THERMOmax, VERSAmax, and SPECTRAmax 
instruments only) Allows you to turn the incubator on or off. When 
on, you can enter a setting for regulation of the temperature in the mi-
croplate chamber.

Button Equivalent:  in the Status bar.

CalibrationÑUseful primarily when doing spectral scans in the Speed Read 
mode. Calibration performs an air reference reading at each wave-
length and updates the non-volatile RAM of the instrument, thus pro-
viding new air calibration for the instrument.

NOTE:
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Assays Menu
Set Folder...ÑAllows you to select a folder or subdirectory containing com-

monly used protocol files. In addition to any protocol files residing 
within this folder (which will be listed below the dividing line and 
may be opened by clicking them), an additional level of subfolders (if 
any) will be shown below a center division. Protocol files can be used 
repeatedly (for specific types of assays, for example). These files can be 
named in any way you choose. 

Folder name(s) after dividing lineÑChoosing any of these folders will open a 
submenu showing protocol files residing in this subfolder. Select one 
of the protocol files to open it.

File name(s) after dividing lineÑThe files that appear here are protocol files 
that reside within the folder determined using the Set Folder... com-
mand. You can quickly open and use one of these protocol files by se-
lecting it from the Assays menu.

Plate Menu
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, 
depending on the type of section that is currently active. If no section is active, 
this menu item does not appear.

Template...ÑOpens the Template Editor.
The Template Editor allows you to describe the samples that are in the 
wells, thus providing the link between the raw data and the analysis 
groups. You can create new groups in the template or assign wells to 
already established groups.

If your experiment contains multiple Plate sections, the template for 
each Plate section must be deÞned using the Template Editor in that 
section. You can create a new template or modify an existing one using 
the Template Editor.

Each Plate section requires that a template be created in order to 
identify groups within that plate. However, two or more Plate sec-
tions may use the same template, or the same groups may be used in 
different templates.
After groups are deÞned in the template and you return to the Plate 
section, the data display will show the group areas in different colors.

Button Equivalent:  in the Plate section tool bar.

Reduction...ÑOpens the Reduction dialog box. Options available in the Re-
duction dialog box depend on the type of reading performed (end-
point, kinetic, spectrum, or well scan) and the instrument used to 
collect the data. The Reduction dialog box is used for initial reduc-
tion of the data collected from the microplate reader. The optical 
density information collected is reduced to a single number per well. 
More information regarding reduction options can be found in Chap-
ter 5, ÒDisplaying and Analyzing Data.Ó

Button Equivalent:  in the Plate section tool bar.

NOTE:
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Display...ÑOpens the Display dialog box. Allows you to decide how the infor-
mation in the Plate section will be displayed. More information re-
garding display options can be found in Chapter 5, ÒDisplaying and 
Analyzing Data.Ó

Button Equivalent:  in the Plate section tool bar.

Graph...ÑThe Well Graph command is modal, so it can be activated both dur-
ing data acquisition and after data has been acquired for a kinetic or 
spectrum reading. You can get a Òclose upÓ view of the plot shown in 
one or more wells by Þrst selecting the well(s) and then choosing the 
Graph... command. (This command is dimmed if the instrument set-
tings are for an endpoint reading or if no well in the Plate display has 
been selected.)

Button Equivalent:  in the Plate section tool bar.

MaskÑAllows you to ÒhideÓ certain wells so that they will not be taken into 
account when performing analyses. (This command is dimmed if no 
data has been acquired or if no wells in the plate have been selected.)

Button Equivalent:  in the Plate section tool bar.

Copy TemplateÑWhile a Plate section is open and active, choosing this com-
mand allows you to copy the template from this Plate section to the 
Clipboard, allowing you to paste it into a different Plate section (in the 
same or in a different experiment or into a Plate section in another 
SOFTmax PRO file).

Paste TemplateÑIf you have copied a template from a Plate section, you can 
then create or activate/open another Plate section and choose Paste 
Template. In this way, you can use the same template for more than 
one Plate section or you can modify the pasted template as desired.
If you are pasting a template into a new experiment and groups from 
the source template do not exist in the destination experiment, pasting 
the template will create them. Existing groups of the same name will 
not be changed by the pasting process. For example, if the template be-
ing copied contains the groups ÒStandardsÓ and ÒUnknown,Ó and the 
group ÒStandardsÓ already exists in the destination experiment, the 
group ÒUnknownÓ will be created but all information regarding the 
group ÒStandardsÓ in the destination experiment will remain un-
changed. If you copy and paste the template with the same experi-
ment, no new groups are created. Group names can be edited in the 
pasted template (these changes will be reflected in the original tem-
plate also).

Export TemplateÑOpens the Export Template to... dialog, allowing you to ex-
port a template to an ASCII text Þle.

Import TemplateÑOpens the Import Template to... dialog, allowing you to 
import a template from an ASCII text Þle.

Section Name...ÑAllows you to change the name of the Plate section.

Mouse Equivalent: double-click the name of the Plate (  )in 
the Plate section tool bar (to the right of the Plate section icon).

New WindowÑOpens the active section in a separate window.

Mouse Equivalent: double-click the  icon in the Plate section tool 
bar.
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CuvetteSet Menu
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, 
depending on the type of section that is currently active. If no section is active, 
this menu item does not appear.

Template...ÑOpens the Template Editor.
The Template Editor allows you to describe the samples that are in the 
wells, thus providing the link between the raw data and the analysis 
groups. You can create new groups in the template or assign cuvettes 
to already established groups.
If your experiment contains multiple CuvetteSet sections, the template 
for each CuvetteSet section must be deÞned using the Template Editor 
in that section. You can create a new template or modify an existing 
one using the Template Editor.
After groups are deÞned in the template and you return to the Cuvet-
teSet section, the data display will show the cuvettes that are assigned 
to groups by means of colors in their locator headings (if viewing by 
one or three cuvettes per row) or as colored outlines (if viewing in a 
grid), if you have a color monitor, or in shades of gray on a mono-
chrome monitor.

Button Equivalent:  in the CuvetteSet section tool bar.

Reduction...ÑOpens the Reduction dialog box. Options available in the Re-
duction dialog box depend on the type of reading performed (end-
point, kinetic, spectrum, or well scan) and the instrument used to 
collect the data. The Reduction dialog box is used for initial reduc-
tion of the data collected from the microplate reader. The optical 
density information collected is reduced to a single number per well.

Button Equivalent:  in the CuvetteSet section tool bar.

Display...ÑOpens the Display dialog box. Allows you to decide how the infor-
mation in the CuvetteSet section will be displayed.

Button Equivalent:  in the CuvetteSet section tool bar.

Graph...ÑDuring data collection and after data has been acquired for a kinetic 
or spectrum reading, you can get a Òclose upÓ view of the plot shown 
in one or more cuvettes by Þrst selecting the cuvette(s) and then choos-
ing this command. (This command is dimmed if the instrument set-
tings are for an endpoint reading or if no well in the Plate display has 
been selected.)

Button Equivalent:  in the CuvetteSet section tool bar.

MaskÑAllows you to ÒhideÓ certain cuvettes so that they will not be taken into 
account when performing analyses. (This command is dimmed if no 
data has been acquired or if no cuvettes in the set have been selected.)

Button Equivalent:  in the CuvetteSet section.

Copy TemplateÑWhile a CuvetteSet section is open and active, choosing this 
command allows you to copy the template from this CuvetteSet sec-
tion to the Clipboard, allowing you to paste it into a different Cuvet-
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teSet section (in the same or in a different experiment or into a 
CuvetteSet section in another SOFTmax PRO file).

Paste TemplateÑIf you have copied a template from a CuvetteSet section, you 
can then create or activate/open another CuvetteSet section and 
choose Paste Template. In this way, you can use the same template for 
more than one CuvetteSet section or you can modify the pasted tem-
plate as desired.
If you are pasting a template into a new experiment and groups from 
the source template do not exist in the destination experiment, pasting 
the template will create them. Existing groups of the same name will 
not be changed by the pasting process. For example, if the template be-
ing copied contains the groups ÒStandardsÓ and ÒUnknown,Ó and the 
group ÒStandardsÓ already exists in the destination experiment, the 
group ÒUnknownÓ will be created but all information regarding the 
group ÒStandardsÓ in the destination experiment will remain un-
changed. If you copy and paste the template with the same experi-
ment, no new groups are created. Group names can be edited in the 
pasted template (these changes will be reflected in the original tem-
plate also).

Export TemplateÑOpens the Export Template to... dialog, allowing you to ex-
port a template to an ASCII text Þle.

Import TemplateÑOpens the Import Template to... dialog, allowing you to 
import a template from an ASCII text Þle.

Section Name...ÑAllows you to change the name of the CuvetteSet section.
Mouse Equivalent: double-click the name of the CuvetteSet section

(  )to the right of the CuvetteSet section icon.

New WindowÑOpens the active section in a separate window.

Mouse Equivalent: double-click the  icon in the CuvetteSet sec-

tion.

Notes Menu
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, 
depending on the type of section that is currently active. If no section is active, 
this menu item does not appear.

Create Summary...ÑWhen the Notes section is active, choosing Create Sum-
mary opens a dialog box allowing you to give a title to a new summary 
and then enter a formula to be used for the summary.

Button Equivalent:  in the Notes section.

Edit SummaryÑIf you have created a summary and need to change it, you can 
do so by first highlighting the summary you wish to edit and then 
choosing Edit Summary. (This command is dimmed if you have not 
yet created a summary or if the summary has not been selected.) The 
dialog box then appears showing the name and formula.
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Mouse Equivalent: Double-clicking the summary performs the same 
function.

Button Equivalent:  in the Notes section.

Show FormulasÑChoosing this command shows the formulas associated with 
the summaries you have created in the Notes section. After choosing 
Show Formulas, the menu name changes to Hide Formulas. (This com-
mand is dimmed if you have not created any summaries.)

Section Name...ÑAllows you to change the name of the Notes section.
Mouse Equivalent: double-click the name of the Notes section

(  )to the right of the Notes section icon.

New WindowÑOpens the active section in a separate window.

Mouse Equivalent: double-click the  icon in the Notes section.

Graph Menu
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, 
depending on the type of section that is currently active. If no section is active, 
this menu item does not appear.

Graph Options...ÑYou can select from three types of graphs: Scatter (with 
symbols plotted and/or the points connected), Cluster Bar, or Stack 
Bar and you can set the height of the graph to be something other than 
the default percentage (100%). The font used for the title, legend, 
and/or axes can be changed and/or modified in size and style. Plots 
can be added, deleted, or edited. Editing plots allows you to change 
the plot name, its source (from which experiment and group), as well 
as the items to be plotted (for example, concentration vs. values).

Button Equivalent:  in the Graph section.

X-axis...ÑSets the X-axis parameters (tick marks, scale, label, gridlines, and 
autorange).

Button Equivalent:  in the Graph section.

Y-axis...ÑSets the Y-axis parameters (tick marks, scale, label, gridlines, and 
autorange).

Button Equivalent:  in the Graph section.

Section Name...ÑAllows you to change the name of the Graph section.
Mouse Equivalent: double-click the name of the Graph section

(  )to the right of the Graph section icon.

Export GraphÑCreates a file containing a picture of the graph with a filename 
of your choice. On the Macintosh, the graphic is in PICT format; in 
Windows, the graphic is in EMF (Enhanced MetaFile) format.

New WindowÑOpens the active section in a separate window.
Mouse Equivalent: double-click the  icon in the Graph section.
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Group Menu
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, 
depending on the type of section that is currently active. If no section is active, 
this menu item does not appear.

Create ColumnÑIf a Group section is currently active, you can add a column 
to the display by choosing this command. If no columns are highlight-
ed, the column will be added at the end of the group. If you select a 
column first, the new column will be added to the right of the high-
lighted column. 

Button Equivalent:  in the Group section.

Create SummaryÑAllows you to create a summary and enter a formula for 
this summary for the Group. Summaries appear at the bottom of the 
group table.

Button Equivalent:  in the Group section.

Edit ColumnÑSelecting a column makes this command active. Choosing Edit 
Column allows you to change the formula associated with the column 
and to change the column name.
Mouse Equivalent: Double-clicking the column performs the same 
function.

Button Equivalent:  in the Group section.

Edit SummaryÑAllows you to edit the formula associated with the summary, 
as well as to change the summary name. (This command is dimmed if 
a summary has not yet been created.) First highlight the summary and 
then select this command.
Mouse Equivalent: Double-clicking the summary performs the same 
function.

Button Equivalent:  in the Group section.

AutosizeÑChoosing this command expands or shrinks the width of selected 
columns to accommodate the largest piece of text in the column.
Mouse Equivalent: Double-clicking the line to the right of the column 
heading performs the same function.

HideÑHides the selected column from view. (This command is dimmed if a 
column has not been selected.)
Mouse Equivalent: Dragging the line to the right of the column head-
ing until it is on top of the line to the left of the column performs the 
same function.

Hide ReplicatesÑHides data for all replicates (if any) from view.

Show AllÑShows all columns or replicates that were hidden previously.

Show FormulasÑCauses a new row to appear beneath the headings of each 
column showing the formulas used to determine the data in the col-
umns. After choosing this command, the menu name changes to Hide 
Formulas. 

Group SettingsÑOpens the Group Settings dialog box, allowing you to re-
name a group and/or change the sample or group descriptors used, as 
well as to modify the units used with each descriptor.
Mouse Equivalent: double-click the name of the Group section
(  )to the right of the Group section icon.
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New WindowÑOpens the active section in a separate window.
Mouse Equivalent: double-click the  icon in the Graph section.

Window Menu
TileÑIf you have several windows open, choosing the Tile command will re-

size and arrange all open windows side by side.

CascadeÑIf you have several windows open, choosing the Cascade command 
will resize and layer the open windows so that each title bar will be 
visible.

Arrange IconsÑIf you have several files open but reduced to icons, choosing 
the Arrange Icons command will move all icons to the bottom of the 
SOFTmax PRO window and put them in order.

Beneath the line will appear the names of all open Þles within SOFTmax PRO. 
The active Þle will have a checkmark next to it. Choosing one of the Þle names 
shown here will cause that Þle to come to the forefront of the screen (and will 
restore the Þle to its previous size if it had been minimized).

Help MenuÑWindows
ContentsÑDisplays the contents of the Help screens, allowing you to choose 

from the listed topics. Clicking a topic opens the help screen associat-
ed with it.

IndexÑShows the alphabetical listing of all items that can be viewed within 
the Help function. Clicking a topic opens the help screen associated 
with it.

Using HelpÑAllows you to choose from an indexed list of topics or to search 
for the type of help youÕre looking for.

About SOFTmax PROÑBrings up the About screen (splash screen) which gives 
the serial number, ROM version, and the instrument type connected 
to the computer, as well as the software version for SOFTmax PRO.

Help MenuÑMacintosh
About Help...ÑBrings up a dialog box explaining how to use the Apple Guide 

which gives detailed information about the help function on the Mac-
intosh.

Show/Hide BalloonsÑDepending upon whether or not you have balloon help 
turned on or off, this menu presents the choice to reverse the setting.

SOFTmax PRO Help...ÑOpens the help section devoted to SOFTmax PRO. Items 
are presented in alphabetical order.

Formula Help...ÑOpens the formula help section which provides information 
about how to use formulas, including formula examples.
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Interprocess Messaging

(This feature is available on the Windows Operating System only)

SOFTmax PRO can be controlled by other Windows applications by means of 
an ASCII string-based messaging system. Commands are available for open-
ing and saving Þles, controlling instruments, selecting sections, exporting 
data from Plate, CuvetteSet, and Group sections, and importing Templates. 
The available commands for interprocess messaging are described in 
Appendix A, ÒSOFTmax PRO Remote Command Language,Ó along with 
examples for programming these commands.
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Introduction

Reading a microplate or cuvette using SOFTmax PRO is a three-part process:

¥ Prepare SOFTmax PRO to collect data;

¥ Prepare the microplate(s) and/or cuvette(s) to be read; and

¥ Read the microplate(s) and/or cuvette(s)

Before reading a microplate or cuvette, you must create the Plate section(s) 
and/or CuvetteSet section(s) and deÞne the instrument settings for the read-
ing. Instrument Settings must be deÞned prior to collecting data and may 
NOT be changed after data is collected. In addition, it is recommended that 
you deÞne a template, the reduction parameters, and display parameters 
prior to reading the microplate, as these parameters determine how data is 
displayed and analyzed, but these last parameters may be set up and/or 
modiÞed after data collection.

A typical process for preparing, collecting, and analyzing data is as follows:

1) Start SOFTmax PRO.

2) Create Plate section(s) and/or CuvetteSet section(s) as needed.

3) DeÞne instrument settings (use buttons in the Plate section/CuvetteSet sec-
tion tool bars or the Control menu).

4) DeÞne the template, reduction parameters, and display parameters.

5) Prepare the microplate(s) and/or cuvette(s) to be read and place them in the 
MAXline instrument.

6) Initiate the reading.

7) Save the data Þle.

8) Modify the template, reduction parameters, or display parameters as you 
wish (or, if you didnÕt set them up in Step 4, do so now).

9) Save the data Þle.

10) Analyze the data using the Group section tables and Graph sections.

11) Save the data Þle when you are Þnished.

This chapter discusses how to deÞne instrument settings, create a template, 
and initiate a reading. Data analysis is covered in Chapter 5, ÒDisplaying and 
Analyzing Data.Ó 
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Instrument Settings

Not all instrument settings are available with all instruments. Only 
the settings that pertain to the instrument that is connected to the PC 
or the one chosen in the Preferences will be shown in the Instrument 
Settings dialog box.

You must specify the instrument settings prior to actually reading a micro-
plate or a cuvette. These settings include:

Microplate or Cuvette:
¥ The read modeÑendpoint, kinetic, spectrum, or well scan.

¥ Wavelength(s) used with endpoint and kinetic mode or the wavelength 
range for spectrum mode

¥ Timing for kinetic runs

¥ Speed Read (SPECTRAmax PLUS, PLUS384, 190, and 340PC only)

Microplate Only:
¥ Well scan read mode.

¥ Wavelength(s) used with well scan mode

¥ Cutoff Þlters (SPECTRAmax GEMINI and GEMINI XS only)

¥ PMT sensitivity and number of readings (SPECTRAmax GEMINI and 
GEMINI XS only)

¥ Read type: fluorescence, luminescence, or time-resolved ßuorescence 
(SPECTRAmax GEMINI and GEMINI XS only)

¥ Plate type: number of wells

¥ Automix (all instruments except Emax)

¥ Blanking (pre-read plate)

¥ Pathlength correction (using the SPECTRAmax PLUS, PLUS384, 190, and 
340PC only)

¥ Strips (SPECTRAmax and VERSAmax instruments only)

¥ Autocalibration

Settings for the reading are made in the Instrument Settings dialog box, which 
can be accessed three ways:

1) Choose Instrument Setup... from the Control menu;

2) Click the [Setup] button in the tool bar of the active, expanded Plate or 
Cuvette section; or

3) Double-click anywhere in the settings box (located to the right of the well 
grid) in the active, expanded Plate or Cuvette section.

You may create more than one Plate or Cuvette section in a single 
experiment, and the instrument settings associated with each 
Plate/Cuvette section can be different. Instrument Setup... can only 
be chosen while a Plate/Cuvette section is active, and the settings 

NOTE:

NOTE:
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you choose will affect only that section. A new Plate or Cuvette sec-
tion that is created in an experiment that contains an active Plate or 
Cuvette section will contain the same instrument settings found in 
the previously active section. The settings for the new section can be 
modiÞed as desired.

Table 4.1 lists all possible instrument settings choices based on instrument type. 
When you have deÞned the instrument settings, click the [OK] button to close 
the Instrument Settings dialog box. After closing, a summary of the instrument 
settings will appear in the box to the right of the data display in the 
Plate/Cuvette section. The MAXline instrument will use these settings to read 
the plate or cuvette.

* Using the SPECTRAmax PLUS384 only.
  Emission settings only.
à No Automatic setting.
**Automatic default is no cutoff Þlter.

Incubator control is an instrument setup parameter that is not found 
in the Instrument Settings dialog box.

Table 4.1: Features Available in the Instrument Settings Dialog Box (Organized by Instrument)

Wave-
length

AutoMix
(Before)

AutoMix
(During)

Pre-
Read 
Plate

Timing Strips
Auto-

calibra-
tion

Pathlength
Correction

Speed 
Read

# of
Reads

PMT
Sensi-
tivity

Cutoffs
# of 
Plate
Wells

Emax
Endpoint ◆ ◆ ◆

Vmax/UVmax/THERMOmax
Endpoint ◆ ◆ ◆ ◆

Kinetic ◆ ◆ ◆ ◆ ◆ ◆

SPECTRAmax 340/250
Endpoint ◆ ◆ ◆ ◆ ◆

Kinetic ◆ ◆ ◆ ◆ ◆ ◆ ◆

Spectrum ◆ ◆ ◆ ◆ ◆

SPECTRAmax PLUS, 190, 340PC, and PLUS384

Endpoint ◆ ◆ ◆ ◆ ◆ ◆ ◆*
Kinetic ◆ ◆ ◆ ◆ ◆ ◆ ◆

Spectrum ◆ ◆ ◆ ◆ ◆ ◆

SPECTRAmax GEMINI and GEMINI XS
Endpoint: Fluorescence

Luminescence
Time-Resolved
  Fluorescence

◆
◆*
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆

◆

◆
◆
◆

Kinetic: Fluorescence
Luminescence
Time-Resolved
  Fluorescence

◆
◆*
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆à
◆à
◆à

◆

◆

◆
◆
◆

Spectrum: Fluorescence
Luminescence
Time-Resolved
  Fluorescence

◆
◆ 
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆à
◆à
◆à

◆**

◆**

◆
◆
◆

Well Scan: Fluorescence
Luminescence
Time-Resolved
  Fluorescence

◆
◆ 
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆
◆
◆

◆

◆

◆
◆
◆

VERSAmax
  Endpoint ◆ ◆ ◆ ◆ ◆

  Kinetic ◆ ◆ ◆ ◆ ◆ ◆ ◆

NOTE:
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Figure 4.1: Instrument Settings Dialog Boxes for an Endpoint Reading Using a 
MAXline Instrument

Endpoint Mode

Above: SPECTRAmax 190

Above: SPECTRAmax PLUS

and 340PC only

or PLUS384
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Figure 4.2: Instrument Settings Dialog Boxes for a Kinetic Reading Using a MAXline 
Instrument

Kinetic Mode
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Figure 4.3: Instrument Settings Dialog Boxes for a Spectrum Reading Using a 
MAXline Instrument

Spectrum Mode
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Figure 4.4: Instrument Settings Dialog Boxes for Endpoint Mode Using 
SPECTRAmax GEMINI and GEMINI XS.

Endpoint Mode
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Figure 4.5: Instrument Settings Dialog Boxes for Kinetic Mode Using 
SPECTRAmax GEMINI and GEMINI XS.

Kinetic Mode
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Figure 4.6: Instrument Settings Dialog Boxes for Spectrum Mode Using 
SPECTRAmax GEMINI and GEMINI XS.

Spectrum Mode
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Figure 4.7: Instrument Settings Dialog Boxes for Well Scan Mode Using 
SPECTRAmax GEMINI and GEMINI XS

Well Scan Mode
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Instrument Settings Options: Absorbance Instruments

Read Mode
Choices for the read mode are endpoint, kinetic, spectrum, or well scan (for 
the SPECTRAmax GEMINI and GEMINI XS only). Available read modes 
depend on the type of instrument connected or selected in the Preferences 
(see Table 4.1 on page 4-5 for a complete listing of available read modes by 
instrument). To select a read mode, click the appropriate section in the Instru-
ment Settings dialog box.

Endpoint
A single reading of the microplate taken at a single or multiple wavelength(s). 
Values reported are optical density or %Transmittance (if this has been 
selected in the Reduction dialog box). The default reduced values are !Lm1 
(or !Lm2-!Lm6, depending upon whether or not multiple wavelengths were 
chosen) and !Pathlength (!Pathlength applies to Plate sections in the 
SPECTRAmax PLUS, PLUS384, 190, and 340PC only).

Figure 4.8: Instrument Settings for an Endpoint Reading. You can choose up to 
6 wavelengths with SPECTRAmax or up to 2 wavelengths with VERSAmax instru-
ments; choose 1 or 1-Ref with Emax, Vmax, UVmax, or THERMOmax instruments.

Read Mode
Buttons
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Kinetic
Data is collected over time with multiple readings taken at regular intervals. 
The default reduced values calculated for kinetic data are Vmax (mOD/min), 
Time to Vmax (seconds), Onset Time (seconds), Time at Minimum, Time at 
Maximum, Time at 1/2 Maximum, Slope, and Area Under Curve.

Figure 4.9: Instrument Settings for a Kinetic Reading

TimingÑWhen kinetic mode is chosen, the Timing parameter is active, allow-
ing you to enter the total kinetic run time and the time interval between read-
ings. A default value will be shown for the run time; to change this value, 
click in the box. Up and down arrows will appear, enabling you to increase or 
decrease the value shown. Highlight the hours, minutes, or seconds shown 
and then click the up or down arrow until the desired value is reached. You 
can also select an existing value and enter a new value using the keyboard.

After entering a total run time and an interval between readings, the total 
number of readings that will result is shown below the run time. The mini-
mum read interval is determined by which instrument is connected to the 
computer or, if no instrument is connected, by which instrument has been 
chosen in the Reader section of the Preferences dialog box and the particular 
settings chosen for that instrument. The minimum interval for SPECTRAmax 
and VERSAmax instruments depends on the number of wavelengths, the 
Automix status, the number of strips, and the distance the monochromator 
and Þlter wheel of the instrument must move. The minimum interval for 
Vmax, UVmax, and THERMOmax instruments depends on the number of 
wavelengths and the Automix status. If you set the interval time to be shorter 
than the instrumentÕs minimum read interval, the program will alert you with 
a message. Additionally with SPECTRAmax and VERSAmax instruments, an 
interval that is too short will cause a warning message to appear telling you 
that no calibration can occur between reads.

If you are writing a protocol that will be used with a different instru-
ment (other than the one connected to the computer or chosen in the 
Reader preferences), you can disregard the alert and save the setup. 
However, if you attempt a reading using a protocol which has set-
tings that are not correct for the particular instrument you are using, 

Number of
Readings

Calculated
from Run Time

and Interval

NOTE:
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an error message will instruct you to change any setting that is out of 
range before a reading can be initiated.

To achieve the shortest possible interval for kinetic readings using 
SPECTRAmax and VERSAmax instruments, choose wavelengths in 
ascending order.

Spectrum
(SPECTRAmax instruments only) Measures absorbance (optical density) or 
%Transmittance across a spectrum of wavelengths. The default reduced value 
reported for each well is the wavelength of maximum absorbance when opti-
cal density is displayed or the wavelength of minimum absorbance when 
%Transmittance is shown.

Figure 4.10: Instrument Settings for a Spectrum Reading

All spectrum readings are made using the scanning monochromator of the 
SPECTRAmax.

Well Scan
(SPECTRAmax GEMINI and GEMINI XS instruments only) Measures ßuo-
rescence, luminescence, or time-resolved ßuorescence at many locations in a 
single well of a microplate at one or more wavelengths (up to four). Four 
scanning patterns are available: h(orizontal) line, v(ertical) line, cross, or Þll:

Data is reported by default in grayscale for a single wavelength. Multiple 
wavelengths can be displayed together and are shown in different colors.

NOTE:
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Figure 4.11: Instrument Settings for a Well Scan Reading (Well Scan Editor shown)

After choosing the Well Scan Editor in the Instrument Settings dialog box, 
choose a pattern by clicking one of the four graphic representations shown in 
the Pattern box.

The Density setting controls the maximum number of points that will be 
scanned in each well, the space between those points, and the approximate 
amount of time required to complete the reading. Choices available for the 
Density setting depend on the type of microplate in use and the scan pattern 
you choose. Microplates with wells having larger diameters have greater 
possible Density settings and so greater numbers of possible points and corre-
spondingly longer read times. Table 4.2 shows the differences the Density set-
ting can make when reading microplates of different sizes.

Table 4.2: The Effects of the Density Setting on Microplates Having 
Different Well Sizes

Plate 
Size 

(wells)

Density 
Setting

Point 
Spacing 

(mm)

H-Line or V-Line 
Pattern

Cross Pattern Fill Pattern

Points/ 
Well

Read 
Time 

(h:mm)

Points/ 
Well

Read 
Time 

(h:mm)

Points/ 
Well

Read 
Time 

(h:mm)

384 1 0 1 0:03 1 0:03 1 0:03

96 3 1.13 3 0:03 3 0:03 3 0:03

48
3 1.7 3 0:03 5 0:05 9 0:08

5 1.02 5 0:05 9 0:08 21 0:18

24

3 3.33 3 0:03 5 0:04 9 0:06

5 2 5 0:04 9 0:06 21 0:14

7 1.43 7 0:05 13 0:09 37 0:25

9 1.11 9 0:06 17 0:12 69 0:45

11 0.91 11 0:08 21 0:14 97 1:03
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The default display for well scanning mode is grayscale. For well scans 
using multiple-wavelength pairs, you can choose to view the data from dif-
ferent wavelengths together or separately.

The default reduction for Wavelength Combination is !Lm1; the default 
reduction for the Well Scan is Average. Other reductions include minimum 
value, maximum value, and custom reductions.

You can view data collected in well scanning mode in well graphs, and you 
can import or export well scan data.

12

3 5.4 3 0:02 5 0:03 9 0:05

5 3.24 5 0:03 9 0:05 21 0:11

7 2.31 7 0:04 13 0:07 37 0:19

9 1.8 9 0:05 17 0:09 69 0:35

11 1.47 11 0:06 21 0:11 97 0:49

13 1.25 13 0:07 25 0:13 137 1:08

15 1.08 15 0:08 29 0:15 177 1:28

17 0.95 17 0:09 33 0:17 225 1:52

19 0.85 19 0:10 37 0:19 293 2:26

6

3 9.67 3 0:02 5 0:03 9 0:40

5 5.8 5 0:03 9 0:04 21 0:09

7 4.14 7 0:04 13 0:06 37 0:16

9 3.22 9 0:04 17 0:08 69 0:29

11 2.64 11 0:05 21 0:09 97 0:41

13 2.23 13 0:06 25 0:11 137 0:58

15 1.93 15 0:07 29 0:13 177 1:13

17 1.71 17 0:08 33 0:14 225 1:33

19 1.53 19 0:09 37 0:16 293 2:02

21 1.38 21 0:09 41 0:18 349 2:25

23 1.26 23 0:10 45 0:19 421 2:55

25 1.16 25 0:11 49 0:21 489 3:23

27 1.07 27 0:12 53 0:23 577 4:00

29 1.00 29 0:13 57 0:24 655 4:37

31 0.94 31 0:14 61 0:26 749 5:12

33 0.88 33 0:14 65 0:28 861 5:58

35 0.83 35 0:15 69 0:29 973 6:45

Table 4.2: The Effects of the Density Setting on Microplates Having 
Different Well Sizes

Plate 
Size 

(wells)

Density 
Setting

Point 
Spacing 

(mm)

H-Line or V-Line 
Pattern

Cross Pattern Fill Pattern

Points/ 
Well

Read 
Time 

(h:mm)

Points/ 
Well

Read 
Time 

(h:mm)

Points/ 
Well

Read 
Time 

(h:mm)
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Wavelengths

For Endpoint, Kinetic, or Well Scan Readings

SPECTRAmax Instruments
Choose the number of different wavelengths to be read. At least one wave-
length must always be speciÞed. Selecting more than one wavelength will 
cause a corresponding number of wavelength setting boxes to appear (maxi-
mum six wavelengths).

Figure 4.12: Wavelength Settings for SPECTRAmax Instruments (GEMINI or 
GEMINI XS below right)

The wavelengths speciÞed previously (or the defaults) will be shown in 
the boxes. You can choose a wavelength from the choices using the pull-
down menu or simply highlight the wavelength you would like to replace 
and type a new wavelength (within the available range of the SPECTRA-
max instrument) over the previous one. Note that the pull-down menu shows 
only common monochromator settings.

VERSAmax Instruments
Choose whether to read at one or two wavelengths. At least one wave-
length must always be speciÞed. Selecting two wavelengths will cause two 
wavelength setting boxes to appear.

Figure 4.13: Wavelength Settings for VERSAmax Instruments

The wavelengths speciÞed previously (or the defaults) will be shown in 
the boxes. You can choose a wavelength from the choices in the pull-down 
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menu or simply type any wavelength (within the available range of the 
VERSAmax instrument) over an existing setting. The pull-down menu will 
show only common monochromator settings.

Emax, Vmax, UVmax, THERMOmax Instruments
Choose either single or dual wavelength. The wavelength(s) must be chosen 
from the drop-down list of values. The values shown in this list are Þlter 
values that have been entered into the Þlters list under Preferences in the 
Edit menu (this list must match the actual Þlters installed in the instru-
ment).

Figure 4.14: Wavelength Settings for Emax, Vmax, UVmax, and THERMOmax 
Instruments

Dual wavelength is represented by Lm1-Ref because the subtraction of the 
second wavelength from the Þrst takes place in the Þrmware of these 
instruments, causing a single number to be reported by SOFTmax PRO.

For Spectrum Readings

SPECTRAmax Instruments
When spectrum is selected, the Wavelengths section of the dialog box 
changes to request a wavelength scanning range and a wavelength increment 
(Step) between the start and stop settings (see Figure 4.15).

The minimum selectable increment is 1 nm.

Figure 4.15: Wavelength Selection for a Spectrum Reading (GEMINI or GEMINI XS 
below right)
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Speed Read (SPECTRAmax PLUS, PLUS384, 190, and 340PC only)
Speed Read performs a fast spectral scan of Plate sections or CuvetteSet 
sections. Speed Read does not measure the total amount of light available at 
each wavelength (I0) but uses the values stored in NVRAM of the instrument. 
As a result, Speed Read may not provide as accurate an absorbance measure-
ment of each wavelength in the scan as with the normal mode.

Figure 4.16: Speed Read Section of the Instrument Settings Dialog Box

PathCheck Pathlength Correction (SPECTRAmax PLUS, PLUS384, 190, 
and 340PC only)

The Instrument Settings dialog box for the SPECTRAmax PLUS, PLUS384, 
190, and 340PC includes a section for PathCheck (pathlength correctionÑsee 
Figure 4.17). When enabled, this feature can be used to normalize the data 
acquired from microplate readings to a 1 cm pathlength, thereby correcting 
each OD to the value expected if the sample were read in a 1 cm cuvette, 
achieving signiÞcantly greater precision. Enable or disable pathlength correc-
tion by clicking in the checkbox at the top of this section. When enabled, a 
checkmark will appear in the box.

Figure 4.17: Instrument Settings Showing the PathCheck Option. The Instrument 
Settings dialog box for the SPECTRAmax PLUS or PLUS384 (left) allows a choice be-
tween using a water constant or reading a cuvette reference for PathCheck; the Instru-
ment Settings dialog box for the SPECTRAmax 190 and 340PC (right) allows only a 
choice to enable PathCheck because these instruments use a water constant.

Pathlength correction is used to report OD or percent transmittance for each 
microplate well with the depth of the ßuid in the well normalized to 1 cm. 
Two methods for pathlength correction are available when using the SPEC-
TRAmax PLUS or PLUS384: one involves cuvette measurements (cuvette ref-
erence) and the other involves a pathlength correction constant stored in the 
instrument (water constant). Pathlength correction for the SPECTRAmax 190 
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and 340PC uses the water constant. The actual pathlength, d, of a solvent is 
found from the following equation:

When a cuvette reference is used for pathlength correction, the value of k is 
obtained by taking OD measurements on the ßuid in the cuvette at two wave-
lengths, 1000 and 900 nm:

When using the pathlength correction constant (water constant), the value of 
k is obtained from the instrument. This constant is recorded into nonvolatile 
memory when the instrument is manufactured and may differ slightly from 
instrument to instrument.

Once the actual pathlength, d, in cm is found, the following equation is used 
to perform the pathlength correction:

Pre-Read Blanking vs. Background Constant Subtraction
In previous versions of SOFTmax PRO, selecting PathCheck automatically 
enabled the Pre-Read Plate (blanking) function which is used to subtract 
the absorbance due to the plate material on a well-by-well basis before 
pathlength correction is applied. Now, however, the program default 
enables subtraction of a background constant (default is 0.0) from the absor-
bance values that are read. Often users do not take the time to pre-read 
plates which provides the most accurate method for reducing background 
signal from absorbance readings. Subtracting a background offset provides a 
better result if no pre-read blanking is chosen.

If you choose to pre-read a plate, be sure to disable the background 
constant subtraction (both choices are available in the Instrument 
Settings dialog box).

To pre-read a plate, place water in the wells. Wells pre-read with water 
generally have less absorbance than do dry wells (e.g., at 426 nm, Nunc 
microplates read with and without water in the wells give absorbance val-
ues of approximately 0.037 and 0.049, respectively). Thus, pre-reading a dry 
plate results in pathlength-corrected absorbance values that are lower than 
the cuvette values. If the pre-read step is omitted entirely, the pathlength 
corrected results are overcorrected.

If the plates are sufÞciently transparent at the wavelength(s) of interest 
and have low well-to-well variability, the pre-read doesnÕt have to be 
made on the same plate that will contain samplesÑanother clean plate 
from the same lot will be adequate. More conveniently, a single plate can be 
pre-read and that pre-read data can be stored for subsequent use. SOFTmax 
PRO allows you to copy and paste pre-read plate data from one plate sec-
tion to another, provided the instrument settings are identical in the two 
plate sections. 

d cm( ) Sample OD1000 OD900–( )
k

---------------------------------------------------------------=

k Cuvette OD1000 OD900–( )=

OD1cm

1cm

d cm( )
--------------- ODsample×=

NOTE:
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If the plates are inherently variable at the wavelength(s) of interest, how-
ever, it may be necessary to use the same plate for pre-reading and reading 
samples to ensure that adequate well-by-well correction is achieved.

If you are using a SPECTRAmax PLUS or PLUS384 and PathCheck is 
enabled, you can choose to ÒRead Cuvette ReferenceÓ or to use the ÒWater 
Constant.Ó ÒRead Cuvette ReferenceÓ requires that you place a standard 1 
cm cuvette containing water or aqueous buffer in the cuvette port. The instru-
ment then takes readings of the cuvette at 900 and 1000 nm and uses those 
values for pathlength correction. ÒWater ConstantÓ uses parameters stored 
in non-volatile instrument memory at the factory (based on readings of 
deionized water). The SPECTRAmax 190 and 340PC also use the Òwater con-
stantÓ when performing pathlength correction.

To determine a number for use as a background constant, pre-read an entire 
microplate at the wavelengths of interest. Average these numbers and use 
the average as the background constant.

PathCheck on SPECTRAmax PLUS/ PLUS384: Cuvette Reference or 
Water ConstantÑWhich Should I Use?

The PathCheck measurement is based on the absorbance of water at 1000 
and 900 nm. If the sample is completely aqueous, has no turbidity, has a low 
salt concentration, and has no interfering color or compounds, then using the 
water constant is Þne. The cuvette reference (using the sample buffer or dilu-
ent) must be used if there is any turbidity, more than 10% organic solvent 
(PathCheck should be accurate up to about 10%), high salt concentration, or 
interference in the 900 to 1000 nm range. [To determine possible color or com-
pound interference: measure the OD at 900 and 1000 nm (both measured with 
air reference); subtract the 900 nm value from the 1000 nm value; and then do 
the same for pure water. If the delta OD for the sample differs from the 
delta OD for water, then the cuvette reference must be used.] If the buffer is 
clear but the sample is turbid, the error associated with PathCheck will not 
meet speciÞcation (2.5% for SPECTRAmax PLUS or PLUS384). PathCheck 
should not be used with high levels of turbidity since the light scatter from 
turbidity cannot be subtracted out from the absorbance reading of the sam-
ple.

With the SPECTRAmax PLUS or PLUS384, choosing ÒRead 
Cuvette ReferenceÓ for the PathCheck option is different from a ref-
erence reading of a cuvette in a CuvetteSet section (by clicking the 
[Ref] button in the CuvetteSet section tool bar). The cuvette refer-
ence used for PathCheck calculations (measurements at 900 and 1000 
nm) does not produce data that can be viewed in a CuvetteSet sec-
tion and is used only with data in microplates, not cuvettes.

PathCheck and SPECTRAmax 190 and 340PC
PathCheck on the SPECTRAmax 190 and 340PC instruments uses only the 
water constant. Therefore, samples must be completely aqueous (no sol-
vents), clear, nonturbid, and have no interfering contaminants in the wave-
length range of 900 to 1000 nm (not highly colored in the upper wavelength 
range as in Lowry assays).

PathCheck must be chosen in the Instrument Settings dialog box before read-
ing a plate in order for this feature to be active. After reading, you can choose 
whether or not to apply the correction in the Reduction dialog box for that 

NOTE:
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Plate section; you can also choose to view the data as percent transmittance 
(%T) or absorbance (OD). PathCheck cannot be applied after a reading, nor can 
you change ÒWater ConstantÓ to ÒRead Cuvette ReferenceÓ after a readingÑ
doing so will require that you replace the existing data with that from a new 
reading (of both the cuvette and the microplate). For more detailed informa-
tion regarding the calculations used for pathlength correction, see Chapter 5, 
ÒDisplaying and Analyzing Data.Ó

Automix
The Automix function is a patented feature that allows you to set automated 
shaking of the microplate. The options available for Automix depend on 
the read mode chosen and the type of instrument connected or chosen in the 
Preferences.

SPECTRAmax and VERSAmax Instruments

Figure 4.18: Automix Settings BoxÑSPECTRAmax and VERSAmax Instruments

Before First Read
This setting can be used with any read mode. Click the checkbox next to 
ÒBefore First ReadÓ to shake the microplate before the Þrst reading. 
Whether you read at a single wavelength or at multiple wavelengths, 
enabling Automix for ÒBefore First ReadÓ will shake the plate for the set 
amount of time before the Þrst wavelength reading only. You can accept the 
default value shown for the amount of time to shake the plate or enter a dif-
ferent value (up to 999 seconds) in the box to the right. 

Between Reads
This option is applicable only to kinetic readings and will be displayed only 
when kinetic mode is selected. To enable automatic mixing of the microplate 
between readings during a kinetic assay, click the checkbox next to this set-
ting. For readings at a single wavelength, ÒBetween ReadsÓ will shake the 
plate for the set amount of time prior to each reading at that wavelength. For 
readings at multiple wavelengths, enabling ÒBetween ReadsÓ will shake the 
plate for the set amount of time before each reading at the Þrst wavelength 
only. You can accept the default value shown for the amount of time to shake 
the plate or enter a different value (up to 999 seconds) in the box to the right.

KineticEndpoint
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Vmax, UVmax, and THERMOmax Instruments

Figure 4.19: Automix Settings Box for Vmax, UVmax, and THERMOmax

Automix read intervals for the Vmax, UVmax, and THERMOmax are not 
user-deÞnable. The Emax does not have Automix capability.

Before First Read
This setting can be used with either endpoint or kinetic readings. Click the 
checkbox next to ÒBefore First ReadÓ to shake the microplate before the Þrst 
reading (automatically done for Þve seconds). Whether you read at a single 
wavelength or dual wavelengths, enabling Automix for ÒBefore First ReadÓ 
will shake the plate for Þve seconds before the Þrst wavelength reading only.

Between Reads
This option is applicable only to kinetic readings and will be displayed only 
when kinetic mode is selected. To enable automatic mixing of the microplate 
between readings during a kinetic assay, click the checkbox next to this set-
ting. For readings at a single wavelength, ÒBetween ReadsÓ will shake the 
plate for three seconds prior to each reading at that wavelength. For dual 
wavelength readings, enabling ÒBetween ReadsÓ will shake the plate for three 
seconds before each reading at the Þrst wavelength only.

Read Entire Plate/Strips Selection 
(SPECTRAmax and VERSAmax Instruments Only)

You may choose to read only certain columns (or strips) of wells in the micro-
plate or to read the entire plate. Partial-plate reading is available for all read-
ing modes, although it is most useful for fast kinetics and limited spectrum 
analyses. The time required for kinetic and spectrum readings may be signiÞ-
cantly reduced using this setting since the instrument does not have to read 
the entire plate. 

KineticEndpoint
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To enable a partial-plate read, highlight the desired columns (see Figure 4.20). 
Columns do not need to start with Ò1Ó but must be contiguous.

Figure 4.20: Partial Plate Read (Strips) Dialog Box with Eight Strips Selected

If you enable a partial-plate reading, only the columns to be read will be visi-
ble in the data display, indicating that no data will be collected for the other 
wells (all columns will be present in the Template Editor, however).

Autocalibration
This checkbox allows you to disable or enable automatic calibration for all 
instruments. The default setting is checked (enabled). Turning Autocalibra-
tion off allows the instrument to complete readings more quickly or to begin 
the Þrst reading of a kinetic plate faster. However, you should allow the 
instrument to perform autocalibration of at least one plate prior to disabling 
this function: calibration settings for the last plate which included an autocal-
ibration are maintained in the instrument memory (NVRAM) until another 
autocalibration is performed.

Blanking (Pre-Read Plate)
The blanking selection found in the Instrument Settings dialog box is known 
as pre-read plate blanking, but pre-reading the plate is only one of Þve types of 
blanking available in SOFTmax PRO. Understanding the differences between 
the types of blanking functions will enable you to choose the type of blanking 
that is appropriate for your assay. Note that blanks can be used in combina-
tion and have cumulative effects. Pre-read plate blanking is discussed here; for 
a description of the other types of blanking that are available and how these 
blanks work in combination, see ÒBlankingÓ on page 4-49.

If pre-read plate blanking is chosen, SOFTmax PRO will prompt you to Þrst 
read the blank plate after you click the [Read] button.

Figure 4.21: Blanking Section of the Instrument Settings Dialog Box



Chapter 4: Reading Microplates and Cuvettes

4-26 SOFTmax PRO UserÕs Manual

The pre-read values will be stored in the data Þle and the individual well values 
collected during the pre-reading of the plate will be subtracted from the individual 
well values obtained during the actual reading of samples. This is particularly 
useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be 
seen with and without pre-read blanking subtracted. This option is only 
available within the Reduction dialog box if pre-read blanking was chosen in 
the instrument setup.

The purpose of pre-read plate blanks is to correct for well-to-well variability 
and, in the case of PathCheck, to subtract plate background before applying 
pathlength correction.

A background constant subtraction setting is also available for 
instruments capable of using PathCheck (in the Instrument Settings > 
PathCheck option). If you pre-read a plate, you should not use a 
background constant subtraction and vice versa.

Pre-read blanking is available for all read modes but is most useful for end-
point readings. When used in spectral scan mode (SPECTRAmax instruments 
only), the pre-read scan is subtracted on a point-by-point basis from the nor-
mal scan. If pre-read is selected using kinetics mode (not generally recom-
mended), a pre-read with the same kinetic read interval and duration as the 
ÒnormalÓ reading will be done and the ODs at each time point of the pre-read 
will be subtracted from the OD of the corresponding time point of the Ònor-
malÓ reading.

Molecular Devices recommends that the wells of the pre-read plate 
be Þlled with the appropriate buffer for the assay or with water when 
performing pathlength correction.

NOTE:

NOTE:
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Instrument Settings Options: Fluorescence/Luminescence 
Instruments

Read Mode
Choices for the read mode are endpoint, kinetic, spectrum, or well scan, 
depending upon the type of instrument that you are using. To select a read 
mode, click the appropriate section in the Instrument Settings dialog box.

Endpoint
A single reading of the microplate can be taken at a single or multiple wave-
length(s). Values reported are relative ßuorescence units (RFU) or relative 
luminescence units (RLU). The default reduced value is !Lm1 (or !Lm2-!Lm4 
if multiple wavelengths were chosen).

Figure 4.22: Instrument Settings for an Endpoint Reading. You can choose up to 
four wavelengths.

Read Mode
Buttons
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Kinetic
Data is collected over time with multiple readings taken at regular intervals. 
The default reduced values calculated for kinetic data are Vmax per Sec 
(RFU/Sec or RLU/Sec), Time to Vmax (seconds), Onset Time (seconds), Time 
at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area 
Under Curve.

Figure 4.23: Instrument Settings for a Kinetic Reading.

TimingÑWhen kinetic mode is chosen, the Timing area becomes active, 
allowing you to enter the total kinetic run time and the time interval between 
readings. A default value will be shown for the run time; to change this value, 
click in the box. Up and down arrows will appear, enabling you to increase or 
decrease the value shown. Highlight the hours, minutes, or seconds shown 
and then click the up or down arrow until the desired value is reached. Alter-
natively, you can type over an existing value using the keyboard.

After choosing a total run time and an interval between readings, the total 
number of readings that will result is shown below the run time. If you set the 
interval time to be shorter than the instrumentÕs minimum read interval, the 
program will alert you with a warning message. An interval that is too short 
will cause a warning message to appear telling you that no calibration can 
occur between reads.

The minimum read interval is determined by the instrument that is connected 
to the computer or, if no instrument is connected, by which instrument has 
been chosen in the Reader section of the Preferences dialog box and the par-
ticular settings chosen for that instrument. The minimum interval for SPEC-
TRAmax GEMINI or GEMINI XS, for instance, depends on the number of 
wavelengths, the Automix status, the number of strips, and the distance the 
monochromator and Þlter wheel of the instrument must move.

If you are writing a protocol that will be used with an instrument 
other than the one connected to the computer or chosen in the Reader 
preferences, you can disregard the alert and save the setup. However, 

Number of
Readings

Calculated from
the Run Time

and Interval

NOTE:



Chapter 4: Reading Microplates and Cuvettes

SOFTmax PRO UserÕs Manual 4-29

if you attempt a reading using a protocol which has settings that are 
not correct for the particular instrument you are using, an error mes-
sage will instruct you to change the setting that is out of range before 
you can initiate a reading.

To achieve the shortest possible interval for kinetic readings using 
the SPECTRAmax GEMINI or GEMINI XS, choose wavelengths in 
ascending order.

Spectrum
Measures relative ßuorescence or luminescence units across a spectrum of 
wavelengths. The default reduced value reported for each well is the wave-
length of maximum ßuorescence or luminescence, depending on the read 
type chosen.

Figure 4.24: Instrument Settings for a Spectrum Reading.

All spectrum readings are made using the scanning monochromator of the 
SPECTRAmax GEMINI or GEMINI XS.

NOTE:
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Well Scan
[With the SPECTRAmax GEMINI or GEMINI XS only) One or more readings 
of a single well of a microplate can be taken at a single or multiple wave-
length(s). Values reported are relative ßuorescence units (RFU) or relative 
luminescence units (RLU). The default reduced value is !Lm1 (or !Lm2-!Lm4 
if multiple wavelengths were chosen).

Figure 4.25: Instrument Settings for a Well Scan Reading. You can choose up to 
four wavelengths.

Read Type
Choices for the read type are ßuorescence, luminescence, or time-resolved ßu-
orescence. To select a read type, click the appropriate section in the Instru-
ment Settings dialog box. All read modes are available for all read types.

Fluorescence: The light emitted by certain substances resulting from the 
absorption of incident radiation. To measure ßuorescence accurately, it is nec-
essary to reduce light scatter. The governing equation for ßuorescence is:

Fluorescence = extinction coefÞcient * concentration * quantum yield * excita-
tion intensity * pathlength * emission collection efÞciency

Luminescence: The emission of light by processes that derive energy from 
essentially nonthermal changes, the motion of subatomic particles, or the 
excitation of an atomic system by radiation.

Time-Resolved Fluorescence: Most ßuorescence substances are not suitable 
for this type of reading. However, the ßuorescence emitted by lanthanide 
dyes is delayed long enough to measure ßuorescence after the lamp is turned 
off. Time-resolved ßuorescence is used to reduce the amount of background 
noise which interferes with ßuorescence. The excitation lamp ßashes and, 
after it is off, the delayed emission is collected for a set period of time before 
the lamp is ßashed again.

Two types of scans are possible when either ßuorescence or time-resolved ßu-
orescence read type is chosen: you can select a Þxed wavelength for excitation 

Read Mode
Buttons



Chapter 4: Reading Microplates and Cuvettes

SOFTmax PRO UserÕs Manual 4-31

and scan emission or vice versa. More about this can be found in the follow-
ing section, ÒWavelengths.Ó

Wavelengths
For Endpoint, Kinetic, or Well Scan Readings

Choose the number of different wavelengths to be read. At least one wave-
length must always be speciÞed. Selecting more than one wavelength will 
cause a corresponding number of wavelength setting boxes to appear (maxi-
mum four wavelengths).

Figure 4.26: Wavelength Settings

The wavelengths speciÞed previously (or the defaults) will be shown in the 
boxes. You can choose a wavelength from the choices in the pull-down menu 
or simply type any wavelength (within the available range of the scanning 
monochromator in the SPECTRAmax GEMINI or GEMINI XS) over an exist-
ing setting. The pull-down menu will show common monochromator set-
tings.

For Spectrum Readings

When spectrum is selected, the Wavelengths section of the dialog box changes 
to request a wavelength scanning range and a wavelength increment (Step) 
between the start and stop settings (see Figure 4.27).

Figure 4.27: Wavelength Selection for a Spectrum Reading

The minimum selectable increment is 1 nm.
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For ßuorescence and time-resolved ßuorescence readings, you must also 
choose whether to read excitation at a Þxed wavelength and scan emission 
wavelengths, or vice versa within the range of the instrument (250-850 nm). 
A procedure to optimize excitation and emission wavelengths for a given 
assay is outlined in Chapter 3 of The SPECTRAmax GEMINI and GEMINI XS 
OperatorÕs Manuals.

When luminescence chosen, you must also select a start and end wavelength 
and a step (minimum step increment is 1 nm).

Automix
The Automix function is a patented feature that allows you to set automated 
shaking of the microplate. The options available for Automix depend on the 
read mode chosen and the type of instrument connected or chosen in the 
Preferences.

Figure 4.28: Automix Settings Box

Before First Read
This setting can be used with any read mode. Click the checkbox next to 
ÒBefore First ReadÓ to shake the microplate before the Þrst reading. Whether 
you read at a single wavelength or at multiple wavelengths, enabling Auto-
mix for ÒBefore First ReadÓ will shake the plate for the set amount of time 
before the Þrst wavelength reading only. You can accept the default value shown 
for the amount of time to shake the plate or enter a different value (up to 999 
seconds) in the box to the right. 

Between Reads
This option is applicable only to kinetic readings and will be displayed only 
when kinetic mode is selected. To enable automatic mixing of the microplate 
between readings during a kinetic assay, click the checkbox next to this set-
ting. For readings at a single wavelength, ÒBetween ReadsÓ will shake the 
plate for the set amount of time prior to each reading at that wavelength. For 
readings at multiple wavelengths, enabling ÒBetween ReadsÓ will shake the 
plate for the set amount of time before each reading at the Þrst wavelength 
only. You can accept the default value shown for the amount of time to shake 
the plate or enter a different value (up to 999 seconds) in the box to the right.

Cutoffs
The choices in this setting depend upon the selections for read mode (end-
point, kinetic, spectrum, or well scan) and read type (ßuorescence, lumines-
cence, or time-resolved ßuorescence). The term ÒcutoffÓ refers to Þlters used 
to condition the light entering or exiting the monochromators in order to 
reduce stray light and minimize background interference.
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Figure 4.29: Cutoff Settings Windows (SPECTRAmax GEMINI or GEMINI XS). 
The choices you see depend upon the setting for the read mode.

No emission cutoff Þlter is used when luminescence is selected. With other read 
types, choices are to enable or disable ÒAuto CutoffÓ with speciÞc Þlter settings 
available if it is disabled (manual cutoff selection). When Auto Cutoff is enabled, 
the instrument sets the cutoffs based upon the wavelength(s) chosen for reading; 
when spectrum is selected as the read mode, however, a manual setting for the 
emission monochromator is required, with the default being no cutoff Þlter.

Determining a manual setting for a cutoff Þlter is done based upon the known 
value of the ÒStokes shiftÓ: the difference between the wavelengths of the 
excitation and emission maxima. If the Stokes shift is small, it may be advis-
able to choose an excitation wavelength that is as far as possible from the 
emission maximum while still being capable of exciting the ßuorophore. 
Doing this causes less of the excited light to overlap the emission spectrum, 
allowing better selection and quantitation of the emitted light. See ÒOptimiz-
ing AssaysÓ in Chapter 3 of the SPECTRAmax GEMINI (or GEMINI XS) Dual 
Scanning Microplate Spectroßuorometer OperatorÕs Manual for more information 
regarding cutoff Þlter settings. 

A new cutoff option for the GEMINI XS is available for excitation 
filters only. See the operatorÕs manual for more information.

NOTE:
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Number of Readings
This setting determines the number of readings that will be performed on 
each well of the microplate (readings are averaged and the average reading is 
displayed).

Figure 4.30: Number of Readings Setting (SPECTRAmax GEMINI or GEMINI XS). 
The left shows the default setting for fluorescence; the right shows changing this set-
ting for more precision with a greater number of readings per well.

The default number of readings per well varies with the read type: for ßuores-
cence, the default is 6; for luminescence, the default is 30; for time-resolved ßu-
orescence, the default is 20. The number of readings is variable from 1 to 30. 

PMT Sensitivity
The PMT (photomultiplier tube) is a vacuum tube that detects light, espe-
cially from dim sources, through the use of photoemission and successive 
instances of secondary emission to produce enough electrons to generate a 
useful current.

Figure 4.31: PMT Sensitivity Setting (SPECTRAmax GEMINI or GEMINI XS). 
Clicking in the box causes a menu of choices to appear. Automatic is present only when 
endpoint mode is chosen. Otherwise, settings are manual and limited to High, Medi-
um, or Low.

The voltage of the photomultiplier tube may be set to low (for samples having 
a higher concentration), medium, or high (samples having lower concentra-
tion) in all read modes. In endpoint mode (and also spectrum mode when 
using the SPECTRAmax GEMINI XS), an additional setting, automatic, is 
available. This setting allows the instrument to adjust the PMT voltage auto-
matically for varying concentrations of sample in the plate.

Plate Type
This setting determines the display of wells in the microplateÑit should be 
set to match the type and number of wells in the actual microplate that will be 
read.
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Figure 4.32: Plate Type Setting. Clicking in the box allows you to choose the number 
of wells and type of microplate you will be reading.

Changing the Plate Type within a Plate section causes well assign-
ments stored in the previous template to be discarded. The groups 
created previously remain, however, so you can select new wells and 
simply apply existing groups to these wells.

DeÞning New Plate Types
The Plate Type list includes entries for microplates with standard dimensions 
and additional entries for plates that work best with custom settings. For both 
96- and 384-well plates, the Standard plate should be used unless a custom 
setting is shown for the microplate you are using.

Read Entire Plate/Strips Selection)
You may choose to read only certain columns or strips of wells in the micro-
plate or to read the entire plate. Partial-plate reading is available for all read-
ing modes, although it is most useful for fast kinetics and limited spectrum 
analyses. The time required for kinetic and spectrum readings may be signiÞ-
cantly reduced using this setting since the instrument does not have to read 
the entire plate. 

To conÞgure the settings for a partial-plate read, choose the Strips setting.

Figure 4.33: Partial Plate Read (Strips) Dialog Box with Eight Strips Selected

Highlight the columns to be read. Strips must be contiguous but do not need 
to start with strip Ò1.Ó If you enable a partial-plate reading, only the columns 
to be read will be visible in the data display, indicating that no data will be 

NOTE:
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collected for the other wells (all columns will be present in the Template Edi-
tor, however).

Template Editor

The Template Editor is available for Plate and CuvetteSet sections. In both 
cases, it is used to describe the location of samples, either in the wells of the 
microplate or in a cuvette, providing the link between the raw data and the 
analysis groups. The Template Editor is used to create a template which pro-
vides SOFTmax PRO with a map of what is in the microplates and/or 
cuvettes.

When you Þrst open the Template Editor for a new Plate section or CuvetteSet 
section, the grid or display is empty. (With the SPECTRamax GEMINI, 
GEMINI XS, or SPECTRAmax PLUS384, the number of wells shown depends 
upon the type of plate selected in the Instrument Settings; for all other instru-
ments, the Template Editor for either a Plate or CuvetteSet section show a 96-
well grid.) After selecting wells or cuvettes, you can assign groups, and indi-
cate the type of samples they will contain.

Depending upon the default protocol you are using, certain group names 
(and associated sample descriptions) may have been created. You can use 
these predeÞned groups and/or create new groups to suit your needs. When 
creating new groups, you may enter any name you wish. Once entered, this 
name will be available for use in that experiment thereafter. New groups can 
be created independently from selecting or assigning any wells/cuvettes in 
the Template Editor.

Each well/cuvette designated as being part of a group has associated with it a 
group name, a sample name (or replicate ID), a sample descriptor (optional), 
and a default column format (group type, such as Standards, for example). 
When a group is applied to selected wells or cuvettes, the group name is dis-
played in bold type over the wells/cuvettes and the wells/cuvettes bear the 
same color.
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Figure 4.34: Template Editor Dialog Box

Groups are always visible, both in the Template and in the data display of the 
Plate section or CuvetteSet section. Even though they are grouped, single 
wells or cuvettes are still selectable in either the Template Editor or the data 
display.

Samples and groups may exist across multiple Plate sections or CuvetteSet 
sections as well as within a single Plate section or CuvetteSet section.

Each template is built upon a hierarchy as follows: the template is composed 
of samples and groups. A set of one or more replicate wells makes up a sam-
ple. A set of related samples forms a group. For example, you may have a 
group named Standards that consists of seven samples named STD01, STD02 
... STD07. Group names may be up to 32 characters long, while sample names 
may be 300+ characters long. Samples may be assigned one at a time using 
the [Assign] button or several at the same time using the [Series] button.

If you create a group in the Template Editor but do not assign any wells to the 
group, a section for that group will still be created automatically when you 
close the template. You can remove the group (both its section in the window 
and its group name in the template) by making that Group section active and 
choosing Delete Groupname (where ÒGroupnameÓ is the name assigned to 
that group in the template) from the Edit menu. Using the Macintosh, you can 
also delete the selected Group by pressing z -; within Windows, you can 
press CTRL+-. Note that deleting the wells assigned to a group from the tem-
plate does not delete the corresponding Group name from the drop-down list. The 
only way to remove a group name from this list in the Template Editor is to 
delete the corresponding Group section from the experiment.

Group
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List

Edit Sample Series
ButtonButton

Assign
ButtonDrop-Down List

Sample
Descriptor

Field

Template
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Tool Bar

Clear
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Microplate or
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Selecting Wells or Cuvettes in the Template Editor
In the Template Editor for a Plate section or a CuvetteSet section, you can 
select one or more wells or cuvettes by clicking or dragging on the grid. Mul-
tiple (contiguous) wells or cuvettes can be selected by dragging across them. 
Non-contiguous selections can be made by holding down the Shift key and 
clicking individual wells or cuvettes. Clicking a row label will select the entire 
row; clicking a column label will select the entire column. Contiguous col-
umns or rows (1-12 or A-H, for a 96-well plate, for example) can also be 
selected by dragging. Non-contiguous columns or rows can be selected by 
holding the z (command) key on the Macintosh or the CTRL key in Windows 
and clicking in labels.

¥ Double-clicking anywhere within a group will select the entire group.

¥ To deselect all wells quickly, click in the empty border around the Template.

¥ When you leave the Template Editor (by clicking the [OK] button), the 
Plate/Cuvette section will show the boundaries of the groups created in the 
template. Group labels and sample descriptors will not be visibleÑyou can 
see them by holding down the Ctrl+Shift keys. When you release the key(s), 
the original view of the Plate section or CuvetteSet section will return. 
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The Template Editor Tool Bar
The tool bar will appear differently depending upon what type of group is 
selected in the Group drop-down list. The following illustration shows how 
the tool bar will appear under various circumstances.

Figure 4.35: The Appearance of the Template Editor Tool Bar under Different 
Circumstances

The tool bar is divided into three areas: the Group area, the Sample area, and 
the Assign area.

The Group Area
The Group area contains the Group drop-down list which allows you to 
assign wells to existing groups, create new groups, or modify (using the 
[Edit] button) existing groups. In addition, it contains the [Clear] button 
which allows you to clear well assignments in the template.

Group Drop-Down List

This drop-down list consists of two areas, divided by a horizontal gray line. 
The two items below the gray line (Blank and New) are always available. 
Items above the gray line are custom groups that may be created as you wish.

The Group drop-down list will appear differently depending upon the cus-
tom groups that have been created (by default or by the user). The Þgure 
below shows two different instances of the appearance of the Group list.

When (Plate or Template) Blank is selected.

A group is selected that does not contain sample 

A group is selected for which a concentration has been 

A group is selected for which a dilution factor is defined 

descriptor information (such as Unknowns column type).

defined (such as Standards column type).

(such as UnknownsDilution column type).
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Figure 4.36: The Group Drop-Down List

Depending on the default template used when opening 
SOFTmax PRO, initially no groups may appear above the gray line. 
As you create new groups, they will be positioned above the line.

¥ BlankÑCreates a plate blank in the Plate section or a Template blank in the 
CuvetteSet section. Note: the name ÒblankÓ is reserved for use by the SOFT-
max PRO program and should not be used when creating custom groups.

¥ NewÑCreates a new group. The Group Settings dialog box will appear (see 
Figure 4.37) showing default settings. This dialog box allows you to deÞne 
the name for a group of related samples, what type of descriptor will be 
associated with these samples, and the initial column format for the Group 
section. Whenever a new group is created (whether or not wells are selected 
in the template), a Group section (table) will also be created. To delete a 
group, you must delete the Group section. Simply clearing a group from the 
Template Editor will remove the assignment of wells to that group name, but 
the name will still show in the group pull-down menu and the Group sec-
tion will still exist.

Figure 4.37: Group Settings Dialog Box Using Default Settings

No custom
groups created

Example of custom
groups created by
a user

NOTE:
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Name: Use either the default name, ÒGroup#X,Ó where ÒXÓ is an integer that 
is initially set to Ò1Ó and increments (i.e., Ò1,Ó Ò2,Ó Ò3,Ó etc.) as other groups 
are created, or enter a custom name (up to 32 characters in length).

In the Sample Descriptor area of the Group Settings dialog box, you can 
enable the application of the sample descriptor, if appropriate by clicking the 
checkbox. You may also choose the units used for the sample descriptor by 
selecting an option from the Units drop-down list or by typing the units you 
wish to use into the list box.

The Sample Descriptor is automatically enabled when either the Standards or 
Unknowns(Dilution) column format (see below) is selected. The descriptor 
defaults to Concentration with the Standards column format and to Dilution 
with the Unknowns(Dilution) column format. The Sample Descriptor may 
also be used for time or fraction number information.

No sample descriptor is assigned automatically for the Basic or 
Unknowns column format. You may assign a sample descriptor to 
these column formats manually but, if you choose to do this, the 
information will not appear automatically in the Group section. To 
see it, you will need to create a new column containing the formula 
!Sampledescriptor. For more information about creating columns, see 
ÒAdding ColumnsÓ on page 5-46.

Column Format deÞnes the default column types that will be created for a 
new group or shows the original column format setting that was used to cre-
ate the group you are editing.

Four selections are offered: Basic, Standard, Unknowns, and Unknowns 
(Dilution). Different types of columns will be created for a new group, or 
changed in an existing group, depending on which of these column format 
settings you select. Table 4.3 shows the default columns created with each 
selection type.

If you are creating a new group for unknowns that have a dilution 
factor, use the Unknowns(dilution) column format as a base rather 
than the Unknowns group included in the default protocol.

NOTE:

NOTE:
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.

* !Concentration and !Factor are from SOFTmax PRO version 1.x. !Concentra-
tion, !Factor, and !SampleDescriptor return identical information.

Table 4.3: Columns Created and Their Formulas

Basic Standard Unknown Unknown(Dilution)

Name Sample Sample Sample Sample

Formula !SampleNames !SampleNames !SampleNames !SampleNames

Name Wells Wells Wells Wells

Formula !WellIDs !WellIDs !WellIDs !WellIDs

Name Sample# Concentration Values Values

Formula Index !Concentration* !WellValues !WellValues

Name Values Values R (Outside Standard 
Range)

R (Outside Standard 
Range)

Formula !WellValues !WellValues If(Values)>=ÔMinStd@
StandardsÕ and 
Values<=ÔMax-
Std@StandardsÕ,

ÒÓ,ÒRÓ

If(Values)>=ÔMinStd@
StandardsÕ and Values<=

ÔMaxStd@StandardsÕ,
ÒÓ,ÒRÓ

Name Mean Value MeanValue Result Result

Formula Average(Values) Average(Values) InterpX(STD@Stan-
dardCurve,Values)

InterpX(STD@Standard-
Curve,Values)

Name Std.Dev. MeanResult MeanResult

Formula Stdev(Values) Average(Result) Average(Result)

Name CV% Std.Dev. Std.Dev.

Formula Cv(Values) Stdev(Result) Stdev(Result)

Name CV% CV%

Formula Cv(Result) Cv(Result)

Name Dilution

Formula !Factor*

Name Adj.Result

Formula MeanResult*!Factor



Chapter 4: Reading Microplates and Cuvettes

SOFTmax PRO UserÕs Manual 4-43

The [[[[EEEEddddiiiitttt]]]] Button

When you click the [Edit] button, the Group Settings dialog box will appear, 
reßecting the settings for the active group (currently visible in the group drop-
down list). If you wish to edit a group that is not currently active, Þrst choose 
the group from the drop-down list and then click the [Edit] button. The Þg-
ure below shows the Group Settings dialog box for the active group called 
ÒPatient#1.Ó 

Figure 4.38: Group Settings Dialog Box for the Group Named ÒPatient#1Ó

The name, sample descriptors, and column format can be changed for the 
group that you are editing.

When you edit a group, you will notice that the information shown for the 
Column Format in the Group Settings dialog box changes to show the name 
of the original group used to deÞne the group columns (see Figure 4.39).

Figure 4.39: Groups Settings Dialog Box Showing Original Column Format

Column Format
Setting

Choices are:

Name of Group

Units for Sample Descriptor

Sample Descriptor

When you are editing Group
Settings (rather than creating
a new group), the word 
ÒoriginalÓ precedes the
Column Format.
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Changing the column format setting will cause the columns 
in the group to revert to their original defaults as shown in Table 4.3 on 
page 4-42. If you have added columns or changed column information 
within the existing section for the group you are editing, these changes 
will be removed.

The [[[[CCCClllleeeeaaaarrrr]]]] Button

Allows you to deselect, or clear, wells in the map of the microplate. Highlight 
the wells you wish to clear and then click the [Clear] button.

The [Clear] button functions the same way in both the Template 
Editor for a Plate section and a CuvetteSet section; however, the 
result of clearing wells or cuvettes differs after you close the Template 
Editor and return to the Plate section or CuvetteSet section data dis-
play. In a Plate section, data for cleared wells will no longer be shown 
in the data display. In a CuvetteSet section, however, data for cuvettes 
that have been cleared in the Template Editor will still be shown for 
both reading and reference.

In SOFTmax PRO 1.x, Clear was an option under the Group drop-
down list.

The Sample Area
The Sample area contains the Sample drop-down list and sample descriptor 
values (active if deÞned in the Group Settings dialog box or if assigned auto-
matically by SOFTmax PRO).

Figure 4.40: Modifying Sample Names and Descriptor Values in the Template Editor

When selecting wells or cuvettes to change sample names or 
descriptors, be sure all wells or cuvettes are replicates of the same 
sample and group or that you want them to become replicates of the 
same sample and group. SOFTmax PRO does not prohibit selecting 
individual wells/cuvettes from different samples and/or groups, for 
example, and changing their descriptionsÑand they will change to 
become the same.

Sample Drop-Down List

The sample drop-down list consists of two areas divided by a horizontal gray 
line. Before other sample names have been deÞned, a single, pre-deÞned 
name (ÒBLÓ) appears below the gray line (the sample name ÒBLÓ is the name 
reserved by SOFTmax PRO for group-associated blanks). The item above the 
gray line is the sample ready to be or currently being assigned. After being 
assigned, it will be shown below ÒBLÓ below the gray line.

! CAUTION:

NOTE:

NOTE:

Sample Descriptor

Sample Name or ID

! CAUTION:
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Figure 4.41: The Sample Drop-Down List. When this list first appears, the only selec-
tion shown below the dividing line is ÒBLÓ; the active sample name that is ready to be 
assigned appears above the line.

When samples are assigned to a group, the default name is the Þrst 3 letters of 
the group name followed by a number. For a group called ÒStandard,Ó for 
example, the default sample names would be Sta01, Sta02, Sta03, and so on. 
Sample names can be 300+ characters long; however, only the Þrst Þve or six 
characters will be displayed in the template and in the Plate section.

You can type a sample name directly into the box next to the arrow 
for the drop-down list by highlighting and typing over the existing 
sample name. If one or more wells or cuvettes were highlighted, typ-
ing a different name will replace the sample name shown in the tem-
plate with the name you have typed and, if the name is new, will add 
this name to those that can be chosen in the drop-down list.

When wells or cuvettes have been selected in the template and sample names 
have been deÞned, the sample menu will look like the one below. The check-
mark indicates the sample that is currently being named.

Figure 4.42: Sample Drop-Down ListÑSample Names Defined and Wells Selected

Sample Descriptor Field

The Þeld associated with the sample descriptor only appears in the Template 
Editor tool bar if the group column type that has been selected requires this 
type of information. Generally the information entered in this Þeld is a dilu-
tion or concentration. Position the cursor in this Þeld and enter a number. The 
label and units assigned to the sample descriptor in the Group Settings dialog 
box are shown on either side of the Þeld.

Assign Area
The Assign area contains the [Series] and [Assign] buttons.

Figure 4.43: Assign Area of the Template Editor Tool Bar

Assign Button and Function

Click this button to apply a sample name to one or more wells that have been 
selected in the template. You may also perform this operation by using the 
Enter key on your keyboard.

NOTE:
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Series Button and Function

This button is used to deÞne several samples as a series, allowing you to easily 
enter incremental sample descriptors (for example, dilutions or concentra-
tions) and sample names to the template as long as the increment can be 
expressed as a mathematical operation. 

Replicate Samples and Samples in a Series

You can assign the same group or sample deÞnition (same sample name and 
description within a group) to multiple wells to create replicates. For example, 
you might want to read standards in replicate to ensure that anomalies can be 
excluded prior to generating a standard curve. Replicates can be created 
using the [Assign] button or with the series function.

Creating a series is faster than assigning replicates individually. The series 
option can be used as long as the replicate values conform to a pattern that 
can be described by a mathematical operator (multiply by 2 or add 5, for 
example).

A series is deÞned in one direction (starting from left, right, top, or bottom) 
and therefore samples must be arranged sequentially in either ascending or 
descending order.

To create a series, do the following:

1) In the Template Editor, highlight the wells to be part of the series. The wells 
must be in the shape of a rectangle.

Figure 4.44: Template with Wells Selected for a Series

Group Name
Pull-Down

Menu

Selected Wells

Sample

Units

Series

Box and
Name

Button
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2) Click the [Series] button to open the Series dialog box.

Figure 4.45: Series Dialog Box

3) Specify the name of the first sample in the series in the box (or accept the de-
fault provided by SOFTmax PRO). Subsequent replicates use this name as a 
base and either increment the number within the name or append a number to 
it. In the example above, the sample name provided by SOFTmax PRO de-
scribes the first sample (Ò01Ó) in a group named ÒStandard,Ó here shortened to 
ÒSta.Ó

4) The information shown in the box labeled Sample Descriptor is derived from 
the information entered in the Group Settings dialog box. If the information for 
sample descriptor or units is not correct, you may change it here. If you did not 
already do so, specify the starting value for the first sample in the series. Values 
for subsequent samples are calculated from this starting value.

5) Choose the operator for the series (+, -, *, or /) from the Step by: drop-down 
list. Enter the starting value for the series in the Starting value: box. The incre-
ment is entered in the box to the right of the Step by: box and below the Start-
ing value: box. Figure 4.45 shows a starting value of Ò.5Ó with the operator 
being division (Ò/Ó) and the increment being Ò2.Ó Thus the series will start 
with a value of Ò.5Ó and divide each subsequent sample by 2 to produce the 
following series values: .5, .25, .125, etc.

6) You must assign a fill direction (from the top, bottom, left, or rightÑto de-
scribe how the series will fill the wells) and a number of replicates. Various op-
tions are diagrammed in Figure 4.46 using a 4 ×4 block of wells (for more 
information about replicates, see ÒReplicate Samples and Samples in a SeriesÓ 
on page 4-46). The maximum number of replicates depends on the selection of 
wells: if you are filling down from the top, for example, and you have chosen 
a block of wells that is 4 wells wide by 8 wells high, the maximum number of 
replicates will be four; with the same block of wells selected, filling from the 
left would allow eight replicates. If the number of replicates you choose does 
not divide evenly into the number of rows or columns you select, depending 
on the filling direction, the remaining wells that cannot contain replicates will 
be labeled as additional individual wells in the series. For example, if you fill 
a block of 4 x 4 wells from the top, and choose three replicates, then the first 
three columns will contain the replicates and the last column will contain the 
additional wells in the series (see the last diagram in Figure 4.46). This repli-
cate feature allows you to quickly define the number of replicates and, in cases 
where the series has more samples than a single row or column, to name them 
simultaneously. To create a series with all 96 samples, highlight all the wells in 
the plate, select the fill direction, and set the replicates to 1.
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Figure 4.46: Fill Options and Replicate Settings

7) Click [OK] to save the series and close the dialog box. While still in the Tem-
plate Editor, you can view the value assigned to any well by clicking that well. 
The value will be displayed at the top of the Template Editor. Holding down 
the Ctrl+Shift keys will display the values for all wells.

Sometimes you may wish the names of a series of samples to incre-
ment but may not have a concentration or dilution factor that you 
wish to enter, or you want the concentration or dilution factor to 
remain constant. This can be done using the [Series] button, setting 
the starting value to 1 or another constant value, and either multiply-
ing by 1 or dividing by 1. In this way, the names will increment but 
the value of concentration or dilution will not change. If you donÕt 
have a concentration or dilution factor, simply deselect the sample 
descriptor checkbox if it is selected.

If sample names are set to increment automatically using the Series 
function, be aware that SOFTmax PRO will automatically truncate 
the sample name to three or four characters, including the increment-
ing number if the sample name starts with letters. If the sample name 
is entirely numeric, it will not be truncated. If sample names are very 
long, and they must be kept long for reference, you will have to set 
up your replicates manually and will not be able to use the series 
function.

Fill from Left (two replicates)Fill from Bottom (one replicate)Fill from Top (one replicate)

Fill from Top (three replicates)Fill from Right (four replicates)

NOTE:

NOTE:
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Blanking
In addition to the pre-read plate blanking selection found in the Instrument 
Settings dialog box, four more types of blanking are available in SOFTmax 
PRO. Understanding the differences between the types of blanking functions 
will enable you to choose the type of blanking that is appropriate for your 
assay. Note that blanks can be used in combination and have cumulative 
effects.

The Þve types of blanking that are deÞned in SOFTmax PRO are:

¥ Pre-read plate blank (Plate section)Ñdiscussed earlier on page 4-25

¥ Ref (CuvetteSet section)

¥ Plate blank (Plate section)

¥ Template blank (CuvetteSet section)

¥ Group blank (Plate section and CuvetteSet section)

Ref (CuvetteSet section only)
Performing a reference reading of the cuvette causes the SPECTRAmax PLUS 
or PLUS384 to take a reading of the cuvette in the cuvette port. A single refer-
ence reading can be used with one or more cuvettes in a CuvetteSet section 
(the default applies to all cuvettes in the set) or different reference readings 
can be taken and applied to different cuvettes in the set. This reference read is 
then applied to sample reading. See ÒReference ReadingÓ on page 4-55 for 
more information.

Plate Blanks (Plate section only)
Wells can be assigned to a ÒBlankÓ group in the Template Editor. Unlike pre-
read plate blanks, the average value of all the wells in a plate blank group is sub-
tracted from all individual well values obtained during the reading of micro-
plates. When PathCheck is selected for the SPECTRAmax PLUS, or PLUS384, 
190, or 340PC, the Plate Blank is subtracted after pathlength correction. Plate 
Blank subtraction may be turned off in the Reduction dialog box so that the 
data may be seen with or without plate blank subtraction.

Plate blanks are only subtracted from wells on the same plate to 
which they are assigned. The checkbox for Plate Blank subtraction 
only appears in the Reduction dialog box after data has been col-
lected.

For kinetic and spectrum data, the blank value is averaged and subtracted on 
a point-by-point basis. The example below shows a graphic representation of 
original and average plate blank data, followed by the resulting data with 
average subtracted.

NOTE:
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Figure 4.47: Graphic Representation of Plate Blank Subtraction

Template Blanks (CuvetteSet section only)
Similar in function to the Plate Blank used with Plate sections, Template 
Blanking occurs when cuvettes are assigned to a Blank group in the Template 
Editor of the CuvetteSet section. The average value of all the cuvettes in a tem-
plate blank group will be subtracted from individual cuvette readings. For kinetic 
and spectrum data, the blank value is averaged and subtracted on a point-by-
point basis. Template blanks are subtracted after the reference reading, if any, 
is subtracted.

Template blanks are only subtracted from cuvettes within the same 
CuvetteSet section.

Group-Associated Blanks (Plates and Cuvettes)
Blank wells or cuvettes can be assigned within any group (other than the 
ÒBlankÓ group) in the Template Editor. The average reduced value of the blank 
wells or cuvettes within that group will be subtracted from individual reduced values 
within that group only. This blanking function uses the reduced number (exam-
ple: !Lm1-!Lm2, Vmax, etc.) onlyÑit does not subtract on a point-by-point 
basis. When a group blank has been assigned, it is automatically subtracted. 
To see the reduced number without the group blank subtracted, mask the 
group blank wells or cuvettes.

Group blanks apply to all wells or cuvettes in a group and thus may be sub-
tracted from wells or cuvettes in more than one Plate section or CuvetteSet 
section.

Blanks in Combination
It is possible to use blanking functions in combination. You could perform a 
pre-read plate blanking, assign a blank group in the template, and also 
include blank wells within different groups. The effects of the different blank-
ing functions are cumulative, so it is important to understand the function of 
each before using more than one type of blanking in a single assay. Pre-read 
blanking, plate blanking, Ref, and template blanking are applied to the raw 
data acquired from the instrument, whereas group blanks are applied to the 
reduced number. Group blank subtraction is only visible in the Plate sec-
tion/CuvetteSet section when the reduced number is displayed. Figure 4.48 
shows the last two types of blanks in the Template Editor.

OD

Time

Sample Well Average of Blank Wells Blank-Subtracted

OD OD

TimeTime

Sample Well

NOTE:
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Figure 4.48: Template Editor Showing Plate Blank and Group-Associated 
Blank Wells

In the Þgure above, note that the plate blank in the upper left appears as a 
separate group named ÒBlankÓ and individual samples within this group are 
named ÒBL.Ó The group-associated blank wells, shown in the upper right, are 
not a separate groupÑthe samples, also named ÒBL,Ó are contained within 
the boundaries of the large group called ÒUnknownsÓ and are the same color 
as that group.

In order to save changes you have made to the template in the Win-
dows version of the Template Editor, be sure to click the [OK] button 
to close the window rather than clicking the Control Menu box. Click-
ing the Control Menu box (located in the upper left of the window) 
performs the same function as the [Cancel] button: the window will 
close but any changes you have made to the template will not be 
saved.

Copying and Pasting Templates

Copying Complete Template Information
Two template actionsÑCopy and PasteÑcan only be activated from the Plate 
or CuvetteSet menu (when a Plate section or CuvetteSet section is active) 
rather than from the Template Editor. If you have created a template in a Plate 
section or CuvetteSet section and wish to use it in another Plate section or 
CuvetteSet section, you may copy that template and paste it into the new sec-
tion. The results of copying and pasting a template depend upon whether the 
action is performed within the same experiment or between experiment sec-
tions.

Copying and Pasting within the Same Experiment Section
To copy a template, make the section containing that template active and 
choose Copy Template from either the Plate or CuvetteSet menu (the menu 
name changes to reßect the type of active section). Then activate the destina-
tion Plate section or CuvetteSet section and choose Paste Template from the 
Plate or CuvetteSet menu.

Blank Group

Group-Associated
Blank Wells

(Plate Blank)

NOTE:
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Figure 4.49: Copy Template and Paste Template Commands in the Plate and 
CuvetteSet Menus

The group names and sample names of the pasted template are identical to 
those of the source template. In effect, the destination template is considered 
an extension of the original template and all wells on the destination plate are 
considered replicates of the wells on the source plate (same group and sample 
names). Any changes made to the template on the destination plate will also 
be made on the source plate. Data from the two Plate sections/CuvetteSet sections 
will be analyzed together.

Copying and Pasting between Different Experiment Sections
To copy a template, make the section containing that template active and 
choose Copy Template from either the Plate or CuvetteSet menu (the menu 
name changes to reßect the type of active section). Then activate the destina-
tion Plate section or CuvetteSet section and choose Paste Template from the 
Plate or CuvetteSet menu.

The group names and sample names of the pasted template will be identical 
to those of the source template but, since they are in different experiments, the 
full name will be different (for example: group@experiment#2 instead of 
group@experiment#1). Any changes made to the template of the destination 
Plate section/CuvetteSet section will not affect the source section. Data from 
the two Plate sections/CuvetteSet sections will not be analyzed together.

Copying and Pasting Template Regions
Contiguous regions of templates can be copied and pasted to other regions of 
templates (within the same or to a different experiment). All template settings 
are pasted into the new template except the group name: the new group is 
given the name ÒGroup#XÓ where X is the next greater number than that 
used already for group names.

To copy a region of a template, highlight the region and then select Copy from 
the Edit menu or press zC (Macintosh) or CTRL-C (Windows). Only the high-
lighted wells will be copied.

To paste the region into another area of a template, highlight the region and 
select Paste from the Edit menu or press zV (Macintosh) or CTRL-V (Win-
dows).

Only the highlighted wells will have template information pasted into them. 
Data is pasted using row priority: all wells in a row of highlighted wells have 
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information pasted into them before proceeding to the next row, from left to 
right. If fewer wells are highlighted for pasting than were copied, the data 
will be pasted until all paste-highlighted wells are Þlled. If more wells are 
highlighted for pasting than were highlighted for copying, the extra wells are 
left empty.

SPECTRAmax GEMINI or GEMINI XS only: If you try to paste template infor-
mation between Plate sections having different plate format settings, an error 
will result. Plates must be of the same type to copy and paste template infor-
mation.

Reading a Microplate or a Cuvette

When you read a microplate using any MAXline instrument except the 
SPECTRAmax GEMINI or GEMINI XS, or when you read a cuvette using the 
SPECTRAmax PLUS or PLUS384, the information sent by the instrument to 
SOFTmax PRO is absorbance (optical density) data. The SPECTRAmax 
GEMINI or GEMINI XS sends ßuorescence, luminescence, or time-resolved 
ßuorescence data.

Absorbance Readings
Optical density is deÞned as:

log (I0/I)

where:
I = the light intensity after it passes through the sample,
I0 = initial light intensity (generally light traveling through air).

When reading a microplate, there are two ways in which the MAXline instru-
ment can obtain an I0 value: with the air reference information programmed 
into the NVRAM (non-volatile memory) of the instrument, or through instru-
ment autocalibration (a reading of an air reference prior to reading samples). 
In early versions of SOFTmax and SOFTmax PRO, a selection was available in 
the Instrument Settings dialog box to turn autocalibration on or off. In SOFT-
max PRO version 2.4 and above but prior to version 3.0, autocalibration could 
not be enabled or disabled by the user. Instead, the software made the deter-
mination regarding whether or not to autocalibrate. Version 3.0 again makes 
it possible to choose whether or not autocalibration will occur (via a choice on 
the Instrument Settings dialog box) See page 4-25 for more information.

When reading a cuvette, the SPECTRAmax PLUS or PLUS384 uses the REF 
value (typically a reading on the appropriate buffer) as I0. If no reference 
reading is taken, the instrument uses the air reference information pro-
grammed into the NVRAM of the instrument.
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Fluorescence, Luminescence, or Time-Resolved Fluorescence 
Readings (SPECTRAmax GEMINI and GEMINI XS only)

Fluorescence is deÞned as the measurement of light that is emitted after 
absorption or excitation from radiant activation of a compound.

Luminescence is the measurement of light given off by a chemical or bio-
chemical reaction.

When reading a microplate, the SPECTRAmax GEMINI or GEMINI XS per-
forms autocalibration (if enabled in the Instrument Settings) by reading from 
an internal reference chip in order to determine the appropriate scaling for 
RFU or RLU. 

Reading a Microplate
You can start a reading at any time after deÞning instrument settings. It is not 
necessary to deÞne groups and assign wells within the Template Editor Þrst. 
The values received from the MAXline instrument are raw absorbance, ßuo-
rescence, luminescence, or time-resolved ßuorescence readings and are not 
affected by settings in the Template Editor. Only instrument settings must be 
deÞned prior to reading a microplate. 

To read a microplate, open the drawer of the MAXline instrument (click the 
drawer button in the status bar, or choose Open Drawer from the Control 
menu) and insert the prepared microplate. Then simply click the [Read] but-
ton in the status bar or choose Read from the Command menu.

If you have created more than one Plate or CuvetteSet section, and no Plate or 
CuvetteSet section is active, choosing the Read command will cause a dialog 
box to appear asking you to choose which section to read (see Figure 4.50). 
Select the correct section and then click [OK] to close the dialog box. If a Plate 
or CuvetteSet section is active, choosing the Read command will read that 
plate or cuvette set.

Figure 4.50: Select Section Dialog Box. The screen on the right shows the choices 
available when two Plate sections and one CuvetteSet section have been created in one 
experiment.

A similar dialog box will appear if you have chosen to pre-read the plate for 
blanking. At the bottom of this dialog box, however, are two option (radio) 
buttons, allowing you to proceed with the pre-read plate blank or to override 
this and read the ÒnormalÓ plate. After reading the blank plate, you must start 
the read process again for the normal plate. The same dialog box will appear, 
but the default option button choice will be ÒNormal.Ó
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Figure 4.51: Select Plate Dialog Box for Pre-Read Plate Blanking

If you select a Plate section that already contains data and choose to Read 
again, an alert appears, asking you to conÞrm replacing data in the destina-
tion plate (see Figure 4.52). If you select [Replace], the reading will proceed 
and the previous data will be replaced with new data.

Figure 4.52: Alert Regarding Replacing Data for Plate Section

Reading a Cuvette (SPECTRAmax PLUS and PLUS384 only)
With the SPECTRAmax PLUS series instruments, two types of readings are 
possible using a cuvette: a reference and a sample reading.

Reference Reading
As in a spectrophotometer, taking a reference reading can be done either on 
air or using a cuvette containing the buffer of your sample. The reading taken 
using [Ref] (using the button in the CuvetteSet section tool bar or the Refer-
ence command from the Control menu) will be used as I0 to calculate the 
absorbance of the sample. If no reference reading is taken, the SPECTRAmax 
PLUS or PLUS384 will use the I0 values stored in the NVRAM of the instru-
ment.

A reference reading of the cuvette in the SPECTRAmax PLUS or PLUS384 can 
be made at any time by choosing Reference from the Control menu or from 
the CuvetteSet section status bar. The Reference button is available when the 
active section is a CuvetteSet section. It is not visible when the active section 
is not a CuvetteSet section or if multiple sections are selected.

If no reference has been taken in a CuvetteSet section and you then read a ref-
erence, SOFTmax PRO assumes that this reference will be used with all 
cuvettes in the CuvetteSet section. Therefore, the time and date of the reading 
are displayed under each cuvette in the section (three cuvettes per row and 1 
cuvette per row displays only). The reference will also be applied to any new 
cuvettes created in that section. The reference may be read before or after 
reading samples.

You may have more than one reference per CuvetteSet section. If you have a 
single cuvette to which you want to apply a different reference, highlight that 
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cuvette in the CuvetteSet section, place the second reference in the cuvette 
port, and click [Ref]. The time/date stamp of the reference for that cuvette 
(and only that cuvette in the set) will change.

Any new cuvettes created in the CuvetteSet section after reading a 
second reference will use that new reference reading.

When a reference is read, the system assumes that it will be used with all 
empty samples. Therefore, the date and time of the reference reading are dis-
played with each empty sample (including the destination sample) currently 
in the Cuvette section. If you wish to use a different reference reading with 
one or more cuvettes in a section, click (or shift-click) the cuvette(s) and then 
click the [Ref] button. A dialog will appear, asking if you wish to replace the 
reference reading for the cuvette(s). Choosing [OK] will enable a new refer-
ence reading to be used for those cuvette(s).

The reference read is automatically applied to the normal read. The reference 
value is not displayed in SOFTmax PRO. If you wish to see the reference 
value, you can choose one of the following procedures:

Procedure 1:
1) Create a cuvette in the CuvetteSet section and [Ref] on air (empty cuvette 

port).

2) Read a cuvette containing the blanking solution.

If you wish to have both reference and read values available, do the follow-
ing:

1) Create a cuvette in the CuvetteSet section and [Ref] on air (empty cuvette 
port).

2) DeÞne a template blank in the CuvetteSet section.

3) Place buffer in the cuvette and [Read].

4) [Read] the remaining samples.

The optical density of the cuvette designated as the template blank will be 
subtracted from the optical density of all the other cuvettes in the CuvetteSet 
section.

Procedure 2:
1) Create a cuvette set with as many cuvettes as you wish (up to the maximum 

of 96).

2) Reference and read the cuvette.

3) Create a template with the appropriate groups.

4) Create a column in each Group table with the formula !wellpreread!Lm1.

If you have a multiple-wavelength reading and wish to see the ref-
erence at each wavelength, create additional columns with the for-
mula !wellprereadLx where ÒxÓ is 2, 3, or 4, corresponding to the 
wavelength for which you want to see a reference.

The optical density with the reference subtracted will be displayed in the Val-
ues column. The reference value for each sample will be displayed in the cus-
tom column you have created.

NOTE:

NOTE:
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Reading a Cuvette
You can highlight any cuvette in the CuvetteSet section and choose to read it. 
If you select more than one cuvette, the software looks for the leftmost-
selected cuvette that does not contain sample read data. When one is found, 
the reading begins with that cuvette.

If you select a cuvette that already contains data and choose to Read again, an 
alert appears, asking you to conÞrm replacing data in the destination sample 
(see left side, Figure 4.53). Similarly, if you choose Reference while a sample 
that has already had a reference reading performed is selected, the alert 
shown on the right side of Figure 4.53 appears. A similar alert is shown if you 
choose either read function with more than one cuvette selected (asking if you 
wish to replace the data or reference for all cuvettes).

Figure 4.53: Alert Regarding Replacing Data for Cuvette Section. Note: the alert box 
presented depends on the number of cuvettes in the Cuvette section and whether or not 
one or more are selected at the time you choose to read again.

For kinetic and spectrum modes, the raw data plot is automatically displayed 
as a graph in the cuvette. You can also enlarge the view of selected samples by 
double-clicking, by using the Well Graph button on the CuvetteSet section 
tool bar, or by choosing Graph... from the CuvetteSet menu.

The instrument settings table shown on the right of a CuvetteSet section is 
similar to the one in a Plate section. Automix is not available for cuvettes. 
Instrument settings must be the same for all cuvettes in a CuvetteSet section.

CuvetteSet sections have a limit of 96 cuvettes. Should this limit be reached, 
the New Sample sub-menu of the CuvetteSet menu and the corresponding 
tool bar button will become unavailable (dimmed) and it will be necessary to 
create a new CuvetteSet section.

General Information about a Reading
After beginning a reading, the status bar will show the actions that are occur-
ring in the MAXline instrument, along with a box showing the elapsed time 
for each action in minutes and seconds. The [Read] button will change to 
[Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar at the start of a kinetic reading of a microplate 
using a SPECTRAmax instrument is shown below.

Figure 4.54: Status Bar during a Kinetic Reading (SPECTRAmax)
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Calibration (SPECTRAmax PLUS, PLUS384,190, and 340PC only)
When the instrument is connected to a SPECTRAmax PLUS, PLUS384, 190, or 
340PC (or when one of those instruments is chosen in the Reader prefer-
ences), a Calibration command is available in the Control menu. Choosing 
this command opens the Calibration dialog box. Either a Plate section, a 
Cuvette section, or both can be selected for calibration. The dialog box also 
shows the date of the most recent calibration.

Figure 4.55: Calibration Dialog Box (SPECTRAmax PLUS or PLUS384 and 
190/340PC)

Instrument calibration performs an air reading at all available wavelengths 
and stores those values in the non-volatile instrument memory (NVRAM). 
For plate readings, these air calibration values are used whenever a spectrum 
reading is performed using the Speed Read option, thus reducing the time it 
takes to complete a spectrum reading. For cuvette readings, the air calibration 
values are used whenever a reference reading has not been taken or when the 
cuvette is read using the control panel of either the SPECTRAmax PLUS or 
SPECTRAmax PLUS384.

Molecular Devices recommends that you update the air reference 
information that is stored in NVRAM periodically. This is particularly 
important if you are using Speed Read, reading cuvettes without a 
reference, or running kinetics in microplates with read intervals that 
are too short to allow autocalibration.

Column vs. Wavelength Priority During a Reading
Depending upon the type of instrument connected to the computer or chosen 
in the Reader Preferences, a priority is given to reading by ÒcolumnÓ or 
Òwavelength.Ó It is most important to understand this priority with multi-
wavelength readings.

SPECTRAmax
PLUS / PLUS384

SPECTRAmax
190 and 340PC

NOTE:
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In column priority, an instrument will read the entire microplate (or chosen 
number of strips) at the Þrst wavelength, and will then go back and read the 
microplate at the second and subsequent wavelengths.

In wavelength priority, the instrument will read all wavelengths for the Þrst 
column of wells in the microplate, and will then read all wavelengths for the 
second column, etc.

The table below shows the priority settings by MAXline instrument for the 
different read modes.

Data Display During a Reading
The values read by the MAXline instrument will appear in the data display of 
the Plate section or CuvetteSet section as they are received from the instru-
ment (in real time). Depending upon the read mode (endpoint, kinetic, spec-
trum, or well scan), the number of wavelengths, the plate type, and the 
display options selected, the data display will show one or more numbers or 
plots.

You can enlarge the display of one or more wells while the a kinetic or spec-
trum reading is in progress. Double-click a single well to enlarge its display to 
a Well Graph or hold the Shift key while selecting more than one well, and 
then choose Graph... from the Plate menu or click the graph button on the tool 
bar to display the data from multiple wells in one enlarged Well Graph. The 
data in the enlarged Well Graph will update to show new data points as they 
are received from the MAXline instrument.

Other choices and settings within SOFTmax PRO affect the way in which data 
is displayedÑthe type of reduction, speciÞc time settings, and so on. These 
settings are discussed in Chapter 5, ÒDisplaying and Analyzing Data.Ó

Table 4.4: Column vs. Wavelength Priority

Endpoint Kinetic Spectrum

SPECTRAmax GEMINI, 
SPECTRAmax GEMINI XS

Column Wavelength Column

SPECTRAmax PLUS, 
SPECTRAmax PLUS384

User choice1

1 You can choose between wavelength and column (default) priority 
readings in the Instrument Settings dialog box.

Wavelength Column

SPECTRAmax 190,
SPECTRAmax 340PC

Column Wavelength Column

SPECTRAmax 250,
SPECTRAmax 340

Column Column Column

VERSAmax, THERMOmax,
UVmax, Vmax

Column Column

Emax Column
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Introduction

Initial display and reduction of the data received from the MAXline instru-
ment is performed in the Plate section or CuvetteSet section in which the data 
has been collected. Display and reduction parameters can be set up either 
prior to collecting data (recommended) or after data has been collected. The 
display and reduction parameters may be modiÞed at any time.

Data analysis and the display of analyzed data is also performed in the Group 
sections (created when wells/cuvettes are assigned to groups in the Template 
Editor) and the Graph section(s).

Notes sections may be used in conjunction with any other section to provide 
text commentary and/or a summation of data through the use of summaries. 
Notes sections are used most commonly to provide an introduction to or sum-
mary of results for a data Þle.

All data files have a minimum of one Plate section or one CuvetteSet section 
with data in it. Multiple Plate sections and/or CuvetteSet sections may be 
present. Most Þles will have a template and Group, Graph, and Notes sec-
tions. However, depending upon the assay and how you wish to report the 
data, only some of these sections may be (or need to be) present in every Þle. 
Some simple assays, such as reading the absorbance of proteins at 280 nm in a 
cuvette (or in a microplate with PathCheck), allow you to calculate concentra-
tion in the Plate or CuvetteSet sections. In such an example, Group and Graph 
sections are necessary only if you wish to display the data graphically.

Many common assays consist of data acquired in a Plate section or CuvetteSet 
section. Standards and unknowns are deÞned in a template. Unknowns are 
then interpolated from a standard curve. The following diagram shows the 
relationship between the different sections in SOFTmax PRO:

Figure 5.1: Relationship of Sections

This chapter discusses the initial display and reduction of data in the Plate 
section Þrst, followed by display and data analysis in the Group, Graph, and 
Notes sections.

Plate or Cuvette
with Template

Initial Data from
Microplate

Reader

Standard
Group Table

Reduced Number
from Plate/Cuvette

Reported Here

Unknowns
Group Table

Reduced Number
from Plate/Cuvette

Reported Here

Interpolated Values
(Results)

Reported from
Graph Section

Graph Section

Plots Created with
Information from

Standards
Group Table
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Initial Data Display and Reduction: Plate/CuvetteSet Section

The manner in which data is displayed in a Plate section or CuvetteSet sec-
tion depends on the type of reading that was performed (endpoint, kinetic, 
spectrum, or well scan), but can be customized by choices made in the data 
display and reduction settings. Depending on the type of reading performed, 
display options include:

¥ Number or plot displays for raw OD or %T (with or without reduced num-
ber) for most instruments; the SPECTRAmax GEMINI or GEMINI XS offers 
number or plot displays for RFU (relative ßuorescence units) or RLU (rela-
tive luminescence units), depending on which was chosen as a read type, 
with or without reduced number, and additionally the option to view raw 
data in 1000Õs (e.g., Ò20,000Ó would be shown as Ò20Ó to make numbers in 
wells more easily visible).

The number format (use of commas or periods in numeric notation) 
chosen for the computer operating system in general is reßected in 
the way that SOFTmax PRO displays data.

¥ Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced 
number)

¥ Display as one or three samples per row or display as microplate layout 
(CuvetteSet section only)

¥ (SPECTRAmax GEMINI or GEMINI XS only): If you have chosen 384-well 
plates from the Instrument Settings, you can display the wells in different 
ways: Normal, Vertical, Rotated, Large, or Interleaved.

Default displays are shown automatically unless you choose a different dis-
play option.

Reduction options allow you to display the raw data received from the MAX-
line instrument in a reduced (analyzed) form. Which reduction options are 
available depend on the read mode, instrument, and read type used; custom 
settings, using formulas you create, are available for all read modes, instru-
ments, and read types.

Reduction settings do not affect the raw data but simply cause it to be dis-
played differently, allowing you to change reduction settings without affect-
ing the raw data from the plate or cuvette reading in any way.

Custom reduction formulas require the use of accessors and operators that 
are understood by SOFTmax PRO. A list of such accessors and operators can 
be found at the end of this chapter.

NOTE:
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The Data Display

After a plate or cuvette has been read, the information sent from the MAXline 
instrument is shown in the data display in the active Plate or Cuvette section. 
The default display for data from endpoint readings for most MAXline instru-
ments is raw OD numeric values; for the SPECTRAmax GEMINI or GEMINI 
XS, the default display for data from endpoint readings is raw RFU/RLU 
numeric values. Data from kinetic or spectrum readings is displayed in plots 
format (for most instruments, raw OD values with respect to time or wave-
length; for the SPECTRAmax GEMINI or GEMINI XS, raw RFU/RLU val-
ues with respect to time or wavelength). While a kinetic or spectrum 
reading is in progress, the display updates dynamically to show the data 
collected so far. If the instrument is reading more than one wavelength in 
kinetic mode, plots for the different wavelengths are overlaid in each well.

All choices except those deÞned in the Instrument Settings affect only the 
manner in which the data is displayedÑthe raw data is not changedÑpermit-
ting you to optimize the display after data is collected.

Data reduction changes the way in which data is displayed and also 
affects the values used in calculations within SOFTmax PRO. While 
the raw values remain unchanged, calculations will use reduced val-
ues, if any, and are, therefore, affected by settings chosen in the 
Reduction dialog box. For more information, see ÒData ReductionÓ 
on page 5-24.

With the SPECTRAmax PLUS, PLUS384, 190, 340PC, and the VER-
SAmax, data comes from the instrument to SOFTmax PRO with four 
digits to the right of the decimal point (instead of three digits for 
all other instruments). Only three of the four digits are displayed 
in the Plate section or CuvetteSet section for endpoint data, how-
ever: the fourth digit is rounded up or down (0.0045 rounds up to 
0.005; 0.0044 rounds down to 0.004, for example). You can view all 
four digits of data, if desired, by displaying the raw OD in a Group 
section table and increasing the number of decimal places showing.

NOTE:

NOTE:
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The Display Dialog Box
Before or after a plate or cuvette has been read, you can click the [Display] 
button to open the Display dialog box which allows you to change the way 
the data is presented. Choices available in this dialog box depend on whether 
a Plate section or CuvetteSet section is currently active, which instrument is 
chosen in the Preferences or is connected to the computer, and which read 
mode you have chosen (for example, the choice for ÒPlotsÓ is not shown if 
endpoint mode is selected). Figure 5.2 shows the default Display dialog boxes 
for the different read modes for Plate sections; Figure 5.3 shows the default 
Display dialog boxes for the three possible read modes for CuvetteSet sec-
tions.

The Display dialog box is divided into two parts (left and right): the default 
display, ÒRaw OD,Ó (or ÒRaw RFUÓ or ÒRaw RLUÓ) is shown to the left of a 
dividing line; the choices for reduced data displays are shown to the right of 
the dividing line. Note: data reduction itself is performed separately; settings 
here simply determine how the reduced data will be displayed in the Plate or 
CuvetteSet section.

An additional set of choices in the CuvetteSet section Display dialog box 
determines how an array of cuvettes will be displayed in the CuvetteSet sec-
tion: one cuvette per row, three cuvettes per row, or in a microplate layout.

The dialog boxes below show the default display choices for the three modes: 
raw optical density values (numbers) for endpoint; the change in raw OD val-
ues over time for kinetic; and raw OD (or RFU/RLU) values for the range of 
wavelengths, displayed as a plot, for spectrum. Other choices available in this 
dialog box include displaying the data as a single reduced value (number), in 
threshold, ranged, or gray scale formats, or any combination of display 
choices with the reduced number (the reduced number display choice cannot 
be used with the reduced number checkbox).
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Figure 5.2: Plate Section: Endpoint, Kinetic, Spectrum, and Well Scan Display Dialog Boxes. The left side shows 
the displays for all instruments except the SPECTRAmax GEMINI or GEMINI XS (shown on the right side). 
Note: Well Scan mode is used with SPECTRAmax GEMINI or GEMINI XS only.
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Figure 5.3CuvetteSet Section: Endpoint, Kinetic, and Spectrum Display Dialog Boxes
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Data in the Plate section is displayed in a grid array (microplate format). With 
all plates other than 384-well plates, the display is always shown as a stan-
dard microplate, with well A1 in the top left corner. If you are reading 384-
well plates using the SPECTRAmax GEMINI, GEMINI XS, or SPECTRAmax 
PLUS384, additional display options can be chosen (see Figure 5.4) to make 
the display of data more clear:

¥ Normal: shows the data in standard left-to-right format, with well A1 in the 
upper left corner. Columns 1 through 24 are along the top and rows A 
through P are shown from top to bottom. The wells are smaller and data is 
shown with fewer digits (les precision).

¥ Vertical: the plate is shown in the same orientation as Normal except that 
columns 1 through 12 (all rows) are shown above columns 13 through 24 
(all rows).

¥ Rotated: Same as the Normal view except that it is rotated 90 degrees clock-
wise (well A1 is in the upper right corner).

¥ Large: Same as the Normal view except larger. This display can be seen in 
its entirety only if you have the page size set for legal paper (8.5 x 14 inches) 
in landscape orientation (set this in Page Setup or Preferences under the File 
menu). In the example in Figure 5.4, the display is shown as it appears if 
you do not change the page size from letter-size to legal.

¥ Interleaved: In this display, the wells are shown in a format that ÒskipsÓ 
every other well as follows: all odd columns and rows begin in the upper 
left corner of the plate display and are followed by all even columns and 
rows. So well A1 is still in the upper left corner, but it is followed horizon-
tally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, 
B1, D1, etc. This display is most useful when the 384-well plate is composed 
of 4 daughter plates of 96 wells each.
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Figure 5.4: Plate Section for the SPECTRAmax GEMINI or GEMINI XS. Choices for 
a 384-well plate display are shown: Normal, Vertical, Rotated, Large, and Interleaved.
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The CuvetteSet section offers three display choices:

¥ 1 cuvette per row

¥ 3 cuvettes per row (default)

¥ Microplate format (8 × 12 array)

Figure 5.5: CuvetteSet Display Options. From top to bottom: one cuvette per row, 
three cuvettes per row, and microplate format.

The height of the cuvettes in the 1- and 3-cuvette per row displays may be 
changed by highlighting any cuvette in the CuvetteSet section, placing the 
mouse on the bottom of the cuvette (the pointer will turn into a cross-hair cur-
sor with vertical arrows), and dragging down.

Resizing in this way will affect the display of all cuvettes in the 
CuvetteSet section.

NOTE:
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Figure 5.6: Resizing Cuvettes in the CuvetteSet Section. A: Cuvette at original size. 
B: When the mouse pointer is positioned over bottom line of cuvette display, it changes 
to show a crosshair cursor with vertical arrows. C: Dragging the cursor down shows 
the bounding box, displaying where the boundary for the cuvette will be when the 
mouse is released (D).

Resizing a cuvette display is different from enlarging the cuvette to a graph 
(by double-clicking the cuvette or clicking the Graph button  or choosing 
Graph... from the CuvetteSet menu), which shows an enlarged display of 
either kinetic or spectrum data in a separate window. Resizing the cuvette in 
the CuvetteSet section provides an enlarged view of the data in the same win-
dow (note also that the resizing is saved with the Þle so the modiÞcation to 
the size will be retained when you reopen the Þle at a later time).

Figures 5.7 (Plate section) and 5.8 (CuvetteSet section) show the default dis-
plays for endpoint, kinetic, and spectrum modes. The default display for end-
point mode is the raw optical density or ßuorescence/luminescence collected 
from the microplate reader. For kinetic and spectrum modes, the default dis-
play is raw OD/RFU/RLU shown in plot format: OD/RFU/RLU vs. time for 
kinetics and OD/RFU/RLU vs. wavelength for spectral scans. Data for most 
instruments may also be viewed as %T (%Transmittance) instead of OD (opti-
cal density) by choosing %T in the Reduction dialog box.

A

B

C

D
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Figure 5.7: Default Displays for a Plate Section (Absorbance & Fluorescence)
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Figure 5.8: Default Displays for a CuvetteSet Section (Endpoint, Kinetic, and 
Spectrum Modes)

Reduced Number
The reduced number is based on the settings deÞned in the Reduction dialog 
box. It is a combination of blank subtraction (pre-read and/or plate blank in 
the Plate section and ref and/or template blank in the Cuvette section), wave-
length reduction, and spectral scan or kinetic reduction. The information 
acquired from the microplate reader is reduced to a single number or value. 
The reduced number will be reported in the Group section when a template 
has been deÞned.

To view by reduced number alone, select the Number option (the Þrst choice 
to the right of the default, just after the dividing line); to see a reduced num-
ber as well as another type of display, click the box next to the option that says 
ÒWith reduced numberÓ in the lower left of the dialog box to enable it. Chang-
ing the reduction parameters after choosing a reduced data display mode will 
cause the display to update accordingly. More information about reduction 
formulas and how to customize them follows later in this chapter. 
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Threshold, Ranged, and Gray Scale
To display Threshold, Ranged, or Gray Scale data, high and low values must 
be entered. When you choose one of these display options, SOFTmax PRO 
provides default values for the high and low limits by means of an autorang-
ing function (encompassing all the data from lowest to highest value). You 
can change the high and low limits by highlighting the existing value and 
entering a new value. An example of the Display dialog box for a kinetic read-
ing (Plate section) with the Threshold display option chosen is shown in Fig-
ure 5.9.

Figure 5.9: Display Dialog Box for Kinetic Threshold Display

Threshold
The Threshold display shows the raw data as a plus (+) for values above the 
high limit, an asterisk (*) for values within the limits, and a minus (-) for val-
ues below the low limit. Figure 5.10 shows an endpoint reading displayed 
using the Threshold option along with the reduced number. 

Low/High
Limit Boxes
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Figure 5.10: Endpoint Data Displayed as Threshold with Reduced Number

Ranged
When the Ranged display is chosen, raw data that falls between the high and 
low limits is assigned proportionally to integer values from 0 through 9. Val-
ues above the high limit are displayed as a plus (+) and values below the low 
limit are displayed as a minus (-). Figure 5.11 shows reduced kinetic data dis-
played in Ranged format. 

Figure 5.11: Kinetic Data (Reduced) Displayed as Ranged
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Gray Scale
The Gray Scale option presents the raw data in eight shades of gray, changing 
from light (for values less than or equal to the low limit) to dark (for values 
greater than or equal to the high limit). Figure 5.12 shows reduced endpoint 
data displayed as Gray Scale.

Figure 5.12: Endpoint Data (Reduced) Displayed as Gray Scale
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Graphing Wells

You can enlarge the display of the wells shown with kinetic, spectrum, or 
well scan modes to get a close-up view of the data. This is done by either 
double-clicking the particular well or cuvette in the data display or by select-
ing the well or cuvette and then clicking the Well Graph button in the Plate 
section or CuvetteSet section tool bar.

Kinetic and Spectrum Well Graphs
Well Graphs plot the data for the individual wells in a microplate or for indi-
vidual cuvettes and show the well ID and reduction information, including 
the goodness of Þt (R^2 value), if appropriate. The default display for the 
X-axis shows time for kinetic plots and wavelength for spectrum plots; OD or 
%T is displayed on the Y-axisfor both plots.

Positioning the cursor within a Well Graph shows X and Y values for the cur-
sor location, allowing you to determine more precisely the location of data 
points.

Well Scan Well Graphs
Well Graphs in well scan mode default to displaying raw data in a grayscale 
plot. The manner in which the data is displayed in a Well Graph for a well 
scan depends on the reduction options that have been chosen, the display 
options (raw or reduced, for example), the number of points read, and 
whether the Well Graph is scaled to the data or to the limits of the entire plate.

Well Graph Options
Along the bottom of each Well Graph dialog box are eight buttons (Þve when 
using well scan mode) which perform the following functions:

¥ [Print]
Opens the Print dialog box.

¥ [Reduction]
Opens the Reduction dialog box.
By default, the ranges on the enlarged plot are set to the limits deÞned in 
the Reduction dialog box, and the information included near the bottom of 
the window is based on the reduction settings currently in use. You may 
change these settings (wavelength combination and type of reduction used, 
minimum and maximum OD limits, lag time and end time, and number of 
Vmax Points; for a cuvette, whether or not to use a template blank, absolute 
values, or to show the data as absorbance or percent transmittance). More 
information about the reduction options can be found later in this chapter.

Changes to the reduction settings made within well graphs will be 
applied to all wells or cuvettes in the Plate or CuvetteSet section. 
When viewing Raw data, you can scale the graph to see data outside 
the reduction limits [line(s) are included on the graph indicating the 
limits and the area outside of them will be shaded slightly]. This view 
should assist you in determining the best limits for the reduced data.

NOTE:
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¥  Show Raw/Show Reduced button

This button toggles the Well Graph between views of raw and reduced 
data. When the Well Graph is opened, the initial view depends on the Dis-
play settings for the Plate section. If raw data is being displayed in the Plate, 
the initial view in the Well Graph will be raw data and the button will be set 
to ÒShow Reduced.Ó If reduced data is being displayed in the Plate section, 
the initial view in the Well Graph will be reduced data and the button will 
be set to ÒShow Raw.Ó

¥  Scale to Data/Scale to Limits button

This button toggles between a view of the data within the reduction limits 
and a view of the entire data set. Switching between these views helps to 
visualize how the limit settings affect data reduction. If raw data is being 
viewed in the Plate section, the display in the Well Graph is set initially to 
show the plot scaled to the reduction limits. If reduced data is being viewed 
in the Plate section, the Well Graph display is set initially to show the plot 
scaled to the data.

If you are viewing raw data and click the Scale to Limits or Scale to 
Data button, only the display of raw data in the Well Graph will be 
affected (the button will not affect the view of reduced data). The 
same is true if you click this button while viewing reduced data. To 
produce comparable scaling of both raw and reduced displays, this 
button must be set to either Scale to Limits or Scale to Data for both 
raw and reduced views of the Well Graph.

¥  Graph Options button (not found in well scan mode)
Opens the Well Graph Options dialog box which allows you enable or dis-
able connected points or plotted symbols the graph.

Figure 5.13: Graph Options Dialog

¥  X-Axis Settings button (not found in well scan mode)

¥  Y-Axis Settings button (not found in well scan mode)

Opens the Well Graph Axis Settings dialog box for the particular axis, 
allowing you to set Auto Range parameters, choose the minimum and max-
imum values for the selected axis, cause the axis to be auto-ranged, add or 
remove gridlines, and add or remove axis tick marks. When a Well Graph is 
opened, the default settings are to show the reduction limits for that axis 

NOTE:
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with Auto Ranging off and gridlines and tick marks selected. Only the Well 
Graph being viewed is affected by changes in these dialog boxes.

¥ [Done]
Closes the Well Graph dialog box.

Figure 5.14: Well Graph for a Single Kinetic Microplate Well (Raw Data)

Figure 5.15: Well Graph for a Single Kinetic Cuvette (Reduced Data)

Multiple wells from the same Plate section or cuvettes from the same Cuvette-
Set section can be graphed together in one enlarged window. Select the 
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well(s) or cuvette(s) in the data display (hold the Shift key if you are selecting 
non-contiguous wells or cuvettes; you can drag across contiguous wells) and 
then click the Graph button or double-click in one of the selected wells or 
cuvettes.

Figure 5.16: Well Graph for Three Kinetic Wells of a Microplate (Raw Data)

The choices you make for viewing the data in the Plate or Cuvette section also 
affect the way the Well Graph appears. Figures 5.14 and 5.16 show Well 
Graphs for raw data displays. If you display one of the reduced options 
(reduced number, Threshold, Ranged, or Gray Scale), the Well Graph will 
show the plot with an indicator of the reduced value and will include the 
word ÒReducedÓ in the window title (see Figure 5.15 which shows the Well 
Graph for a single kinetic cuvette viewed in a reduced plots format).

Zoom Box
You can enlarge the Well Graph even further by clicking the zoom box in the 
upper right-hand corner of the window (the center box of three in the upper 
right corner in Windows). Clicking the zoom box once will cause the window 
to Þll the total display on your monitor; clicking the zoom box again will 
return the window to its previous size.

Size Box
Clicking and dragging the size box located in the lower-right corner 
(Macintosh) or clicking and dragging the lower right corner of the window 
(Windows) allows you to make the Well Graph any size desired.

Printing the Well Graph
You can print the Well Graph window, if desired, by clicking the [Print] 
button at the bottom left corner of the dialog box.
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If you enlarge the Well Graph to greater than 12 inches, Molecular 
Devices does not recommend printing it since the graph will not Þt 
on an 8.5- by 11-inch page and the printout will be truncated.

Masking Wells or Cuvettes   
If you Þnd data in certain wells or cuvettes (outliers) that should be excluded 
from the calculations to be performed by data reduction, you can mask these 
wells or cuvettes. Select the well(s) or cuvette(s) to be masked and then click 
the Mask button in the Plate section or CuvetteSet section tool bar or choose 
Mask... from the Plate or CuvetteSet menu. Masked wells/cuvettes are 
shown with an overlay of diagonal lines.

The masking function can be used as a Òwhat if?Ó tool. For example, you 
could suppress or enable certain functional groups within the experiment. 
Suppose you have included a group blank in the template and want to see the 
data with and without the blank. Masking the group blank wells would sup-
press the blanking function; unmasking them would enable it again.

Figure 5.17: Masked Wells in a Plate Section and a CuvetteSet Section

To remove masking from one or more wells, highlight the masked well(s) and 
click the Mask button in the Plate section tool bar (toggles masking on and 

NOTE:

Masked
Wells

Masked
Cuvette
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off) or choose Mask... from the Plate or CuvetteSet menu again. The diagonal 
lines covering those wells (and masking function) will be removed.
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Data Reduction

Raw data received from the MAXline instrument can be displayed in an ana-
lyzed (or reduced) form. The reduction process within SOFTmax PRO is 
based on formulas that reduce the raw data to show a single number for each 
well or cuvette. Further analysis of this reduced number then takes place in 
the Group and Graph sections.

SOFTmax PRO performs calculations hierarchically when reducing the opti-
cal density information collected from the instrument. Calculations in the 
Plate section or CuvetteSet section are performed in the order shown below. If 
an option has either not been selected in the Instrument Settings dialog box, is 
not available for the instrument you are using, or has not been deÞned in the 
template and/or Reduction dialog box, SOFTmax PRO starts/continues with 
the next listed calculation.

Plate Section
With the SPECTRAmax GEMINI or GEMINI XS, start with step 

number 4 below (steps 1 through 3 do not apply to this instrument).
1) Convert OD to %T (and vice versa)

2) Pre-read plate blank or plate background constant subtraction (or division for 
%T)

3) PathCheck pathlength correction (different equations for OD and %T)Ñ
available with SPECTRAmax PLUS, PLUS384, 190, and 340PC only

4) Plate blank subtraction

5) Wavelength reduction

6) Kinetic or spectrum reduction

7) Group blank subtraction

CuvetteSet Section
1) Convert OD to %T (and vice versa)

2) Reference is subtracted from the reading (optical density mode) or the read 
data is divided by the reference (%T modeÑsee Caution below)

3) Template blank subtraction

4) Wavelength reduction

5) Kinetic or spectrum reduction

6) Group blank subtraction

NOTE:
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Separate mathematical calculations are used for handling 
OD and %T calculations for Pre-read plate blanking, PathCheck, and 
Reference because OD calculations are performed on a linear scale, 
whereas %T calculations are performed on a logarithmic scale. Other 
calculations, however, are not calculated differently by SOFTmax 
PRO for absorbance and %T modes. Because of this, Molecular Devices 
recommends that %T be used only for raw OD, raw OD with Pre-read plate 
blank subtraction, or PathCheck-corrected raw OD readings. Use caution 
when using %T on reduced numbers or any readings that apply other 
calculations since the data may not accurately reßect proper calcula-
tions.

You can access the Reduction dialog box in several ways: by clicking the
[Reduction] button in the tool bar of the active plate/cuvette section, by 
choosing Reduction from the Plate/CuvetteSet menu, or by clicking the 
[Reduction] button in the Well Graph display. The appearance of the Reduc-
tion dialog box will be different depending on the type of read mode you 
have chosen, and the options you have chosen in the Instrument Settings dia-
log box. Figures 5.18 and 5.19 show the Reduction dialog boxes for a Plate sec-
tion and a CuvetteSet section, respectively, in endpoint, kinetic, and spectrum 
modes (both absorbance and ßuorescence settings are shown), along with the 
default reductions for each of those modes.

! CAUTION:
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Figure 5.18: Reduction Dialog Boxes for Endpoint, Kinetic, Spectrum, and Well Scan 
Modes (Plate Section). Boxes in the center are from SPECTRAmax GEMINI or 
GEMINI XS.

Reduction Dialog Boxes Default
ReductionsEndpoint

Kinetic

Spectrum

Well Scan
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Figure 5.19: Reduction Dialog Boxes for Endpoint, Kinetic, and Spectrum Modes 
(CuvetteSet Section)

The PathCheck (SPECTRAmax PLUS, PLUS384, 190, and 340PC only) and pre-
read plate reduction parameter checkboxes will not be displayed in the Plate 
section Reduction dialog box unless they have been selected in the Instru-
ment Settings dialog box. Figure 5.20 shows how the Reduction dialog box 
looks with the ÒUse plate blank,Ó ÒUse pre-read plate,Ó ÒSwitch normal and 
pre-read,Ó and ÒApply PathCheckÓ options available.

Reduction Dialog Boxes Default
Reductions

Endpoint

Kinetic

Spectrum
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Figure 5.20: Example Reduction Dialog Box Showing PathCheck, Pre-Read and Plate 
Blank Options

All of the read modes offer one or more predeÞned choices for reduction. The 
predeÞned reductions are described below under the appropriate read mode 
heading. In addition, with any read mode, you can create a custom reduction 
formula to better suit your needs. Since all custom reduction formulas are 
deÞned the same way, regardless of read mode, they are described together 
after the individual read mode sections.

Endpoint

Wavelength Combination
The default reductions for endpoint readings are !Lm1, !Pathlength,1 and 
Custom for all MAXline instruments when you read at a single wavelength or 
if you choose Ò1-RefÓ (for all instruments except SPECTRAmax and VERSA-
max). The !Pathlength reduction reports the pathlength in each well. With all 
SPECTRAmax instruments, additional wavelength combinations become 
available depending on the number of wavelengths chosen. For any MAXline 
instrument, you can choose Custom and create different reduction formulas. 
The wavelength combinations available in the drop-down menu show the 
correct format of the formulas that produce these reductions.

PathCheck (SPECTRAmax PLUS, PLUS384, 190, and 340PC only)
Pathlength correction allows microplate data in endpoint mode read by the 
SPECTRAmax PLUS, PLUS384, 190, and 340PC to be normalized to a 1 cm 
pathlength. When PathCheck is turned on in the Instrument Settings dialog 
box for the plate, ÒApply PathCheckÓ appears in the associated Reduction 
dialog box.

1. The !Pathlength option is only applicable to Plate or CuvetteSet sections when 
using the SPECTRAmax 190, 340PC, PLUS384, or PLUS; however, the wave-
length reduction display is not instrument-dependent in SOFTmax PRO, so this 
choice is always shown, regardless of which instrument is connected or chosen in 
the Preferences. Choosing !Pathlength with any other instrument or for Cuvette-
Set sections in the SPECTRAmax PLUS or PLUS384 will cause an error. The Plate 
section will not display a reduced number and, consequently, no values will be 
reported in the Group section table.



Chapter 5: Displaying and Analyzing Data

SOFTmax PRO UserÕs Manual 5-29

Kinetic

Wavelength Combination
The default wavelength combination for kinetic readings is !Lm1 and is the 
only choice (besides Custom) for all MAXline instruments except the SPEC-
TRAmax and VERSAmax. For the SPECTRAmax, the choices depend on the 
number of wavelengths chosen (for example, if you will read at two wave-
lengths, choices default to !Lm1 and !Lm2, along with Custom). With the 
VERSAmax, choices depend on whether you are reading the plate at either 
one or two wavelengths. For any MAXline instrument, if you do not wish to 
use the default reduction, you can choose Custom and create a different 
reduction formula.

Kinetic Limits
The Limits settings for the display of kinetic data are MaxOD, MinOD, Lag 
Time, and End Time for absorbance instruments, and MaxRFU/RLU, Min-
RFU/RLU, Lag Time, and End Time for the SPECTRAmax GEMINI or GEM-
INI XS.

The display of OD/RFU/RLU values is shown relative to the Þrst 
point measured for each well. Negative kinetic values decrease with 
time, and limits should be set accordingly (below 0) to view negative 
kinetic data.
Limits deÞne the data that will be viewed and included in data reduction, 
but do not affect data collection. If you alter a limit to show less data, 
you can always display the ÒhiddenÓ data again by changing the 
limit.

MaxOD/MaxRFU/MaxRLU
The limit for the maximum value you wish to report. Any values from the 
reading that are above this limit will not be shown and will be excluded from 
data reduction. The defaults are 1.0 for OD and 20,000 for RFU/RLU.

The MaxOD/RFU/RLU reduction parameter can be used to exclude the non-
linear portion of the reaction from data analysis. This type of data reduction is 
most useful in reactions where the initial portion of the data is linear. You 
might also adjust the End Time setting to remove a non-linear portion after a 
certain time point in the reaction. Using MaxOD/RFU/RLU allows the use of 
the maximum number of linear points to calculate the slope of the line and, 
thus, to determine the rate for each well.

NOTE:
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Figure 5.21: Different Reductions of the Same Data Using Different MaxOD Points

Both of the Well Graphs shown above display different reductions of the same 
data (these examples use optical density readings). In the Þgure on the top, 
the MaxOD is set to 2.0 for the display of wells B4, C6, and D8. In the Þgure 
on the bottom, the MaxOD has been reset to 0.5.Alternatively, you could leave 
the Maximum OD and decrease the number of Vmax Points used to deter-
mine the slope of the line.
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MinOD/MinRFU/MinRLU
The limit for the minimum value you wish to report. Any values from the 
reading that are under this limit will not be shown and will be excluded from 
data reduction. The default is 0 OD/RFU/RLU. To display negative kinetics, 
the value should be set below 0 (zero). 

Lag Time
SpeciÞes how many initial data points are excluded from the calculation of 
Vmax Rate. Lag Time truncates the data used in the calculation. It does not 
prevent data from being collected. The kinetic plots will not display the data 
collected prior to the set Lag Time. The value for Lag Time can be changed 
after the plate is read. The default is 0.

Figure 5.22: Different Lag Time Settings

In the Þgure on the left, well C5 has a lag time: the data is not linear until 
approximately 80 seconds after the start of data collection. Thus, the linear 
curve Þt is not good and the slope of the line does not reßect the maximal rate. 
In the Þgure on the right, a lag time of 80 seconds has been set and the linear 
curve Þt for both wells is good, allowing the slope of the lines to reßect the 
maximal rate in each well. Alternatively, you could leave the Lag Time and 
decrease the number of Vmax Points used to determine the slope of the line.
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End Time
This setting speciÞes the time at which you wish to stop showing data in the 
display. Any values occurring after this limit will not be reported in the dis-
play. The default setting is the total assay time. The value for end time may 
not be greater than the total assay time.

Absolute Values
This setting causes the plots shown in the data display to be drawn at their 
absolute OD or RFU/RLU as opposed to the default (with the box unchecked) 
which offsets the Þrst point to the (0,0) coordinate. Enabling Absolute Values 
may cause some data points that do not fall within the default limits for the 
plots to ÒdisappearÓ (see Figure 5.23).

Figure 5.23: Kinetic Reduction with Absolute Values Enabled. Note that the limits in 
this example (MinOD=0, MaxOD=0.5) do not allow all of the data to be visible.

To see more data, yet still display absolute values, increase the limits for 
MinOD/RFU/RLU and/or MaxOD/RFU/RLU found in the Reduction dia-
log box (Figure 5.24).
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Figure 5.24: Limits in Reduction Dialog Box (OD and RLU shown)

If you increase the MaxOD/RFU/RLU setting to be at least as large as the 
largest absorbance/ßuorescence/luminescence value expected, most or all of 
the data plots should appear in the data display. In the example shown in Fig-
ure 5.23, if the MaxOD value is increased from 0.5 to 2.0, the plots then appear 
as shown in Figure 5.25.

Figure 5.25: Kinetic Reduction with Absolute Values Enabled and MaxOD Value 
Increased

OD Limits

RLU Limits
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Kinetic Reduction
Kinetic reductions are applied to the list of numbers (the value at each time-
point) after the wavelength combination formula is applied. Vmax per min 
and Vmax per sec reductions are available for all instruments that are capable 
of kinetics; the default kinetic reduction for absorbance instruments is Vmax, 
and for the SPECTRAmax GEMINI or GEMINI XS, the default kinetic reduc-
tion is Vmax (units per sec). Other reductions available from the pop-up 
menu are Time to Vmax, Onset Time, Time at Minimum, Time at Maximum, 
Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose Custom 
and then create a different reduction formula.

Vmax
The maximum slope of the kinetic display of optical density (for absorbance 
instruments) or relative ßuorescence/luminescence units (for SPECTRAmax 
GEMINI or GEMINI XS) versus time. The default value displayed is in milli-
optical density units per minute (mOD/min) for absorbance instruments; for 
the SPECTRAmax GEMINI or GEMINI XS, the default value displayed is in 
units/second, where units are relative ßuorescence units (RFU) or relative 
luminescence units (RLU). The rate is calculated with the use of  Vmax Points 
(see below) which determines the number of contiguous points over which 
Vmax is calculated. The number of Vmax Points defaults to the maximum 
taken during the reading; you can change this number in the Reduction dia-
log box if desired.

Vmax = Vmax/sec ¥ 60,000

A linear regression is performed to determine the slope of the line using the 
equation:

y = m*X + B

where m is the slope of the line.

The reaction rate is reported in milliOD/min (color change in milliOD per 
minute of reaction time) for absorbance instruments, or in units/sec for the 
SPECTRAmax GEMINI or GEMINI XS.

Vmax Points

This setting deÞnes the maximum size of the line segment used to determine 
the slope of the line used in calculating the rate of the reaction. The default is 
the total number of points taken in the reading, with the data normalized to a 
starting point of 0,0 (as opposed to starting from the optical density of the Þrst 
time point). The Þrst slope is calculated for a line drawn beginning at the Þrst 
reading as deÞned by Lag Time (described below) and ending at a total num-
ber of readings equal to the Vmax Points setting. The second and any subse-
quent slopes are calculated beginning at the second time point and ending at 
a total number of readings equal to Vmax Points. The steepest slope is 
reported as Vmax Rate. If the data plot displays fewer time points (data 
points) than the number of time points chosen for Vmax Points, then all of the 
time points will be used to determine the slope of the data.

NOTE:
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* SOFTmax PRO will perform a linear regression on as many overlapping 
5-point line segments as possible in the analysis window. The slope will be 
determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in Table 5.1, above, the 
slope will be determined for line segments consisting of time points 1 to 5, 
2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line segment 
with the steepest slope will be reported as the Vmax Rate.

The progressive slope calculations are repeated until the last included data 
point is reached (as deÞned by the End Time or MaxOD/MaxRFU/MaxRLU 
Ñ see below). The maximum positive or negative slope is reported as Vmax 
(mOD/min, RFU/sec, or RLU/sec). Vmax Points can be set from 2 to the total 
number of points in the curve. The number of Vmax Points can be set before 
the plate is read and can be changed after the plate is read. The data display 
will update automatically each time. The Vmax Points setting does not affect 
data collection.

The height of the Y axis in the raw data plots or plate display is con-
trolled using MinOD/RFU/RLU and MaxOD/RFU/RLU. The 
default settings are:
MinOD/RFU/RLU = 0
MaxOD = 1.0      MaxRFU/RLU = 20,000
The width of the X-axis in the raw data plots or plate display is con-
trolled using Lag Time and End Time. If either the MaxOD or End 
Time setting excludes points such that a total number of readings 
equal to Vmax Points cannot be used, then the maximum included 
points will be used.

Time to Vmax
This is an alternative method for analyzing non-linear kinetic reactions which 
reports the elapsed time until the maximum reaction rate is reached, rather 
than reporting the maximum rate itself. Used in conjunction with Vmax 
Points, Time to Vmax is the time to the midpoint of the line deÞned by Vmax 
Points and used to calculate Vmax. This elapsed time data is useful for appli-
cations including coagulation chemistry where the changing concentration of 
the reagents does not change Vmax, but rather will change the time at which 
the reaction reaches the maximum rate.

Table 5.1: Using Vmax Points (Example)

Well 1 Well 2 Well 3

Time points visible in 
the well (data plot)

25 10 2

Number of Points Used for Data Analysis:

Vmax Points set to 25/25 
(default)

25 10 2

Vmax Points set to 5/25 Overlapping 
5-point line 
segments*

Overlapping 
5-point line 
segments*

2

NOTE:
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Onset Time
This is another method for analyzing non-linear kinetic reactions. Onset Time 
reports the time required for a kinetic reaction to change by a speciÞed optical 
density (onset OD or RFU/RLU above the initial OD/RFU/RLU reading for 
the well). This elapsed time data is useful for cascade reactions including clot 
formation (endotoxin testing, for example) and clot lysis applications where 
the change in reagent concentration does not affect the maximum optical den-
sity change but changes the time required for the reaction to reach comple-
tion. 

Time at Minimum
This setting reports the time at the minimum OD, %T, RFU, or RLU that falls 
within the reduction limits.

Time at Maximum
This setting reports the time at the maximum OD, %T, RFU, or RLU that falls 
within the reduction limits.

Time at 1/2 Maximum
This setting reports the time at the half of the maximum OD, %T, RFU, or 
RLU that falls within the reduction limits. To calculate this reduction, SOFT-
max PRO Þrst determines the kinetic point (within the reduction limits) that 
has the maximum signal level (OD, %T, RFU, or RLU). It then scans the 
kinetic plot from left to right until it Þnds two points having signals that 
bracket half of that value. A linear interpolation between these two points is 
used to estimate the Time at 1/2 Maximum.

Slope
This setting determines the slope of the combined plot (i.e., the slope of the 
line using linear regression after the wavelength combination reduction). This 
setting uses all visible timepoints in the reduction window. Slope is the same 
as Vmax Rate when Vmax Rate is set to the same number of points as the run 
(i.e., the default). Slope is not the same as Vmax Rate if you have modiÞed the 
Vmax Points.

Area Under Curve
This reduction estimates the area under the curve as deÞned by the data plots 
in wells and cuvettes (within the reduction limits). The data plots are treated 
as a series of trapezoids with vertices at successive data points and at the X-
axis coordinates of the data points. The areas deÞned by each of the trape-
zoids are then computed and summed.
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Spectrum (SPECTRAmax Instruments Only)

Spectrum Limits
The Limits settings for the display of spectrum data are MaxOD/RFU/RLU, 
MinOD/RFU/RLU, Starting Wavelength in nm, and Ending Wavelength in nm.

The display of values is shown relative to the Þrst point measured 
for each well. Limits deÞne the data that will be viewed and included in 
data reduction, but do not affect data collection. If you alter a limit to 
show less data, you can always display the ÒhiddenÓ data again by 
changing the limit.

MinOD/MinRFU/MinRLU
The limit for the minimum value you wish to report. Any values from the 
reading that are under this limit will not be shown and will be excluded from 
data reduction. The default is 0 OD/RFU/RLU.

MaxOD/MaxRFU/MaxRLU
The limit for the maximum value you wish to report. Any values from the 
reading that are above this limit will not be shown and will be excluded from 
data reduction. The default is 1.0 OD for absorbance; the default for the 
SPECTRAmax GEMINI or GEMINI XS is 20,000 RFU/RLU.

Start (Wavelength) nm
SpeciÞes the limit for the minimum wavelength setting you wish to report. 
Any values from the reading that are under this limit will not be shown and 
will be excluded from data reduction.

End (Wavelength) nm 
SpeciÞes the limit for the maximum wavelength setting you wish to report. 
Any values from the reading that are above this limit will not be shown and 
will be excluded from data reduction.

The settings for the Start and End wavelength settings cannot be 
below the lowest wavelength or above the highest wavelength 
entered in the Instrument Settings for the spectrum reading.

Spectrum Reduction
The spectrum reduction formula is applied to the list of numbers in each well 
(values at each wavelength) after the wavelength combination formula is 
applied. The default reduction for spectrum readings is Lambda at Maxi-
mum. You can choose Lambda at Minimum, Maximum, Minimum, or Area 
Under Curve instead from the pop-up menu or you can choose Custom and 
create a different reduction formula.

Maximum
Reports the maximum absorbance (optical density), percent transmittance 
(%T), relative ßuorescence, or relative luminescence (within reduction param-
eters of MinOD/RFU/RLU and MaxOD/RFU/RLU).

NOTE:

NOTE:
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Minimum
Reports the minimum absorbance (optical density), percent transmittance 
(%T), relative ßuorescence, or relative luminescence (within reduction param-
eters of MinOD/RFU/RLU and MaxOD/RFU/RLU).

Lambda at Maximum
Reports the wavelength at which maximum absorbance (optical density), per-
cent transmittance (%T), relative ßuorescence, or relative luminescence is 
achieved (within reduction parameters of MinOD/RFU/RLU and 
MaxOD/RFU/RLU).

Lambda at Minimum
Reports the wavelength of minimum absorbance (optical density), percent 
transmittance (%T), relative ßuorescence, or relative luminescence is achieved 
(within reduction parameters of MinOD/RFU/RLU and 
MaxOD/RFU/RLU).

Area Under Curve
This reduction estimates the area under the curve as deÞned by the data plots 
in wells and cuvettes (within the reduction limits). The data plots are treated 
as a series of trapezoids with vertices at successive data points and at the X-
axis coordinates of the data points. The areas deÞned by each of the trape-
zoids are then computed and summed.

Data Mode (%Transmittance/Absorbance)
For all read modes (except with the SPECTRAmax GEMINI or GEMINI XS), 
you can choose whether to view data as %Transmittance or Absorbance (OD). 
As with all reduction or display options, these choices do not affect the raw 
data acquired from the instrument but rather only how it is shown in SOFT-
max PRO. If %T is chosen, all values including raw data are displayed in %T.

When the data mode is switched from %T to Absorbance or 
vice versa, SOFTmax PRO recalculates all of the values based upon 
the new data mode. Separate mathematical calculations are used for 
handling OD and %T calculations for Pre-read plate blanking, and 
PathCheck because OD calculations are performed on a linear scale, 
whereas %T calculations are performed on a logarithmic scale. How-
ever, other calculations are not calculated differently by SOFTmax 
PRO for absorbance and %T modes. Therefore, switching from %T to 
Absorbance or vice versa is not recommended. Additionally, Molecular 
Devices recommends that %T be used only for raw OD, raw OD with Pre-
read plate blank subtraction, or PathCheck-corrected raw OD readings. Use 
caution when using %T on reduced numbers or any readings that 
apply other calculations since the data may not accurately reßect 
proper calculations.

If you switch from one mode to the other, note that settings for the 
two modes are not ÒlinkedÓÑsettings chosen for one mode are not 
reßected if you switch to the other mode. For example, if data from a 
spectral scan is displayed with a MinOD of 0 and a MaxOD of 1 
(absorbance), and you then switch to %Transmittance and change the 
limits to 0 and 50%, respectively, switching back to absorbance will 

! CAUTION:

NOTE:
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not change the limits set previously (the Min- and MaxOD limits will 
still be 0 and 1).

Well Scan (SPECTRAmax GEMINI Series Only)

Wavelength Combination
The default wavelength combination for well scan readings is !Lm1 and is the 
only choice besides Custom which can be used to create a different reduction 
formula.

Well Scan Reduction
Choices are Maximum, Minimum, Average (default), and Custom. Average 
provides the average value for all points in the well scan.

Custom Reduction Formulas
If the predeÞned reduction formulas do not meet your needs, you can create 
one or more different reduction formulas for any or all read modes (endpoint, 
kinetic, spectrum, or well scan). Choosing ÒCustomÓ from any of the menus 
or dialog boxes causes a Formula button to appear (an example of this button 
in an endpoint Reduction dialog box is shown in Figure 5.26). Custom reduc-
tion formulas may contain other operators and terms in addition to wave-
lengths.

Figure 5.26: ÒCustomÓ Selected Showing Formula Button (Endpoint)

Clicking the Formula button opens the Calculation dialog box in which you 
can name and deÞne a new reduction formula.

Figure 5.27: Wavelength Calculation Dialog Box (Endpoint)

Formula

Button
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Examples of some formulas that might be used when combining multiple 
wavelengths in the Calculation dialog box are given in Table 5.2.

For Emax, Vmax, UVmax, or THERMOmax instruments, the choice 
available for reading at two wavelengths is designated Ò1-Ref.Ó While 
the instrument performs a reading at the two wavelengths you desig-
nate (one for the measurement and one for the reference), data 
regarding these individual wavelength readings is automatically 
reduced to a single value in the data display: the value obtained from 
the reading at the reference wavelength is subtracted from the read-
ing at the measurement wavelength and only the resulting value is 
displayed. When you choose 1-Ref, you cannot view the data associ-
ated with the readings at the individual measurement or reference 
wavelengths.

Table 5.2: Wavelength Reduction Formula Examples

2 λ 3 λ 4 λ to 6 λ

!Lm1 + !Lm2 !Lm1 + !Lm2 + !Lm3 !Lm1 + !Lm2 + ... + !Lmn

!Lm1 - !Lm2 (!Lm1 - !Lm3) / (!Lm2 - 
!Lm3)

(!Lm1 - !Lm6) /(!Lm2 - !Lm5) /
(!Lm3 - !Lm4)

!Lm1 / !Lm2 !Lm1 / !Lm3 !Lm1 / !Lmn

!Lm1 * !Lm2 !Lm1 * !Lm3 !Lm1 * !Lmn

Log10(!Lm1/!Lm2) Log10(!Lm1/!Lm3) Log10(!Lm1/!Lmn)

!Pathlength !Pathlength !Pathlength

!Lmx/constant For example, Lm1/1.44 for quantitating a polyclonal antibody by 
measuring the absorbance at A280 in a SPECTRAmax PLUS or 

PLUS384 with PathCheck on.

Average(!allvalues) This formula will average together the optical densities for 
multiple readings at the same wavelength (for example, if you 

read the well six times at 280 nm).

Min(!allvalues) This formula will report the minimum OD recorded for 
multiple wavelength readings in each well.

Max(!allvalues) This formula will report the maximum OD recorded for 
multiple wavelength readings in each well.

If(!Lmz<A,makeerr(118),(if(!L
mx>B,makeerr(117),!Lm1)))

This formula will report ÒlowÓ for any well with an OD less than A, 
ÒhighÓ for any OD greater than B, and the OD of any well that 

lies between A and B.

NOTE:
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Custom reduction formulas utilizing mathematical operators or terms can be 
used to obtain speciÞc types of data. Table 5.3 provides some examples of 
such formulas for kinetic and spectrum readings.

A list of accessors and operators that may be used in custom reduction formu-
las can be found at the end of this chapter. For a full discussion of custom for-
mulas, see the Formula Reference Guide.

When you Þnish your entry in the Calculation dialog box and click [OK], the 
formula you have entered then appears to the right of the word ÒCustomÓ 
and becomes the default selection for the Custom option. You may subse-
quently edit this formula or enter a new one by clicking the Formula button 
again.

Recalculation Options
By default, SOFTmax PRO performs continuous recalculation of the data 
when you read plates, create or change formulas, and so on. At certain times, 
it would be useful to disable the recalculation feature so that you can make 
alterations to the experiment without waiting for individual recalculations to 
be completed. Two commands are available in the Edit menu that allow you 
to modify the way in which SOFTmax PRO performs recalculation: 
Suspend Recalculation and Recalculate Now (z =; CTRL+=).

Choosing Suspend Recalculation disables the automatic recalculation feature 
of the program and places a checkmark to the left of the command in the 
menu to indicate that it has been selected. While this function is enabled, no 
recalculation will occur, regardless of what you may change, add, or delete 
from the experiment. This is especially useful when creating or changing col-
umn formulas within Group sections, for example, as it can speed up the pro-
cess greatly.

When recalculation has been suspended, you may wish to see the results of 
the changes you have made but may still not wish to enable continuous recal-
culation. Choosing Recalculate Now (z =; CTRL+=) from the Edit menu will 
cause SOFTmax PRO to examine all elements of the experiment and perform 
complete recalculation of the data. Choosing this command does not enable 

Table 5.3: Kinetic and Spectrum Reduction Formula Examples

Kinetic

Vmaxcorr(!combinedplot,
!vmaxpoints,!readinterval)

Reports Vmax correlation coefÞcient for plots in all 96 wells.

Vmax(Delta(!combinedplot),
!vmaxpoints,!readinterval)

Will report the Vmax Rate of the delta between each time point.

Spectrum or Kinetic

Nthitem(!Lm1,X) Will report the optical density at item X in the list of readings. 
For example, if you have a kinetic run with 20 time points and 
X is 10, it will report the OD of the 10th time point. Similarly, if 

you have a spectral scan with 20 measurements and X is 10, 
it will report the OD of the 10th wavelength measured.
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continuous recalculation but simply causes the program to perform recalcula-
tion once.

To return to continuous recalculation, choose Suspend Recalculation again. 
The checkmark next to the command will disappear, indicating that the 
function is no longer in use.

Recalculate Now (z =; CTRL+=) can be used to see intermediate 
results during long kinetic readings. At any time, you can choose 
Suspend Recalculation to delay calculations until a later time.

Displaying Data in Group, Graph, and Notes Sections

Group Sections
The manner in which data is displayed in a Group section depends on the 
type of reading that was performed (endpoint, kinetic, spectrum, or well 
scan), but can be customized by choices made in the data display, reduction 
settings, and the Edit menu.

¥ Resizing/hiding columns

¥ Adding/deleting columns

¥ Showing/editing column formulas

¥ Adding/editing summaries

¥ Changing text style

Default displays for Group sections are shown automatically unless you 
choose a different display option.

The particular font to be used in a Group section table, as well as its size and 
style, can be changed by Þrst selecting one or more columns in the Group sec-
tion table and then choosing the Text command from the Edit menu and mak-
ing the desired choices from the dialog box that appears.

Settings from the Plate/CuvetteSet Section Affect Data Display in 
Group Section Tables
Reduction options in the Plate/CuvetteSet section allow you to display the 
raw data received from the MAXline instrument in a reduced (analyzed) 
form. Which reduction options are available depend on the read mode used 
and reduction settings chosen. Reduced number from the Plate/CuvetteSet 
section is displayed in the Values column of the Group section tables by 
default.

Reduction settings do not affect the raw data but simply cause it to be dis-
played differently. You can change reduction settings without affecting the 
raw data from the plate or cuvette reading in any way.

Custom reduction formulas require the use of accessors and operators that 
are understood by SOFTmax PRO. A list of these accessors and operators is 
given at the end of this chapter.

NOTE:
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Resizing and Hiding Columns
The columns in a Group section can be resized in several ways. One of the 
simplest is to drag the line dividing the columns to another position (moving 
it horizontally). When you point to a line between columns, the cursor 
changes to a double arrow with a vertical line through it, showing that it is 
ready to move left or right (see Figure 5.28).

Figure 5.28: Cursor Positioned on a Line between Columns

Reducing Column Size and Hiding Columns
You can reduce a column to a size smaller than the width of its title, in which 
case the title will not be completely visible. You can also hide a column by 
reducing its size completely (drag one edge of the column on top of the other) 
or by selecting that column and choosing Hide from the Group menu.

If you hide a column in this way and then wish to view it again, use 
the Show All command in the Group menu. All columns that were 
hidden will again be visible. There is no way to show only one hidden 
column.

Enlarging Column Size
You can enlarge the width of columns to any size. Increasing the size of col-
umns may make the width of the Group section increase beyond the page 
width boundary. If this occurs, the columns will ÒdisappearÓ off the edge of 
the screen but are really still there. To bring these columns back into view, 
reduce the width of the columns that are still visible until the others reappear.

Figure 5.29: Dragging a Column Divider Line

Double-headed
arrow cursor

NOTE:

Divider being
dragged to the

left
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If the width of a section extends beyond the page width boundary, 
the portion that is not visible will not be printed.

To size two or more columns to the same width, highlight those columns and 
then drag one of the dividing lines to the desired width. The width of all high-
lighted columns will be sized the same as the column to the left of the divid-
ing line you are moving.

Columns can also be resized to the minimum amount of space required by 
choosing Autosize from the Group menu. By highlighting the entire table or 
individual columns and then choosing Autosize, the amount of space each 
column requires will be reduced to the minimum size required by the largest 
piece of text in that column.

Double-clicking the line dividing two columns causes the single column to 
the left of the divider to be sized according to the largest amount of text in 
that column.

Showing and Editing Existing Column Formulas
When group sections are Þrst created, the formulas used to calculate the data 
are not displayed.

These formulas can be shown (until you choose to hide them again) by mak-
ing a Group section active and then choosing Show Formulas from the Group 
menu. (Note that the command in the menu changes to Hide Formulas after 
they are shown.)

Figure 5.30: The ÒShow FormulasÓ Command in the Group Menu

Choosing this option causes an additional row to appear (beneath the head-
ing for each column) which shows the formula used to calculate the data in 
each column. To see formulas brießy, hold down the shift and control (Ctrl) 
keys.

NOTE:

Show Formulas Command
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Figure 5.31: Formulas Shown in Group Columns

Modifying Column Formulas
To modify the formula for an existing column, double-click the column or 
click the column once and then click the formula button in the section tool bar. 
The dialog box associated with the column formula will open, allowing you 
to edit the formula (and the name) associated with the column.

Figure 5.32: Formula Button Activated and Column Formulas Shown

Information about the accessors and operators that can be used in column for-
mulas can be found at the end of this chapter. For a complete discussion, see 
the accompanying Formula Reference Guide.

Formulas

Formula Button
Create Summary Button

Create Column Button
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Adding Columns
You can add a new column to a Group section by clicking the Create Column 
button in the Group tool bar or by choosing Create Column from the Group 
menu which will open the Column Formula dialog box.

Figure 5.33: Column Formula Dialog Box

In the Column Formula dialog box, you can change the name of the new col-
umn (from the default which simply lists the column by number) to reßect the 
data that it will contain.

If no existing column is selected when you click the Create Column button, 
the new column will be created to the right of all existing ones. If you select 
(highlight) a column and then add a new column, it will be positioned to the 
right of the one you selected. If the table is currently as wide as the sheet of 
paper speciÞed in Page Setup when a new column is added, the columns will 
ÒdisappearÓ off the right side of the window but are still there. To bring these 
columns back into view, resize visible columns smaller.

New columns can contain references to other columns, both in the current 
section or in a different one within the same experiment. For example, if you 
wanted to subtract the mean values in one group from those in another, you 
could create a new column (in either group) to do this. If the two groups were 
named ÒGroup 1Ó and ÒGroup 2,Ó for example, and both groups contained a 
column entitled ÒMean,Ó you could create a column within ÒGroup 1Ó that 
would subtract the mean values in ÒGroup 2Ó from those in ÒGroup 1.Ó 
The column formula needed to do this would be:

Mean-Mean@Group2

Numerous possibilities exist for creating and editing column formulas to dis-
play the data you desire. A list of operators that can be used in formulas 
within SOFTmax PRO is given at the end of this chapter. For a complete dis-
cussion of formulas and operators, see the accompanying Formula Reference 
Guide.

To delete a column, highlight it and press the Delete key or choose 
Cut from the Edit menu.

NOTE:
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Adding or Editing a Summary in a Group Section
To add a summary at the bottom of a Group section, click the Create Sum-
mary button in the tool bar or choose Create Summary from the Group menu. 
The Calculation dialog box will appear, allowing you to change the name of 
the summary or hide the name, if desired, as well as to enter a description of 
the summary and to create a formula for it (including the number of decimal 
places for the result, if appropriate). Double-clicking an existing summary 
causes the same dialog box to appear, allowing you to modify summary infor-
mation.

Figure 5.34: Calculation Dialog Box

Information entered in this dialog box will be placed at the bottom of the 
Group section as follows:

Name = Description     Formula Result

You can click the checkbox next to Hide Name which will change the way the 
summary appears to show:

Description     Formula Result

The name assigned to a summary is important since you can refer-
ence the summary by name in other formulas (building one upon 
another). The summary name can be referenced even if it is hidden.

If you wish to see the formulas associated with summaries without calling up 
the Calculation dialog box for each one, you can choose Show Formulas from 
the Group menu. To see these formulas only brießy, hold down the shift and 
control (Ctrl) keys while that Group section is active. The summaries will 
ÒexpandÓ to show the complete formula along with the title. They will 
resume their previous appearance when you release the option key.

Summaries in Group sections can be moved horizontally, if desired, by drag-
ging them left or right. When you position the pointer over a Group sum-
mary, the cursor changes to show a double-headed horizontal arrow. Clicking 
once highlights the summary; dragging and then releasing the summary 
leaves it in the position where the mouse button was released.

To have summaries line up with particular columns in the Group, hold down 
the control (Ctrl) key while dragging the summary. When you release the con-
trol (Ctrl) key, the summary will Òsnap backÓ so that it begins ßush to the left 
side of the column under which it was released. Each summary can be posi-
tioned in a different place in the Group section, if desired.

NOTE:
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To delete a summary, highlight it and press the Delete key or choose 
Cut from the Edit menu. A summary can also be copied or cut and 
then pasted in a different location.

You can also change the format of the text in Group section columns and/or 
summaries. By selecting the column or summary and then choosing Edit and 
then Text Style (Ctrl+T), you can change the font, size, and/or style of the 
text.

Notes Sections
The Notes section allows you to enter text describing the experiment and one 
or more summary lines that contain formulas. To create a summary, click the 
Create Summary button in the tool bar or choose Create Summary... from the 
Notes menu.

The Calculation dialog box that appears (see Figure 5.34) allows you to enter 
a description of the summary, accept the default title for the summary, change 
it, or hide it, and to enter a formula (including the number of decimal places 
the reduction should show, if appropriate). Detailed information regarding 
operators and accessors can be found at the end of this chapter.

If you wish to see the formulas associated with the summaries without calling 
up the Calculation dialog box for each one, you can choose Show Formulas 
from the Notes menu. To see these formulas only brießy, hold down the shift 
and control (Ctrl) keys while that Notes section is active. The summaries will 
ÒexpandÓ to show the complete formula along with the other summary infor-
mation. They will resume their previous appearance when you release the 
option key.

Graph Section

The Plot#X Dialog Box
Whenever you create a new Graph section or add a plot to an existing graph, 
the Plot#X dialog box opens automatically (ÒXÓ starts with Ò1Ó and incre-
ments each time a new plot is added to a Graph section). In this dialog box, 
you can rename the plot, assign speciÞc information to be plotted on the X- 
and Y- axes, and choose which icon and color will be used. If you rename the 
plot, the title of the dialog box will change to show the new plot name.

All groups that have been created or assigned within the Þle are listed on the 
left side of the ÒSource:Ó Þeld in the Plot#X dialog box. The Þrst group in the 
Þle is automatically selected. Other groups can be selected by highlighting 
them. When a group is selected, the pull-down menus in the X-axis and Y-axis 
subÞelds change to show the group columns that are available for graphing. 
Group columns can be assigned for both the values to be plotted and any 
error bars to be included for both axes.

Summaries and user-deÞned formulas can also be graphed. Pushing the  
button for either the X-axis or Y-axis opens a dialog box which allows you to 
enter formulas. To plot a summary, enter the summary name in this dialog 
box. Formulas can be plotted for comparison with other data. For example, if 
the data is assumed to follow a speciÞc model, the model formula can be 
entered as a plot and then the data can be chosen for another plot within the 
same graph. You can also use this feature to plot kinetic or spectrum data in 

NOTE:
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Graph sections. For example, to plot kinetic data from well A1 in a Graph sec-
tion, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun 
accessor for the X-axis. The entered formulas are also shown in the ÒSource:Ó 
Þeld of this dialog box.

The size, color, and style of the icon used for a plot can be selected on the right 
side of this dialog box. Four sizes, nine colors, and nine styles are available 
from drop-down menus.

The Graph Options Dialog Box
The Graph Options dialog box allows you to change the name of the Graph 
section, change the height of a graph, select the type of graph to be displayed, 
change the fonts used on the title, legend, and axes, access the Plot#X dialog 
box for editing plots, entering new plots, and/or to delete plots. This dialog 
box is opened after pressing [OK] in the Plot#X dialog box when a new 
Graph section is being created. This dialog can also be accessed by pressing 
the Graph Options button  on the Graph section toolbar or by choosing 
Graph Options from the Graph menu.

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars 
can be used with all graph types. You can also choose whether to connect the 
points and/or plot the symbols in the graph.

In the ÒPlots:Ó Þeld of this dialog box, each of the plots that have been created 
for this Graph section are listed. Choosing any of these plots provides an indi-
cation of the data to be used for the X- and Y- axis data points and error bars 
on the right side of this Þeld. Plots can be deleted by highlighting the plot 
name and clicking the [Delete] button. Clicking on the [New] button opens 
the Plot#X dialog box, allowing you to create a new plot for the graph. Exist-
ing plots can be edited by highlighting the plot name and clicking on the 
[Edit] button which opens the Plot#X dialog box containing all the informa-
tion for the selected plot.

When creating a new Graph section, the Graph Options dialog box opens 
after pressing either [OK] or [Cancel] in the Plot#X dialog. The new Graph 
section is not created, however, until you press [OK] in the Graph Options 
dialog box.
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Figure 5.35: Graph Options Dialog Box

Creating Multiple Plots
SOFTmax PRO makes it possible to create multiple plots within a simple 
graph. Each plot will represent data from a group that has been created in the 
Template Editor or data from a summary or custom formula. You may plot 
data from any group or from several groups on a graph, even if the groups are 
in separate experiments. It is possible, for example, to plot multiple dilution 
series of an unknown, to graph together a series of patient samples, or to plot 
several controls that are run over time against one another.

Following is a summary of the steps required to create multiple plots within a 
single graph, after which is an example that provides more detail.

Multiple Plots Step Summary

¥ Create all required groups in the Template Editor.

¥ Read the microplate or cuvette to obtain data.

¥ Create a graph section.

¥ Add plots to the graph and choose the group and the X and Y values to be 
shown for each plot.

Example of Creating Multiple Plots

This example shows how three groups, all of which are Standards, were plot-
ted on the same graph. 

1) Groups are created in the Template Editor. For this example, four groups are 
created: three for standards (Standard1, Standard2, and Standard3) and one 
for Unknowns (Unknown1).

Edit... [plot] button

New... [plot] button

Name of the plot

Plot name and symbol

(you can change this)

Delete... [plot] button

Chart options box

Fonts options 
box

X and Y axis 
labels

X and Y
error bar 
description
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Figure 5.36: Standards and Unknowns Groups Created

2) The associated Group sections are created using the Standards column format 
which, by default, generates columns for concentration and optical density 
values. The example below shows the Group section for Standard2.

Figure 5.37: Standard2 Group Section

3) A new Graph section is created by selecting New Graph from the Experiment 
menu. This causes the Plots dialog box to open automatically. The default 
name for the Þrst plot, ÒPlot#1,Ó is then changed (by typing a new name over 
it) to ÒStandard#1.Ó Clicking [OK] opens the Graph Options dialog box which 
allows you to choose the graph type, modify the fonts used for the graph, and 
so on. Choices should be made as follows: Standard1 for the group to be plot-
ted, the concentration of Standard1 for the X-axis, and values of Standard1 for 
the Y-axis. No error bars are added.
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Figure 5.38: Graph Options Dialog Box with Plot Name Changed to ÒStandard#1Ó

4) A second plot is added to this graph by clicking the [New] button in the 
Graph Options dialog box. After clicking [New], a dialog labeled Plot #2 is 
opened. The second plot name defaults to ÒPlot#1,Ó which now shows 
beneath the Þrst plot. Change this second plot name to ÒStandard#2,Ó choose 
Standard2 for the group, and change the X- and Y-axes to show concentration 
and values, respectively, for Standard2.

Figure 5.39: Graph Options Dialog Box with Second Plot Added for Standard#2

5) This process is repeated for a third plot, labeled ÒStandard#3.Ó
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6) Now that all plots information is complete, clicking [OK] in the Graph 
Option dialog box will close it, and the resulting graph will show the three 
plots created.

Figure 5.40: Graph Displaying Three Standards Plots

You can add as many plots to a graph as you wish, and these can be of the 
same or different types of groups. If you create a graph and later wish to add 
one or more plots to it, simply click the [Graph Options] button on the 
Graph section tool bar and then click the [New] button. This will cause the 
Plots dialog box to reappear, allowing you to add or modify the plot informa-
tion.
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Error Bars
When data is displayed as a scatter or bar graph, you can choose to display 
error bars for the plot of the data for the X- and/or Y-axis. Error bars are lines 
that extend beyond a plotted value in either or both directions and graphi-
cally represent some amount of error in plotted data.

Figure 5.41: Plot Showing Error Bars

Choices for displaying error bars relative to a particular axis are the same as 
those available for displaying data on that axis: any column from that group 
that contains numerical information (not columns with text). To display error 
bars, click and hold the box next to ÒError BarsÓ in the Plot#X dialog and drag 
to select one of the choices in the menu. To disable error bars, choose ÒNo 
ErrorÓ for the X- and/or Y-axis.

Error bars show both positive and negative error. Depending on the range set-
tings for the graph, portions of the error bars may not be visible.

Curve Fitting
When you Þrst create a graph of the data, it does not have a Þt associated with 
it. The graph might appear something like this:

Figure 5.42: Graph with No Fit

Error Bars

No Fit selected
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You can Þt any plot to one of nine curve-Þtting algorithms: Linear, Semi-Log, 
Log-Log, Quadratic, 4-Parameter (logistic), Log-Logit, Point-to-Point, Expo-
nential, and Cubic Spline. These selections are shown in the Fits pop-up menu 
in the Graph section toolbar (click on the box next to ÒFitÓ).

Typically, a standard curve refers to the curve Þtted to the plot of concentra-
tion versus mean value for the Standard group.

Once you have selected a Fit type, SOFTmax PRO determines the parameter 
values that best Þt the data. The function with these parameters is then drawn 
on the graph. Ideally, the type of Þt used should be determined by the under-
lying chemistry of the assay and could be set before data is read.

A good discussion of curve Þtting appears in ÒData Analysis and 
Quality Control of Assays: A Practical PrimerÓ by R. P. Channing 
Rogers in Practical Immuno Assay, edited by Wilfrid R. Butt (published 
by Marcel Dekker, Inc., New York, 1984).

When a Þt is chosen, the Graph section is updated to show the coefÞcients 
describing the Þt when applicable. These values are displayed in the legend at 
the bottom of the graph. Figures 5.43 through 5.50 show the same graph with 
the different Þt algorithms applied. Note that the legend information changes 
(along with the formula for the Þt) at the bottom of each Graph section for 
each different Þt.

All plots on a graph must have the same type of Þt.
When a curve Þt is chosen, the values for the coefÞcients of the equation (A, B, 
C, etc.) will be shown as will the square of the correlation coefÞcient (R^2). 
The correlation coefÞcient describes how well a change in x values correlates 
with a change in the y values. Please see ÒJudging a Good Curve FitÓ on page 
5-65 for more information. The R^2 value should only be used for curve Þts 
having linear axes.

NOTE:

NOTE:
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Linear
The linear function Þts the best straight line to the data. The equation for this 
Þt has the form of:

Y = A + (B * X)
where A is the y-intercept of the line and B is the slope. A linear Þt should be 
used whenever the values appear to lie on or scattered around a straight line.

This equation is shown on the screen as:

y = A + Bx
A linear Þt should be used whenever the standard values appear to lie on or 
are scattered around a straight line. Figure Figure 5.43 shows an example of a 
linear Þt.

Figure 5.43: Graph with Linear Fit
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Semi-Log
The semi-log function Þts the best straight line to a set of data for log(X) plot-
ted against Y. The resulting curve displayed will be a straight line with the X-
axis drawn in logarithmic scale. The equation for a semi-log Þt is:

Y = A + [B * log10(X)]
and is shown on the screen as:

y = A + B * log(x)
where A is the y-intercept of the line and B is the slope (note: log in this equa-
tion is the common or base-10 logarithm).

Figure 5.44: Graph with Semi-Log Fit
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Log-Log
The log-log function Þts the best straight line to the set of data which consists 
of the logarithm of the readings on the Y-axis (the response) and the logarithm 
of the dose on the X-axis. The resulting display will be a straight line with 
both axes drawn in logarithmic scale. The equation for the log-log Þt is:

log10(Y) = A + [B * log10(X)]
and is shown on the screen as:

log(y) = A + B * log(x)
where A is the log10Y-intercept of the line for log10(X) = 0 and B is the slope 
(note: log in this equation is the common or base-10 logarithm).

Figure 5.45: Graph with Log-Log Fit
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Quadratic
The quadratic function Þts the best parabola to the data. The parabola is a 
curved line based on the equation:

y = A + (B * x) + (C * x2)
which is shown on the screen as:

y = A + B*x + C*x^2
where A is the intercept, B is the slope of the curve at the intercept, and C is 
the measure of the curvature of the parabola.

The quadratic Þt is most appropriate when the standard curve has a tendency 
to curve up or down. An example of a quadratic Þt is shown in Figure 5.46.

Figure 5.46: Graph with Quadratic Fit
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4-Parameter Logistic and Log-Logit
If the standard curve has a sigmoidal shape when plotted on the semi-log 
axes, it may be appropriate to use either the log-logit or 4-parameter Þt. Both 
Þts are based on the equation:

where D is the Y-value corresponding to the asymptote (i.e., the ßat part of the 
curve) at high values of the X-axis and A is the Y-value corresponding to the 
asymptote at low values of the X-axis. The coefÞcient C is the X-value corre-
sponding to the midpoint between A and D. The coefÞcient B describes how 
rapidly the curve makes its transition from the asymptotes in the center of the 
curve. A large value of B describes a sharper transition. Typically, B has a 
magnitude of about 1.

Both the log-logit and 4-parameter equations are shown on the screen as:

y = (A - D) / (1 + (x / C) ^ B) + D

Figure 5.47: Graph with 4-Parameter Fit
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Figure 5.48: Graph with Log-Logit Fit

Some publications show the log-logit equation in another form:

where

A different algebraic expression of these is:

The difference between the log-logit Þt and the 4-parameter Þt are in the way 
the coefÞcients A and D are calculated. For the log-logit method, the standard 
values for the lowest and highest values of x are used. The corresponding y 
values are assigned to A and D, respectively. Based on these Þxed values for A 
and D, the algorithm then computes values for B and C. This technique works 
well if there are standard points along the upper and lower asymptotes. If this 
is not true, the log-logit Þt should be avoided in favor of the 4-parameter 
logistic.

In SOFTmax PRO 2.x, the 4-parameter logistic curve Þt uses 2000 iterations. If 
the Þt does not converge in this number of iterations, the program will report 
a Þt error.

The curve-Þtting algorithm for the 4-parameter equation was based 
on the Levenberg-Marquardt Method. Discussion of this method can 
be found in Numerical Recipes in C: The Art of ScientiÞc Computing by 
William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. 
Vetterling, published by Cambridge University Press, New York, 
1988.
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If you are moving from SOFTmax PRO 1.x to 2.x, note that the num-
ber of iterations used to Þt the 4-parameter curve has been increased 
(to 2000). If no Þt is found, the software will reverse the A and D val-
ues and try again for up to 2000 additional iterations. If the Þt still 
does not converge, the software will report a ÒÞt error.Ó

Point-to-Point
A linear equation is Þt to each pair of data points. Fit parameters are not 
given. The point-to-point curve Þt is a linear Þt composed of pieces that 
assume a linear relationship between each pair of data points. The line seg-
ment deÞned by each pair is used to interpolate data between those points. 
Since there are multiple line segments, Þt parameters are not shown on the 
graph.

Figure 5.49: Graph with Point-to-Point Fit

NOTE:
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Cubic Spline
This curve Þt generates a Þt to a cubic equation between each pair of data 
points. The general form of a cubic equation is:

y = A + Bx + Cx2 + Dx3

The equations are computed with the requirement that the Þrst and second 
derivatives of the equations are continuous throughout the range of the data. 
As multiple curve Þts are performed with this routine, Þt parameters are not 
shown with the graph.

Figure 5.50: Graph with Cubic Spline Fit
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Exponential
The exponential function used to generate this curve Þt is:

y = A + B * (1 - exp^(-x / C))

Figure 5.51: Graph with Exponential Fit

SOFTmax PRO does not plot samples with descriptor values of zero 
(0) on a log axis. Curve Þts affected by this are the semi-log, log-log, 
log-logit, and 4-parameter curve Þts.

NOTE:
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Minimum Number of Standards
The number of standards used in a standard curve depends on the particular 
curve Þt selected and on the judgment of the operator. The table below gives 
the minimum number of standards required mathematically by each of the 
curve Þtting algorithms.

For optimal results, you should always exceed the minimum number of stan-
dards required for any given Þt.

There are other requirements on the standards for the log-logit and 4-parame-
ter logistic curves. The Þts for the 4-parameter logistic curve are based on the 
assumption that the curve has a high and a low asymptote and a certain 
ÒsteepnessÓ for the linear portion around the inßection point between the 
asymptotes. If a sufÞcient number of points do not deÞne the inßection point 
and the asymptotes, you will receive a Òno ÞtÓ error message or an inappro-
priate Þt. For best results, make sure that the 4-parameter Þt is appropriate for 
your assay and that the entire range of the assay is represented in your stan-
dards.

If your standards do not clearly deÞne both a high and low asymptote, the 
spline Þt may be more appropriate for your assay.

Judging a Good Curve Fit
The correlation coefÞcient is also known as the goodness of Þt value because 
it shows how good a Þt exists between the computer curve and the standard 
data points. It measures the degree to which the points fall on the computer 
curve and may give an indication as to what residuals are to be expected. The 
correlation coefÞcient is popularly known as R and is between -1 and 1, inclu-
sive. When the data points lie on a perfectly straight line with negative slope, 
then R = -1. If the correlation coefÞcient is not suitably close to 1 or -1 (a per-
fect Þt), you can simply apply one of the other types of curves without having 
to reread the plate or cuvette. 

For nonlinear curve Þts, SOFTmax PRO performs transformations that cause 
the curve to become more linear. The correlation coefÞcients are derived from 

Table 5.4: Minimum Number of Standards Required for Curve Fits

Curve Minimum Number of Standards

Linear 2

Quadratic 3

Semi-Log 2

Log-Log 2

Log-Logit 4

4-Parameter 4

Point-to-Point 2

Exponential 3

Cubic Spline 4
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that transformed data. Because of this, you should be cautious about using 
correlation coefÞcients as an indicator of goodness of Þt. Do not let this single 
value for goodness of Þt sway your intuition about which Þt is best. Some 
curve Þts may seemingly give a good Þt (e.g., Þt values close to 1) but, when 
inspected by eye, show a poor Þt along a major portion of the plot.

Graph Options   
Graphs can be customized further through the Graph Options dialog box 
which is accessed by choosing Graph Type... from the Graph menu or by click-
ing the Graph button ( )in the section tool bar.

Figure 5.52: Graph Options Dialog Box

The default options are shown in Figure 5.52, but you can alter these as 
desired: you may change the font and type size used for the title, legend, 
and/or axes of the graph, and you can choose the color and type of symbol 
used on a scatter graph to show the plot. The graphs shown in preceding Fig-
ures reßect the default graph options. Connecting the points of a scatter graph 
can be useful in determining the closeness of the Þt. Figure 5.53, below, shows 
a scatter graph with points connected compared to a linear Þt.

The Connect Points option connects the points in order of appear-
ance by sample nameÑnot the appearance of points from left to right 
on the graph.

NOTE:
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Figure 5.53: Scatter Graph with Points Connected (Linear Fit Applied)

Other options in this dialog box allow you to plot the data as a bar graph with 
data shown in clusters or stacked. Figure 5.54 shows both of these bar graph 
options.

Figure 5.54: Bar GraphsÑCluster and Stack

Bar graph options for multiple plot graphs are only available when 
each plot contains the same number of data points and has matching 
X-axis coordinates.

When choosing the Connect Points option, the order in which points 
are connected is sample name dependent.

X- and

Buttons

Graph Options Button

Y-Axis

Cluster Bar Graph

Stack Bar Graph

NOTE:

NOTE:
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Axes Options   
Double-clicking either graph axis, clicking the X-axis or Y-axis button in the 
Graph section toolbar, or selecting either X-axis... or Y-axis... from the Graph 
menu opens a dialog box concerning the conÞguration of that axis. Figure 
5.55 shows the dialog box for the X-axis.

Figure 5.55: X-Axis Dialog Box

The default settings are shown in the Figure above. You can change these as 
desired for either or both axes.

Axis Settings
Enabling the Auto-range option causes the graph to be drawn such that all 
data points are shown (by automatically adjusting the minimum and maxi-
mum range settings to encompass the data). You can disable the Auto-range 
function by clicking the checkbox or by changing either or both values for the 
Min and/or Max settings.

Formulas in SOFTmax PRO

You can enter custom calculations in several places within SOFTmax PRO to 
provide the information you desire:

¥ In Plate sections and Cuvette sets, you can specify formulas to be used for 
wavelength reduction, kinetic reduction, and spectral scan reduction.

¥ In the Group table sections, you can view and edit the formulas associated 
with the various columns or create new columns containing new formulas. 
The data shown in columns from one group can relate to or contain infor-
mation derived from columns in another group. You can also create sum-
maries which consist of formulas and text.

¥ Notes sections allow you to enter summaries which consist of formulas and 
related text.

Use of formulas in SOFTmax PRO is described in a separate manual, 
The SOFTmax PRO Formula Guide.
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File Creation and Management

During routine use of SOFTmax PRO, you will create, open, and save numer-
ous Þles. You may wish to create Þle folders that will make it easy to locate 
particular Þles. It is also important to understand the way in which SOFTmax 
PRO Þnds and uses default protocol Þles to enable certain assay options auto-
matically.

When you install SOFTmax PRO, certain Þles and folders/directories are cre-
ated on your computerÕs hard disk. One of these Þles is known as the 
ÒDefault ProtocolÓ (so named on the Macintosh; called ÒDEFAULT.PPRÓ in 
Windows). The Default Protocol Þle is automatically used as a ÒtemplateÓ for 
new Þles you create. You can, however, create one or more different Òtem-
plateÓ protocol Þles.

Default Protocol
When Þrst installed, SOFTmax PRO looks for the Default Protocol Þle in 
the same folder or subdirectory as the SOFTmax PRO program Þle. You can 
instruct SOFTmax PRO to look in a different location, however, through the 
Assays menu. Suppose, for example, that you create a folder/subdirectory 
called ÒMYASSAYSÓ and that you create a new protocol Þle (called ÒDefault 
ProtocolÓ or ÒDEFAULT.PPRÓ) within this folder. The Assays menu shows 
two sections: at the top, a command entitled Set Folder..., which allows you 
to choose the folder within which SOFTmax PRO will look to Þnd the Default 
Protocol Þle when creating a new experiment. At the bottom of this menu, 
beneath the dividing line, is a list of all protocol Þles contained in the cur-
rently chosen folder.

Figure 6.1: The Assays Menu

To have SOFTmax PRO look in a different folder for the Default Protocol Þle, 
choose Set Folder.... A dialog box will open, allowing you to locate and set a 
different default folder. Figure Figure 6.2 shows the dialog box that appears 
for the Macintosh and Figure Figure 6.3 shows the dialog box that appears for 
the Windows environment.

Figure 6.2: Set Folder Dialog BoxÑMacintosh
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Select the folder you wish to use and then click the large button at the bottom 
of the dialog box to set this folder as the default. The name shown in this but-
ton will change to reßect the name of the selected folder.

Molecular Devices recommends that you have only one default 
protocol.

Figure 6.3: Select Folder Dialog BoxÑWindows

Locate and highlight the folder you wish to use and then click the [Select] 
button at the right of the dialog box to set this folder as the default.

Opening Other Protocol Files
The bottom half of the Assays menu provides a ÒshortcutÓ for opening other 
protocol Þles contained in the set folder. These usually consist of protocols 
you or others create for repeated use. To choose a different protocol Þle, click 
the protocol Þle you wish to use. An untitled copy of that protocol Þle will 
open in a new window.

NOTE:
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Locating Protocol and Data Files
You may Þnd it useful to create separate folders/subdirectories within which 
to store the data Þles that SOFTmax PRO creates. In addition, you may want 
to create and save various protocol Þles for use as ÒtemplatesÓ for later read-
ings. In a multi-user environment, it might be helpful to create a folder/sub-
directory for each SOFTmax PRO user or to create separate 
folders/subdirectories for different types of experiments. We recommend that 
you consider the way in which you will organize your Þles before creating too 
many of themÑotherwise you may Þnd that locating a particular Þle among 
the many that Þll your hard disk difÞcult and/or time consuming.

Creating new folders on the Macintosh must be done outside of 
SOFTmax PRO (using commands in the Finder); creating new subdi-
rectories in Windows must be done outside of SOFTmax PRO (using 
the File Manager or Windows Explorer, for example).

Creating New Files
Selecting New (zN; CTRL+N) from the File menu causes a new, untitled Þle to 
open, creating a new window on the screen. The initial contents of this win-
dow are based on the default protocol Þle chosen in the Preferences dialog 
box.

You can create and/or open more than one SOFTmax PRO Þle at a 
time. Subsequently opened Þles will appear in separate windows in a 
cascading, diagonal order.

New Þles can be saved as protocol Þles at any time, either before or after data 
is acquired. To create a new protocol Þle, enter all the instrument settings for 
the reading and then choose Save or Save as... from the File menu. The dialog 
box that appears presents the option of saving a Þle as either a protocol or a 
data Þle (the default). On the Macintosh, click the option button next to ÒPro-
tocolÓ and enter a name for the Þle in the text box (type over ÒUntitledÓ). 
In Windows, choose the appropriate format from the list in the box under the 
heading, ÒSave File as Type:.Ó Also remember to choose the folder or subdi-
rectory in which to save this Þle. When you have entered all the information, 
click [Save] or [OK].

If you are creating a protocol Þle from a Þle containing data, Þrst 
save the Þle as a data Þle (if you wish to save the data) and then per-
form a second save as a protocol Þle. Data will not be saved with a 
protocol Þle.

Protocol Þles are stationery pad ÞlesÑwhen you choose to open a protocol 
Þle, you are actually presented with a copy of the Þle, which appears as an 
untitled Þle.

NOTE:

NOTE:

NOTE:
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Figure 6.4: Save as... Dialog BoxÑMacintosh

Figure 6.5: Save as... Dialog BoxÑWindows

Opening Files
You can open a SOFTmax PRO Þle by selecting Open... (zO; CTRL+O) from the 
File menu within SOFTmax PRO or by double-clicking on the Þle name or 
icon when you are in the Finder (Macintosh) or in the File Manager (Win-
dows). Note that you can open SOFTmax PRO Þles using either platform 
regardless of whether they were created using Macintosh or Windows (see 
ÒCross-Platform Files,Ó below, for more information).

Opening SOFTmax/SOFTmax PRO Files (Earlier Versions)
SOFTmax PRO allows you to open Þles from previous versions of SOFTmax 
PRO as well as from SOFTmax. From within SOFTmax PRO, select the Open 
(z O; CTRL+O) command from the File menu. The Þle will open and will func-
tion in the same way as a SOFTmax PRO Þle. If you wish, you can save the 
Þle in SOFTmax PRO format by selecting Save As... from the File menu. If you 
do not change the name of the Þle and save it to the same location, a message 
box will appear, asking whether or not you want to replace the existing SOFT-
max Þle with the new SOFTmax PRO version. If you do not, you can either 
choose a different location or rename the Þle.

File type
option buttons

Enter a name
for the new
Protocol file here

Choose the
location for the
new file here

Enter a name
for the new
Protocol file here

Choose the
location for the
new file here

File type choices
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While SOFTmax Þles can be opened using SOFTmax PRO, two 
items do not translate completely across the programs: sample blanks 
and auto range limits (in graph sections). The data for sample blanks 
obtained using SOFTmax will be available when these Þles are 
opened in SOFTmax PRO, but no calculations are performed auto-
matically using this data. Auto range limits are not available when 
SOFTmax Þles are opened using SOFTmax PRO, so limits for the dis-
play of information in graphs must be entered manually.

Cross-Platform Files
If you have SOFTmax or SOFTmax PRO Þles that were created on a platform 
other than the one you are currently using, you can transfer these Þles to your 
computer and use them, provided you have the required software and/or 
hardware to do so.

Transferring Macintosh Files to the PC
Third-party software is available for the Windows-compatible PC that allows 
the insertion and reading of Macintosh 3-1/2-inch disks. If you need to trans-
fer Þles between Macintosh and PC platforms and do not have such software 
for the Windows-compatible PC, you can use PC disks for both platforms 
since the Macintosh will be able to read them.

Macintosh computers are equipped with software that allows you to ÒreadÓ 
and transfer Þles from PC disks. If you are using System 7.5 or later, you will 
need to make sure that File Exchange is available in the Control Panels. The 
process of using File Exchange is described below.

1) If you have not yet enabled File Exchange on your Macintosh, select Control 
Panels from the Apple (ð) menu. From within the Control Panels, choose the 
Extensions Manager and turn File Exchange on by placing a checkmark next 
to it. Restart your computerÑFile Exchange will now be enabled.

2) Rename the Macintosh Þles you want to transfer to PC disks so that their 
names conform to the DOS Þle naming conventions: no more than eight char-
acters, no spaces, and a three-letter extension preceded by a period. Table 6.1, 
found later in this chapter, describes the three-letter extensions that are associ-
ated with data and protocol Þles from SOFTmax and SOFTmax PRO.

3) Insert an PC-formatted disk into the Macintosh ßoppy drive. It will appear as 
an icon on the Macintosh desktop.

4) Drag the renamed Þles onto the IBM disk icon to copy the Þles to the disk. 
Drag the disk to the trash to eject it.

Certain special characters will not translate accurately across plat-
forms. Characters that are created on the Macintosh using the option 
key, such as ¨, ©, ¡C, ª, or ¥ (bullet character) for example, will be 
shown on the PC as other letters or characters. Also, if you align items 
using spaces, these may or may not align when viewed on a different 
platform since fonts on the different platforms have different charac-
ter widths.

NOTE:

NOTE:
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Transferring PC Files to a Macintosh

Third-party software is available for the Windows-compatible PC that allows 
the insertion and reading of Macintosh 3-1/2-inch disks. If you need to trans-
fer Þles between Macintosh and PC platforms and do not have such software 
for the Windows-compatible PC, you can use PC disks for both platforms 
since the Macintosh will be able to read them.

Macintosh computers are equipped with software that allows you to ÒreadÓ 
and transfer Þles from PC disks. If you are using System 7.5 or later, you will 
need to make sure that File Exchange is available in the Control Panels.

1) If you have not yet enabled File Exchange on your Macintosh, select Control 
Panels from the Apple (ð) menu. From within the Control Panels, choose the 
Extensions Manager and turn File Exchange on by placing a checkmark next 
to it. Restart your computerÑFile Exchange will be enabled.

2) Choose File Exchange from the Control Panels. A dialog box like the one 
below will appear.

Figure 6.6: PC Exchange Dialog Box

3) In this dialog box, click [Add...]. This will cause a second dialog box to 
appear.



Chapter 6: File Management and Printing

SOFTmax PRO UserÕs Manual 6-9

Figure 6.7: Add Mapping Dialog Box

4) In order to allow the Macintosh to automatically recognize protocol and data 
Þles of PC origin as SOFTmax PRO Þles, you need to enter the associated 
three-letter extensions that correspond to these Þles in the File Exchange Add 
Mapping dialog box. The table below lists the type of Þle and its correspond-
ing extension that should be entered in the dialog box.

For example, if you will be working with SOFTmax PRO protocol Þles created 
on the PC, enter .PPR in the box under “Extension . [_____]”

5) Then click the application icon (currently shown as ÒFile Type ???Ó in the cen-
ter of the box under ÒApplication Program.Ó From the menu choices, navigate 
to the folder where the SOFTmax PRO application resides. Highlighting this 
application will enable the Macintosh to start SOFTmax PRO and read the 
corresponding protocol Þle whenever you double-click a PC Þle bearing the 
Ò.PPRÓ extension. Also select the appropriate Macintosh document type 
(shown in the table above). Clicking [OK] causes this dialog box to close and 
updates the earlier dialog box to show the extension and associated program 
you just entered.

6) Repeat steps 3 through 5 for other PC Þle name extensions with which you 
will be working.

Table 6.1: PC File Name Extensions and Macintosh Document Types 
for Use with File Exchange

Type of File
3-Letter 

Extension
Macintosh 

Document Type

SOFTmax PRO Protocol File .PPR sPFd

SOFTmax PRO Data File .PDA SPFd

SOFTmax Protocol File .PRO sPFd

SOFTmax Data File .DAT SPFd
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Saving Files Manually
SOFTmax PRO provides several ways to save Þles manually. If the current Þle 
has not been saved (is ÒUntitledÓ), it can be saved under any name. If you 
have opened and modiÞed an existing Þle, you can save it under the same 
name (overwriting the old information) or under a different name. You can 
also save the Þle in the same or in a different location on your hard disk (in a 
different folder or subdirectory).

Saving Files under the Same Name
If you have made changes to a Þle and want to save these changes, thereby 
updating the same Þle, select Save (zS; CTRL+S) or Save As... from the File 
menu. If you select Save (zS; CTRL+S), the current version of the Þle will 
replace the old one (without notiÞcation). If you select Save As..., an alert box 
will appear, asking if you want to replace the previous Þle by that name. If 
you are intentionally replacing the Þle, click [Replace] or [Yes]. The new 
information will be written over the old information under the same Þle 
name.

Saving Files under a Different Name or in a Different Folder
If you have made changes to a Þle and want to save these changes as a new 
Þle, or if you wish to save the Þle to a different location, select Save As... from 
the File menu. A dialog box will open allowing you to enter a new name 
and/or a new location for the Þle. To choose a different location for the Þle, 
use the pull-down menu at the top of the dialog box to select a different 
folder. To change the name, overtype the existing Þle name. Click [OK] when 
you have entered all the necessary information and you are ready to save the 
Þle.
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Autosave
SOFTmax PRO can be conÞgured to save a copy of your data Þle automati-
cally (Autosave) after a reading. This function is enabled in the Preferences 
dialog box (choose Preferences... from the Edit menu).

Figure 6.8: Preferences Dialog Box

When you enable the Autosave function (by clicking its checkbox in the Pref-
erences dialog box), the textbox below it becomes active, allowing you to 
accept or change the default location for saving data Þles. The default location 
is the folder containing the SOFTmax PRO program. You may accept the 
default Þle preÞx or change it to another preÞx of your choice. For example, 
you may wish to use a preÞx that is speciÞc for a certain group of experiments 
or one of several users. You may also choose the Þle type for the Autosaved 
Þle (SOFTmax PRO Þle or ASCII text Þle), choose to append the date to the 
autosaved Þle name, and, if you select the Text Þle option, you can then 
choose either the ÒCreate a new ÞleÓ or ÒAppend to ÞleÓ option.

When Autosave is enabled in SOFTmax PRO Þle mode within Þles 
containing multiple experiment sections, each experiment section 
will be autosaved to a separate Þle.

If you are using SOFTmax PRO with ROBOmax, you must deselect 
the Autosave and Autoprint functions. ROBOmax software automati-
cally saves the SOFTmax PRO data Þle after the plate is read.

NOTE:

NOTE:
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Printing

Five printing options are available for an experiment:

1) You can print a report at any time by choosing Print... (z P; CTRL+P) 
from the File menu. You can determine which sections (or whether all 
sections) will be printed in this report (see ÒThe Printed Report,Ó below).

2) A copy of the template can be printed while you are in the Template Ed-
itor by clicking the [Print] button in the bottom left corner.

3) A report can be printed automatically at the end of a reading. To enable 
this function, choose Preferences... from the Edit menu and select ÒAu-
toprint.Ó

4) You can print the active section or selection. This option is available 
within the File menu. If only one section is selected, the name shown in 
the menu will reflect the name of the active section. For example, if the 
active section is named ÒPlate #1,Ó the topmost print command in the 
File menu would be Print ÔPlate #1Õ.... If more than one section is select-
ed, the menu will show Print Selection. You can select multiple sections 
to be printed by holding down the Shift key and clicking on the section 
tool bars to make them active.

5) Enlarged displays (well graphs) of kinetic or spectrum data can be print-
ed by clicking the [Print] button in the Well Graph window. The size of 
the printout is dependent on the size of the well graph.

If you enlarge the well graph to greater than 12 inches, the printout 
will be truncated.

Regardless of which print option you select, make sure the printer is con-
nected properly to the computer and that it is turned on prior to sending the 
print request.

If Autoprint is enabled, make sure the printer is connected and that it is 
turned on prior to starting a reading.

If you are using a Macintosh, you can check the Chooser for the currently 
selected (connected) printer.

If you are using Windows, you can select a printer by choosing Print Setup 
from the File menu. In the Print Setup dialog box, choose the default printer 
or select from any other printers have been conÞgured for use with Windows. 
See your Windows documentation for further information.

NOTE:
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The Printed Report
You can create customized reports by including or excluding experiments and 
individual sections, changing the order in which sections will print, and add-
ing text describing each experiment in Notes sections. You can also create 
summaries (consisting of reduction formulas and associated text) in Notes 
and Group sections. The size and content of Group sections can also be 
changed.

Including or Excluding Sections
When sections are created, they default to being included in the printed 
report. You can exclude sections from printing by clicking the print setting 
button on the tool bar of that section (it is a toggle, so it will change from 
enabled  to disabled   or vice versa).

Changing the print setting option for the experiment will change the state of 
all sections within that experiment. Changing the print setting option for one 
or more sections within an experiment will cause the print setting button for 
the experiment to change to reßect an ÒundecidedÓ status with regard to the 
sections within it (  ). Toggling the experimentÕs print setting button will 
override any changes made to individual sections and set all of them to print-
ing.

When Print is chosen from the File menu, selecting Print All will override the 
print settings made to sections or experiments.

Customizing the Report
In addition to choosing which sections will print in the report by toggling 
their print status, you can choose to print all items in a Þle or to print only the 
report from the Print dialog box that appears when you choose Print from the 
File menu. 

Figure 6.9: Print Dialog Box

Other options regarding the appearance of the printed report can be chosen in 
this dialog box: you can add text to be included in the header on every page 
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of the report (maximum of 100 characters in a single row), and you can 
include or exclude the experiment title (the name of the experiment in the Þle) 
as well as the name(s) of sections, and you can include the date and time of 
printing, as well as add page numbers to the report which are printed at the 
bottom right corner of each page. These are all enabled, by default, until you 
disable them by clicking in the box with the checkmark next to each option 
(which will deselect that option).

If a Notes section is longer than can be printed on one page, a line 
may be cut off (not printed) at the bottom of the Þrst page. To Þx this 
problem, insert a carriage return in the appropriate place (above the 
page break) in the Notes section and print again.

Changing the Section Order
When sections are created (either automatically by SOFTmax PRO or by you), 
their order may not be optimal for either viewing or printing. The order of 
sections in the window determines how they will print in the report, and you 
may Þnd that changing the order of sections makes it easier to view the data.

When you create a new section, it is positioned directly after the currently 
active section. To change the order of a section, Þrst make it active by clicking 
on it, then click in its tool bar and drag it to a new position (on top of the sec-
tion you want it to precede). Sections may be open or closed during this pro-
cedure.

Figure 6.10: Moving a Section Upward

NOTE:

Click in the
tool bar of the
active section

and drag upward
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Changing the Text Format
The text in Notes and Group sections can be formatted to change its appear-
ance. The Format Text dialog box, accessible by choosing Text Style... (zT; 
CTRL+T) from the Edit menu, provides a number of different options (see 
Figure 6.11).

Figure 6.11: Format Text Dialog Box (Macintosh)

First highlight the text you wish to format. Then choose Text Style... 
(zT; CTRL+T) and select the options you wish to apply to the selected text. You 
can click on the [Apply] button to see the result of the selections you have 
made, allowing you to select more or different options before Þnally setting 
the options by clicking on [OK].

The Print Dialog Box
Choosing any of the Print... commands brings up a dialog box. The contents 
of this box will vary depending upon the type of printer you have selected or 
the particular printing option you have chosen, but the basic elements are the 
same. The dialog boxes shown below represent those displayed when you 
choose the Print... command from the Macintosh and from Windows.

Figure 6.12: Print Dialog Box for the Macintosh

You can choose to print all of the sections, regardless of whether they are 
included in the report, by clicking the option button next to ÒPrint allÓ at the 
bottom left of the Print dialog box.

Macintosh
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Figure 6.13: Print Dialog Box for Windows (Epson Stylus 800 Shown)

If more than one printer is available to your computer, make sure 
you select the desired printer prior to selecting one of the Print 
options in the File menu. If you start to print and discover the wrong 
printer is selected, choose [Cancel] to exit from the Print dialog box. 
Select the correct printer (using the Chooser for the Macintosh or the 
Print Setup dialog box for Windows) and then repeat the print pro-
cess.

Additional information regarding the general print functions available in 
these dialog boxes can be found in the documentation that accompanies your 
computer and/or printer.

NOTE:
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Exporting/ Importing Information

Exporting Data
The Export... command (a sub-menu of Import/Export located in the File 
menu) creates a Þle of data from one or more Plate sections, CuvetteSet sec-
tions, and/or Group table sections within a SOFTmax PRO Þle. The type of 
data that is exported depends upon three things:

1) Selections made in the Preferences dialog box regarding the export format. 
Choose Preferences from the Edit menu. Within the Preferences dialog box 
that appears, select the format for data export that you prefer: for Plate sec-
tions, you can choose either time-based, which produces a linear format for 
the data, or plate-based, which exports data in a matrix format corresponding 
to a microplate grid; CuvetteSet sections are automatically exported as time-
based data. You also must choose whether or not to include labels with the 
exported data.1 Click [OK] to close the dialog box.

Figure 6.14: Choosing an Export Format from the Preferences Dialog Box

The preference settings chosen above also affect the copying and 
pasting of data and Autosaving to ASCII text.

2) Display options chosen for the Plate section or CuvetteSet section.
Whether raw or reduced data will be exported depends upon the display 
options. If raw data is displayed, raw data will be exported; if reduced data is 
displayed, this reduced data will be exported.
Open the Plate section or CuvetteSet section from which you will be export-
ing data. Click the [Display] button in the tool bar of the Plate section or 
CuvetteSet section to access the Display dialog box. Choose the elements of 
the display settings that match the data you would like to export: raw or 
reduced data, with or without number, and so on. When Þnished selecting 
display preferences, click [OK] to close the dialog box.

1. Including labels will affect all data exported, but doing so is most noticeable with Group section data, since 
the column headings in the Group table will be shown, as will any other calculated data in summaries, etc. 
Labels included with Plate and CuvetteSet sections show Ò1-12Ó headers for 96-well Plate section data rep-
resented as an 8 x 12 matrix; 384-well plate data will show Ò1-24Ó headers; CuvetteSet section labels show 
ÒA1,Ó ÒA2,Ó etc., representing the same number of cuvettes shown in the CuvetteSet section.

Export
Format

Selection

NOTE:
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Figure 6.15: Display Dialog Box

When exporting data as tab-delimited ASCII text, all reduced dis-
plays will be exported as numbers, regardless of how the data is 
shown in SOFTmax PRO. Choosing Grayscale, Ranged, or Threshold 
will export the same information as the reduced number display. 
Choosing Òwith numberÓ will also not affect the exported data, since 
only the raw number is exported when raw numbers are displayed 
and only the reduced number will be exported when reduced data is 
displayed.

3) Choices made in the Export dialog box.
After choosing Export... from the File menu, a dialog box will appear, asking 
you to choose which sections you wish to export. You can choose to export 
Plate and CuvetteSet sections (all or selected) and/or Group sections (all or 
selected). After choosing a name for the exported data Þle, click [OK] to save 
the exported data.

Figure 6.16: Export Dialog BoxÑWindows and Macintosh

Exported tab-delimited ASCII data Þles have a minimum of Þve lines and, in 
most cases, will be considerably longer. An example of an exported tab-delim-
ited Þle containing Endpoint data collected from a SPECTRAmax 250 follows. 
The reading was done at a single wavelength, displayed as raw data in a 
microplate format with labels:

NOTE:
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##BLOCKS= 1          

Plate:  Plate#1  1  PlateFormat  Endpoint  Absorbance  Raw  FALSE  1  300  9  350  750  10  1  405  1  12  96 

 20.80 0.1 0.11052 0.12214 0.13499 0.14918 0.16487 0.18221 0.20138 0.22255 0.24596 0.27183 0.30042

0.12214 0.13499 0.14918 0.16487 0.18221 0.20138 0.22255 0.24596 0.27183 0.30042 0.33201 0.36693

0.14918 0.16487 0.18221 0.20138 0.22255 0.24596 0.27183 0.30042 0.33201 0.36693 0.40552 0.44817

0.18221 0.20138 0.22255 0.24596 0.27183 0.30042 0.33201 0.36693 0.40552 0.44817 0.4953 0.54739

0.22255 0.24596 0.27183 0.30042 0.33201 0.36693 0.40552 0.44817 0.4953 0.54739 0.60496 0.66859

0.27183 0.30042 0.33201 0.36693 0.40552 0.44817 0.4953 0.54739 0.60496 0.66859 0.73891 0.81662

0.33201 0.36693 0.40552 0.44817 0.4953 0.54739 0.60496 0.66859 0.73891 0.81662 0.9025 0.99742

0.40552 0.44817 0.4953 0.54739 0.60496 0.66859 0.73891 0.81662 0.9025 0.99742 1.10232 1.21825

~End 

An example of an exported Þle containing Group table data is shown below:

The Þrst line of an exported ASCII data Þle includes one Þeld indicating the 
number of data sets in the Þle. This single Þeld includes the text 
"##BLOCKS=" followed by a number that equals the number of data sets.

The second line of a Þle for a Plate or CuvetteSet section includes 19 Þelds 
that provide all of the information needed to determine the type of test that 
was run to measure the Þrst data set. The table following describes each of 
these Þelds.
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The information for the Þrst plate or cuvette section is provided in the lines 
following the descriptors. The number of lines of data depend on the export 
format and the type of test that was run. A minimum of one line of data is 
exported when the Time format is used with a single wavelength endpoint 
read.

Table 6.2: ASCII Data File Fields and Descriptors

Field Field Entry Description

1 Section kind Either Plate: or Cuvette:

2 Section name DeÞned in Section dialog

3 Export version Always 1 in SOFTmax PRO 2.x (2 if there are headers)

4 Export format PlateFormat or TimeFormat, set in Preferences

5 Read mode Endpoint, Kinetic, spectrum, or well scan

6 Data mode For absorbance plates: Absorbance or %Transmittance
For others: Fluorescence, Luminescence, or Time-Resolved Fluorescence

7 Data type Raw or Reduced

8 Pre-read included TRUE or FALSE; always FALSE for Cuvettes

9 Kinetic points Reduced plates and endpoint plates = 1
Kinetic/spectrum plates: number of reads

10 Kinetic read time Kinetic read time in seconds or well scan read pattern (horizontal, vertical, X, or 
Þll); otherwise blank Þeld

11 Kinetic interval Kinetic read interval in seconds or well scan density; otherwise blank Þeld

12 Start wavelength Spectrum start wavelength; otherwise blank Þeld

13 End wavelength Spectrum end wavelength; otherwise blank Þeld

14 Wavelength step Spectrum wavelength step; otherwise blank Þeld

15 # of wavelengths # of wavelengths in endpoint, kinetic, well scan reads; for spectrum: blank Þeld

16 Read wavelengths For absorbance/luminescence: wavelengths read, separated by a space; for 
spectrum: blank Þeld; for ßuorescence: emission wavelengths; for Ex/Em 
sweep: blank Þeld

17 First column read First column read (1 to max), always 1 for cuvettes

18 Number of columns Last column read (1 to max), always 12 for cuvettes

19 Number of wells or 
cuvettes

Number of wells in a plate (24, 96, 384, etc.) or number of cuvettes read for a 
CuvetteSet

After Field 19, the format splits, depending on the read type. Fields 20-28 are not present for absorbance or 
transmittance but are included for ßuorescence and/or luminescence.

20 Excitation wave-
lengths

Excitation wavelengths, separated by spaces
For luminescence or sweeps, this is a blank Þeld (the emSweep excitation 
wavelength is in Þeld 16)

21 Cutoff option Manual or Automatic

22 Cutoff Þlters Cutoff Þlter wavelength values, separated by spaces

23 Sweep wave option EmSweep or ExSweep or blank Þeld

24 Sweep Þxed wave The value for the Þxed (em or ex) wavelength

25 Reads per well Number of times a well is read for a single reading

26 PMT setting Automatic, High, Medium, or Low

27 Start integration time Time to start integration for time-resolved ßuorescence; otherwise, blank Þeld

28 End integration time Time to end integration for time-resolved ßuorescence; otherwise, blank Þeld
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If the instrument you are using has a temperature associated with 
the data (all MAXline instruments except Emax, Vmax, and UVmax), 
the temperature at the time of the reading will appear before the Þrst 
data point in the reading.

The second line of a Þle for a Group table section includes Þelds that corre-
spond to the number and types of columns found in that section (they are 
labeled as the table is labeled and look very much like the table itself.

Following the data, a blank line is included and then a line with a single ter-
mination Þeld: ~End.

Each subsequent data set in the Þle includes the lines described above, a 
blank line, and a line with the termination Þeld.

Importing Data from Outside of SOFTmax PRO
SOFTmax PRO imports data in tab-delimited ASCII text format, allowing you 
to import data collected by a non-Molecular Devices instrument into SOFT-
max PRO. Note that only plate and cuvette data can be imported.

Selecting Import... from the Import/Export menu under File causes the 
Import dialog box to appear.

Figure 6.17: Import Dialog Box

Choose the Þle you wish to import and click the [Import] button. Note that data 
to be imported must contain the appropriate header information. A new experiment is 
created in the open SOFTmax PRO Þle for the imported data. New Plate sec-
tions and/or CuvetteSet sections are created for each data set within the Þle. 
Plate pre-read and CuvetteSet reference data can also be imported, but data for 
pathlength correction cannot. Note that the time/date stamp for a section con-
taining imported data shows Òimported dataÓ rather than a date or time.

Importing and Exporting Templates
Template information, saved as an ASCII text Þle, can be exported from Plate 
and/or CuvetteSet sections and can also be imported into such sections. A 
template Þle consists of seven columns of data that is separated by tabs. Each 
line of the Þle provides information for one well in a plate or one cuvette.

When template information is exported, the information for well/cuvette A1 
is written into the Þrst line of the Þle, information for well/cuvette A2 is writ-
ten to the second line of the Þle, and so on, until a line has been created in the 
export Þle for each well in a plate or all cuvettes. If no template information 

NOTE:
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exists for a well in a plate or for a cuvette, that line is left blank. The ASCII Þle 
terminates with the string Ò~EndÓ.

The order for importing template information must match the export order. 
Similarly, blank lines in the Þle are assigned to a well or cuvette, providing a 
well/cuvette with no template setting.

Table 6.3 describes the data that is included in each column of the ASCII tem-
plate Þle.

Exporting Graphs
Graphs from Graph sections and Well Graphs can be exported in PICT format 
(Macintosh) and EMF format (Enhanced MetaFile in Windows). Graph sec-
tions can be exported by choosing Export Graph from the Graph menu. Well 
Graphs can be exported by choosing Export Graph from the Plots menu that 
appears when a Well Graph is opened.

Table 6.3: ASCII Template File Columns and Descriptions

Column Column Entry Description

1 Group name Assigned in the Group Settings dialog box. If this Þeld is missing, the rest of the 
line is ignored. Any text string can be entered in this Þeld.

2 Column format Assigned in the Group Settings dialog box. Five text strings are supported in 
SOFTmax PRO 3.0: Empty, Basic, Standards, Unknowns, and Unknowns[Dilution]. 
Blank groups have an Empty column format. If this Þeld is empty, the Basic col-
umn format is assigned.

3 Sample name The sample name is set in the ÒSample:Ó Þeld of the Template Editor dialog box. If 
this Þeld is left blank, no sample name will be assigned to the well, although the 
sample name will be included in the group.

4 Number of 
descriptors

0 for Empty and Unknown column formats; 1 for other column formats.

5 Descriptor units Assigned in the Group Settings dialog box. Supported strings are unit/ml, mg/ml, 
ug/ml, ng/ml, mg, ng, and ml. If this column is left blank, unit/ml is assigned.

6 Sample
descriptor

Assigned in the Group Settings dialog box. Any text string can be entered in this 
Þeld or it may be left blank.

7 Descriptor value Assigned in the Series dialog box. Can be set to any number or left blank.
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Copying and Pasting
Parts of an experiment can be copied within a SOFTmax PRO Þle, to or from 
another SOFTmax PRO Þle, or to or from another program using the Copy 
and Paste commands. Plate section and CuvetteSet section data, and text and 
summaries in Notes sections can be copied and pasted to other sections 
within the same or a different experiment within SOFTmax PRO or to other 
programs. Virtually any ASCII-formatted text can be copied and pasted into a 
Notes section. A graph can be copied and the resulting picture pasted into 
another application. Template information can be copied and pasted from one 
part of a template to another (within the same or to different templates and 
from one experiment to another).

Plate Section and CuvetteSet Section Data and Templates

Copying and Pasting 
within SOFTmax PRO

Data can be copied from one Plate section to another or from one CuvetteSet 
section to another within SOFTmax PRO. Make the source section active by 
clicking on it and then choose Copy (zC; CTRL+C) from the Edit menu. Create a 
new section, if necessary, and make the destination section active. Choose 
Paste (zV; CTRL+V) from the Edit menu to paste the data into this section.

When copying Plate sections, all well data is copied. It is not possi-
ble to copy and paste the data from only certain wells. Even if you 
select only one well prior to choosing the Copy (zC; CTRL+C) com-
mand, all plate data will be copied and pasting will replace all data in 
the destination plate (PathCheck data is not copied). It is possible, 
however, to copy individual cuvettes or groups of cuvettes and paste 
these into other CuvetteSet sections.

If the Instrument Settings of the target section do not match the settings from 
the section being copied, the Instrument Settings for the target section will be 
updated appropriately to match.

Templates can also be copied from one Plate section to another or from one 
CuvetteSet section to another within SOFTmax PRO. However, the effects of 
this action depend on whether you are pasting the template to another section 
in the same experiment from which it was copied or to a section in a different 
experiment. Pasting a template to a section in the same experiment from 
which it was copied is useful for cross-plate analyses since corresponding 
wells in each plate will be assigned to the same group and sample.

Pasting a template to a section in a different experiment will create new 
groups in that experiment if those groups have not previously been created in 
that experiment. If you are pasting templates between experiments, and 
groups from the source template do not exist in the destination experiment, 
pasting a template will create them. Existing groups of the same name will 
not be changed by the pasting process. For example, if the template being 
copied contains the groups ÒStandardÓ and ÒUnknown,Ó and the group 
ÒStandardÓ already exists in the destination experiment, the group 
ÒUnknownÓ will be created but all information regarding the group ÒStan-
dardÓ in the destination experiment will remain unchanged.

Experiments deÞne a naming scope for the sections within them, which is 
especially important for Group sections: it allows you to have identical 
groups (name and column format) within two or more different experiments 
in the same Þle. Having multiple experiments in the same Þle also provides 

NOTE:
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you with quick access to different types of information without having to 
open or refer to multiple Þles.

If you are copying cuvette data and the target CuvetteSet section does not 
contain the appropriate cuvettes for the data that is to be pasted, new cuvettes 
will be created automatically. Please note that pasting cuvette data for only 
some cuvettes will clear the existing data from all other cuvettes in that sec-
tion. For example, if cuvettes A2, A4, and A6 are copied from CuvetteSet#1 
and you attempt to paste this data into CuvetteSet#2 which contains cuvettes 
A1 through A12, the data in all twelve cuvettes will be cleared and then 
cuvettes A2, A4, and A6 will receive the pasted data. An alert box will ask 
whether or not you wish to replace all the data before proceeding.

Copying from Other 
Programs

Plate section data, CuvetteSet section data, and Notes section text can be copied 
from programs other than SOFTmax PRO and pasted into a Plate section, 
CuvetteSet section, or Notes section. For Plate section data, the format of the 
copied information must match the Instrument Settings of the target Plate sec-
tion and the settings chosen in the Export Format in the Preferences. Pre-read 
data cannot be pasted into a Plate section. If there is a mismatch between the 
data to be pasted and the target section, SOFTmax PRO will attempt to paste the 
data, but if it cannot do so, an error message will result (an example of such an 
error message for a Plate section is shown in Figure 6.18). After data is pasted 
into a Plate section, the information to the right of the display will show 
Òimported data.Ó

Figure 6.18: Error Message Generated When Pasting Mismatched Data

If you have created a template for a Plate section prior to pasting 
data, numbers will be shown only in the group(s) you have created in 
the template. Data in other wells will not be reported (but will be 
available if you alter the template). Clearing the template or assign-
ing groups to all wells in the plate will show the complete data set.
Templates for CuvetteSet sections do not change the way the data is 
shown in the display (all cuvettes will show data, regardless of whether 
or not the template has only certain cuvettes assigned to groups.

Copying to 
Other Programs

Plate section, CuvetteSet section, Group table section, and Notes section data 
can be copied from SOFTmax PRO and pasted into another program that will 
accept the data (such as a spreadsheet or word processing program). No copy 
or paste features are available for Graph sections or Well Graphs, but these 
graphs can be exported as either PICT or EMF Þles (see ÒExporting GraphsÓ 
on page 6-22 for more information).

NOTE:
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Group Columns
You can copy a Group column and paste it within another Group in the same 
experiment or into a Group of another experiment. The data included in the 
pasted columns will be appropriate for the target group.

Highlight the column, select Copy (zC; CTRL+C) from the Edit menu; then acti-
vate the section into which you want to paste the column and select Paste 
(zV; CTRL+V) from the Edit menu. If you highlight a column in the destination 
section, the column you are pasting will appear to the right of the highlighted 
column. Otherwise it will be appended to the right of all existing columns.

Columns and summaries in Group sections can also be copied and pasted to 
other programs. Data from other programs cannot be pasted into Group sec-
tions within SOFTmax PRO, however.

Copying Formulas and Summaries
Formulas are used in Group columns, custom reductions, and summaries. 
Sometimes it is useful to copy an existing formula, column, or summary from 
one area of the program to another, or from one experiment to another, rather 
than taking time to recreate it. Summaries can also be copied and pasted within 
SOFTmax PRO. After pasting, both formulas and summaries can be edited.

Contiguous column formulas may be copied and pasted together. 
Summaries must be copied and pasted individually.

To copy a formula or summary, highlight it and then select Copy (zC; CTRL+C) 
from the Edit menu. Activate the area or section in which you would like to 
paste it; if necessary, with a formula, access the particular dialog box into which 
it will be pasted. After placing the cursor in the correct location and highlighting 
any existing information to overwrite it, select Paste (zV; CTRL+V) from the Edit 
menu. The pasted formula or summary will appear in the new location.

Formulas and summaries can be deleted by highlighting them and pressing 
the Delete key or choosing Cut from the Edit menu.

Duplicate and New
Duplicate All sections and even complete experiments can be duplicated by making the 

section or experiment active and then selecting Duplicate from the Edit menu. 
All of the information in the section or experiment (including data) is copied to 
the newly created section or experiment. The name of the new section or experi-
ment is the same as that of the original with the addition of the word ÒCopyÓ 
(e.g., ÒOldName CopyÓ). Duplicated sections are created at the end of the exper-
iment. Duplicated experiments are created beneath the other experiments.

Duplicating a Cuvette section creates a copy of the previous Cuvette section, 
including the last reference that was read.

Group section tables can also be duplicated. When a Group table is dupli-
cated, its name is added to the Template EditorÕs list of group names (but the 
group is not assigned to any wells).

Graph sections that are duplicated include all settings for plots, Þt, etc.

Notes sections are duplicated exactly, including any summaries and all text.

New New sections and new experiments can be created by selecting New from the 
Section or Experiment menu. If an existing section or experiment is active 
when this command is chosen, all of the information in the section or experi-

NOTE:
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ment (except data) is copied to the newly created section or experiment. The 
name of the new section or experiment is the same as that of the original with 
the addition of an incrementing number (e.g., ÒOldName#2Ó). A new section 
is created immediately below the active section. A new experiment is created 
immediately below the active experiment.

Creating a new Cuvette section creates a copy of the previous Cuvette section, 
including the template, if any, but this section contains no data.

New Group section tables can also be created but are devoid of any data.

New Graph sections include all settings for plots, Þt, etc., but contain no data.

New Notes sections are exact copies of the active Notes section, including any 
summaries and all text (same as duplicated Notes sections except for the 
name).

Table 6.4: New vs. Duplicate within an Experiment

New Duplicate

Notes 
Section

Empty Notes section. Replicates text and summaries from source 
Notes section.

Plate 
Section

Replicates Instrument Setup, Reduction, 
and Display parameters from last Plate 
section created (if no Plate section exists, 
default values are used).

Replicates Instrument Setup, Reduction, and 
Display parameters from last Plate section cre-
ated.

Cuvette-
Set Sec-
tion

Replicates Instrument Setup, Reduction, 
and Display parameters from last Cuvette-
Set section created (if no CuvetteSet sec-
tion exists, default values are used).

Replicates Instrument Setup, Reduction, and 
Display parameters from last CuvetteSet sec-
tion created. Also copies the last reference that 
was read and the number of cuvettes deÞned 
from the source CuvetteSet section.

Graph 
Section

Creates a new Graph section with default 
settings and asks for plot information.

Replicates all Graph settings, including any 
plots that were deÞned in the source Graph 
section.

Group 
Section

Not available Creates a replicate of the source Group section 
table. The new group will be in the template 
Group drop-down menu but no wells will be 
assigned to this group.
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Password Protection

Individual protocol and/or data Þles can be protected by adding a password 
to them. When a protocol Þle is password protected, you may read data into 
the Þle but you may not change the Þle in any other way. When a data Þle is 
password protected, you may view the Þle but are unable to change it. The 
correct password must be entered to make changes to the Þles.

The table below shows the various actions that are protected when a pass-
word is assigned to a SOFTmax PRO Þle.

Table 6.5: Actions Protected by Password

Menus
Tool Bar 
Buttons

Dialog Boxes Others

File>Page Setup Read* Summary Moving a formula in a Notes 
section

File>Import Ref.* Instrument Setup Resizing columns in a Group

File>Save As... Template Editor Moving sections and experi-
ments

Edit>Undo Reduction Typing in sections (Notes, Plate, 
and CuvetteSet)

Edit>Cut Display

Edit>Paste Mask Well

Edit>Clear New Column

Edit>Delete Section Edit Formula

Edit>Duplicate Section Plots

Edit>New Experiment Graph Options

Edit>New Section X-Axis/Y-Axis

Edit>Text Style All Section Settings

Control>Instrument Setup

Notes (all items)

Plate (all items)

Group (all items)

Graph (all items)

Cuvette (all items)

* Only if data exists in the section.
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Setting and Changing a Password
Choosing Set Password... from the File menu causes the Password dialog to 
appear. If the active document is already password protected, the menu com-
mand changes to Change Password... .

Figure 6.19: Set Password Dialog Box. Left, no password set previously; right, with 
previously set password.

This dialog appears differently depending upon whether or not you are set-
ting a password for the Þrst time or if you are changing/removing an existing 
password. If you have not previously set a password, the dialog box will 
appear like that on the left of Figure 6.19. To set a password, type it in both 
boxes (Þrst to set it and then to conÞrm it). After password protection is 
enabled, a ÒlockedÓ icon will appear on the right side of the status bar (       ).

When changing or removing a password, the dialog box will appear as shown 
on the right of Figure 6.19. Before you can change or remove the password, you 
are required to enter the old password in the top text box. After entering the old 
password, checking the box next to ÒRemove PasswordÓ and typing nothing in 
the rest of the boxes will clear the password from the Þle when you click [OK].

As with all password protection, be sure to choose a password that you will 
be able to remember, since the Þle will be locked to changes of nearly any kind 
should you forget it. If you try to perform an unauthorized action on a pro-
tected Þle, a dialog box will appear asking you to enter the password.

Figure 6.20: Password Required Dialog Box

When this dialog box appears, you must enter the password in order to con-
tinue with the action you have chosen. 

If you do not remove password protection prior to trying to change the Þle, 
every attempt to change the Þle will result in this dialog box appearing. This 
repeat prompting can be stopped by enabling the Suspend Password option 
(click the box to check it).

SOFTmax PRO provides no hidden commands that will 
override password protection. If you are concerned that you might 
forget your password, write it down and store it in a safe place for 
future reference.

! CAUTION:
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Introduction

The Òhands-onÓ written tutorial included in this chapter is designed to take 
you through the basic features of the SOFTmax PRO program. A SOFTmax 
PRO Þle (endtut.pda) will also be used (how to open and use this Þle is 
described in the tutorial steps).

If you are new to SOFTmax PRO, we suggest that you read and follow the 
steps in this Òhands-onÓ tutorial before using SOFTmax PRO for the Þrst time. 
Going through this tutorial will help you learn to use the basic features of 
SOFTmax PRO quickly. To learn more about SOFTmax PRO, you will want to 
read through Chapter 3, "SOFTmax PRO Overview,"Ó and Chapter 4, ÒRead-
ing Microplates and Cuvettes,Ó as well as reading the introduction to the 
Formula Reference Guide.

If you have not yet installed SOFTmax PRO, refer to Chapter 2, 
ÒInstallation,Ó and follow the steps listed there to install the software 
before proceeding with this tutorial.

NOTE:
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Quantitative Endpoint Assay Tutorial

This tutorial section will lead you through the steps required to create and 
run a quantitative assay utilizing a standard curve. It will be especially bene-
Þcial for users who are new to SOFTmax PRO.

Hard and Soft Parameters
The only settings that must be deÞned before reading a microplate are the 
instrument settings (found in the Instrument Setup dialog box). These set-
tings tell the instrument what conditions should be in place in order to collect 
data. They include the read mode (endpoint, kinetic, spectrum, or well scan), 
the number of wavelengths, speciÞc wavelength settings, and so on. These 
settings, called ÒhardÓ parameters, deÞne the conditions under which the 
data is obtained. Once a microplate has been read, the instrument settings 
cannot be changed without deleting the data.

ÒSoftÓ parameters include the template deÞnition and data reduction settings. 
These parameters can be deÞned prior to reading a microplate, but they are 
applied only after the plate is read and can be changed at any time.

In this tutorial, you will build a complete protocol (based on the settings 
found in the Default Protocol Þle) which will include both hard and soft 
parameters. You will save the completed protocol Þle prior to collecting data 
(it could then be used to generate future data Þles).

This tutorial assumes you are using an absorbance instrument. If 
your computer is connected to a SPECTRAmax GEMINI or GEMINI 
XS, you should choose a different instrument in the Preferences 
before proceeding: in the Edit menu, choose Preferences. In the dialog 
box that appears, choose the SPECTRAmax and then close the dialog 
box. When you are Þnished with the tutorial, be sure to go back to the 
Preferences dialog box and choose the GEMINI instrument that is 
connected to your computer.

A synopsis of the steps you will take during this tutorial is given below.

1. Create a new Þle
2. Instrument setup
3. Template setup
4. Set reduction parameters
5. Set display parameters
6. Save the protocol
7. Read the plate (start the simulator and then open the Tutorial Þle)
8. Analyze dataÑStandard Curve
9. Analyze dataÑStandard section

10. Print the report

NOTE:
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Description of the Assay Example
Following are the details about the quantitative assay settings we will use to 
create a protocol Þle using SOFTmax PRO.

Type of Assay: Endpoint

Standards in µg/ml: 0, 0.1, 0.25, 0.5, 0.75, 1.0, and 1.4
(each standard run in duplicate)

Blanks: Plate blank run in duplicate

Auto Mix: On

Wavelengths: OneÑ405 nm

Standard Curve Fit: Linear

DeÞne the Protocol
The following steps will guide you through the process of creating a protocol 
Þle for a quantitative assay. Reading a plate will not be requiredÑdata has 
been saved in a separate tutorial Þle that will be opened later, allowing you to 
continue with this tutorial.

Step 1: Start SOFTmax PRO (Create a New File)

Double-click the SOFTmax PRO icon to start the program. If SOFTmax PRO is 
already running and another Þle is loaded, then choose New... from the File 
menu. You should see a new Þle labeled ÒUntitled.Ó

Figure 7.1: New SOFTmax PRO File with Introduction to 
Default Protocol/Tutorial Open
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CuvetteSet#1 (shown open in the Þgure above) can be deleted since the use of 
a cuvette is not covered in this tutorial. To delete this section:

1) Click in the title bar of the CuveteSet#1 section (it will turn gray and the title 
will become bold). From the Edit menu, choose Delete CuvetteSet#1. A small 
dialog box will appear, asking you to conÞrm deletion of this section. Click 
the Delete button and the section will be deleted.

2) The experiment should now have a Plate section, a Graph section, and certain 
other predeÞned group sections that will be used in this tutorial.

Step 2: DeÞne the Instrument Settings

Click the [Setup] button in the Plate section tool bar to open the Instrument 
Settings dialog box. The option button next to ÒEndpointÓ is automatically 
selected; no change is required. The ÒWavelengthsÓ may be set to the default 
of 1 at 405 nm; if so, leave the settings on the right side of the box alone. If not, 
click the arrow next to the number of wavelengths and choose Ò1Ó from the 
drop-down list; then click the arrow next to the wavelength shown for Lm1 
and type in 405. Figure 7.2 shows what the Instrument Settings dialog box 
might look like at this point (it may look differently depending upon which 
instrument is actually connected to your PC).

Figure 7.2: Instrument Settings Dialog Box (example for SPECTRAmax; 
your Instrument Settings dialog box may look different).
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Now check the settings for Automix & Blanking on the left side of the dialog 
box: ÒBeforeÓ should be set to ÒOffÓ; ÒPre-Read PlateÓ should be set to ÒOn.Ó 
If they are not, click the heading for Automix & Blanking on the left side of 
the dialog box. This will cause the settings for that function to appear on the 
right side of the box. Click the appropriate checkboxes to turn settings on or 
off. When you are Þnished, the dialog box should look similar to the one 
shown in Figure 7.3.

Figure 7.3: Instrument Settings Dialog Box Showing Automix & Blanking

The Instrument Settings dialog box for some instruments may show 
additional choices such as a menu for selecting plate types and/or 
PathCheck. The online Help index can be used to learn more about 
these features. To learn about ÒAutoCalibrateÓ shown in this dialog 
box, for example, choose Index from the Help menu. Then type Òauto-
calibrateÓ in the Þrst Þeld and double-click the result showing ÒAuto-
calibrateÓ in the second Þeld. A description of AutoCalibrate should 
now be displayed.

Instrument settings are now complete. Click [OK] to accept the settings, close 
the dialog box.

NOTE:
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Step 3: DeÞne the Template

A) Click the [Template] button in the Plate section tool bar. This will open the 
Template Editor, showing all wells empty. Drag the mouse (or shift-click) to 
select the Þrst two wells, A1 and A2. Click the Group pull-down menu on the 
Template Editor to see the group selections. Choose Blank. The two selected 
wells in the template will now be deÞned as the plate blank.

Figure 7.4: Template with Plate Blank Wells Assigned

B) Now select the two wells B1 and B2. Select ÒStandardsÓ from the Group 
menu. The selected wells will now show the default Þrst sample name for the 
Standards group, ÒSt01.Ó The area in the top center of the Template Editor 
will become active, showing the default values for concentration and units.

Figure 7.5: Template with First Standards Entered

Group
Pull-down

Menu
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In this tutorial, the concentration for the Þrst Standard should be set to 0 
µg/ml. If a value other than Ò0Ó is shown, highlight the existing value and 
enter 0 in this box. Click the [Assign] key or press either the Tab or Return 
key on the keyboard to assign this concentration to the selected wells in the 
template. You can quickly check the concentrations you have assigned to the 
template by pressing and holding the CTRL+Shift keys (Macintosh or Win-
dows). This causes the display to show only group names and values 
assigned to speciÞc wells.

Figure 7.6: Template showing First Standards Concentrations

C) Now select wells C1 and C2. ÒStandardsÓ is still showing as the default group 
name, but a new sample descriptor is created automatically (St02), so all you 
need to do is assign a concentration value of 0.1 µg/ml to these wells. After 
entering the value, click the [Assign] box (or press the Tab or Return key) to 
assign this value to the selected wells.

D) A total of seven standards will be assigned in duplicate in this template. You 
can use the Series function to assign the next four standards. Select wells 
D1/D2 through G1/G2. Click the [Series] button. In the dialog box that 
appears, leave the default values for the sample descriptor (Std03), starting 
from the top, and the concentration in µg/ml. Enter 0.25 for the starting 
value, choose the function Ò+Ó and enter 0.25 for the increment of the series. 
These choices will cause the series of wells you have selected to be assigned 
concentrations of 0.25, 0.5, 0.75, and 1.0 µg/ml, respectively. The choices you 
have made should look like this:
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Figure 7.7: Series Dialog Box

Click the [OK] button to close the dialog box and return to the Template Edi-
tor. The four sets of wells you selected should now be assigned the values 
entered for the series. You can check the concentrations assigned to these 
wells by pressing and holding the CTRL+Shift keys.

Figure 7.8: Template with CTRL+Shift Keys Depressed

E) The last standards need to be entered manually. Select wells H1 and H2. A 
new sample descriptor is created automatically (St07), so all you need to do is 
assign a concentration value of 1.4 µg/ml to these wells. After entering the 
value, click the [Assign] box (or press the Tab or Return key) to assign this 
value to the selected wells.

The template should look like the one in Figure 7.9 when you are Þnished 
entering the Standards.
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Figure 7.9: Template Filled with Blanks and Standards

F) This tutorial example uses seven separate unknown samples, with each 
unknown being placed in four wells. The unknown samples should be 
entered on the template as follows:

¥ Sa01Ñwells A5 through D5 ¥ Sa05Ñwells E7 through H7

¥ Sa02Ñwells A6 through D6 ¥ Sa06Ñwells A8 through D8

¥ Sa03Ñwells E6 through H6 ¥ Sa07Ñwells E8 through H8

¥ Sa04Ñwells A7 through D7

Start by highlighting wells A5 through D5. Select ÒSamplesÓ from the Group 
menu. The selected wells will now show the default Þrst sample name for the 
Samples group, ÒSa01.Ó The template should look like the one below.

Figure 7.10: First Samples Added to the Template
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Continue highlighting the wells as described above, assigning new unknown 
sample descriptors to each subsequent group. When all seven unknown 
samples have been added to the template, it should look like this:

Figure 7.11: Samples Added

G) This tutorial example uses two controls, with each control being placed in 
three wells. The controls should be entered on the template as follows:

¥ Co01Ñwells A9 through C9 ¥ Co02Ñwells D9 through F9

Start by highlighting wells A9 through C95. Select ÒControlsÓ from the Group 
menu. The selected wells will now show the default Þrst sample name for the 
Samples group, ÒCo01.Ó Do the same for wells D9 through F9, assigning the 
default second sample name, ÒCo02Ó to these wells. The template should look 
like the one below.

Figure 7.12: Controls Added
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H) The last items to be added to the template are samples with dilution. To do 
this, you will need to create a new group. First choose the wells of the tem-
plate that will contain these samples: A11 through G12. Click the Group pull-
down menu and choose ÒNew...Ó from the bottom of the list. This causes a 
dialog box to appear, allowing you to choose the attributes for the new group. 
Name the group ÒSam w/dilÓ and choose ÒUnknowns (dilution)Ó for the Col-
umn Format. This causes a checkmark to appear in the Sample Descriptor box 
and puts ÒDilution FactorÓ into the text box automatically. To the right of this 
text box, deÞne the units by clicking the arrow next to the drop-down menu 
and choose Òµg/ml.Ó The dialog box should look like the one below.

Figure 7.13: Samples with Dilution Added

When you click the [OK] button to close the dialog box, the template should 
look similar to the one below.

Figure 7.14: Samples with Dilution Added

The samples with dilution need to be changed to be part of a series, however, 
since we really want to include six different samples with replicates. 
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Highlight wells A11 through G12 again and click the [Series] button. Leave 
the default direction from the top down and leave the default operator of 
divided by 1. Enter Ò10Ó for the starting dilution. The Series dialog box 
should look like this:

Figure 7.15: Series Dialog Box for Samples with Dilution

Clicking [OK] in the Series dialog box causes the template to look like this:

Figure 7.16: Samples with Dilution Made into a Series

I) The template is now complete. Click the [OK] button to accept the entries and 
close the Template Editor. The outlines of the groups you have deÞned in the 
Template Editor will now be shown in the Plate section.
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Figure 7.17: The Plate Section Showing Group Boundaries

Step 4: Set the Reduction Parameters

Click the [Reduction] button in the Plate section tool bar to open the Reduc-
tion dialog box.

Figure 7.18: Reduction Dialog Box (Single-Wavelength Endpoint)

The default reduction setting for a single measurement wavelength, Ò!Lm1,Ó 
is acceptable and no change is required. However, for this tutorial example, 
we wish to subtract the plate blank included in the template. Make sure the 
box next to this option is checked (click it if it is not), and then click [OK] to 
close the dialog box.
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Step 5: Set the Display Parameters

Click the [Display] button to open the Display dialog box.

Figure 7.19: Display Dialog Box (Endpoint)

The default display for Endpoint readings is raw OD showing the reduced 
number (checkbox enabled under ÒShowÓ). It is not necessary for the pur-
poses of this tutorial to show a reduced number, so click the checkbox next to 
ÒWith reduced numberÓ to disable this function. If you decided later that you 
would like to view the reduced data, you can change the display options after 
the reading since this does not affect the actual dataÑonly how it appears on 
the screen and printout.

Figure 7.20: Display Dialog Box after Disabling ÒWith reduced numberÓ

Click [OK] to close the dialog box.
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Step 6: Save the Protocol

Choose Save from the File menu. Because the Þle has not been saved before 
and is not named, the Save As... dialog box will open.

Figure 7.21: Save As... Dialog BoxÑMacintosh

Figure 7.22: Save As... Dialog BoxÑWindows

On the Macintosh, click the option button next to ÒProtocol File.Ó In Win-
dows, click in the box under ÒSave File as Type:Ó and choose ÒPro Protocol 
Files (*.ppr).Ó Type the name you are giving to the Þle in the text box (high-
lighted over ÒUntitledÓ). In this example, type Tutorial. When you have Þn-
ished entering information in this dialog box, click [Save] to save a copy of 
the protocol Þle to the hard disk.

The title bar of the window will still show ÒUntitled,Ó rather than 
ÒTutorialÓ after saving. This does not mean the protocol has not been 
saved. When you create a protocol Þle, SOFTmax PRO saves a copy of 
the current Þle under that Þle name but does not display the name on 
the screen. Protocol Þles are saved as template Þles (on the Macin-

NOTE:
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tosh, these are known as stationery Þles). When you open a protocol 
Þle, an ÒUntitledÓ window appears, containing all the protocol infor-
mation saved previously, so that you can collect data and save the 
resulting data Þle under a different name.

Congratulations! You have just created your Þrst SOFTmax PRO protocol Þle. 
Now would be the time to read the plate and then save the data Þle. In this 
tutorial example, however, you will not perform an actual plate reading but 
will use a simulator program built into SOFTmax PRO to generate ÒdataÓ that 
you will manipulate as if it had been obtained from an actual reading. The 
same data is also contained in a Þle provided with the original software from 
Molecular Devices called ÒEndtut.pda.Ó The data in this Þle was generated 
using the parameters you have just created in this protocol Þle.

Step 7: Read the Plate

If you were reading an actual microplate at this time, you would prepare the 
microplate as it is deÞned in the Template Editor. (Before an actual reading, 
you might Þnd it helpful to print a copy of the template to assist in properly 
Þlling the plate.) You would then place the Þlled microplate in the drawer of 
the MAXline instrument. Since we are using a simulator, you donÕt need to 
load anything in the instrument. To enable the simulator, hold down the Ctrl 
and Shift keys and then choose Flash Simulator from the extended menu 
choices that appear in the Control menu (see the Þgure below).

Figure 7.23: Extended Choices in the Control Menu

Now that the simulator is active, click the [Read] button in the SOFTmax 
PRO status bar at the top of the screen to initiate the simulated reading.

A dialog box will appear asking you to choose the section you wish to read 
(the only choice in this tutorial is Plate#1) and whether or not you wish to 
include a pre-reading (see the following screen).
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Figure 7.24: Select Section Dialog Box

We will skip the Pre-read for this tutorial because it is done automatically by 
the simulator. Click the radio button next to ÒNormalÓ and then click the 
[OK] button to close this dialog box and begin the simulated reading.

Values appear in the data display in the Plate section as they if they were read 
by the MAXline instrument (faster than in real time). (Note that these same 
values are contained in a Þle called Endtut.pda in the Tutorial folder within 
the SOFTmax PRO folder on your hard drive. If you wish, you can open and 
use the data in that Þle instead from this point forward.)

The plate section of either Þle should look similar to the Þgure below.

Figure 7.25: Plate Section with Simulated Data

The display for each well that is deÞned by a group boundary shows a raw 
OD value. The reduction formula is shown at the bottom of the display: 
ÒWavelength Combination: !Lm1Ó.

In this part of the tutorial, you will Þrst view raw data without the plate blank 
subtracted and then display the data in various reduced formats.
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A) Click the [Reduction] button in the Plate section tool bar. The Reduction dia-
log box will open.

Figure 7.26: Reduction Dialog Box

Click the box next to ÒUse plate blankÓ to deselect it. Clicking [OK] closes the 
dialog box and returns to the Plate section. It will be updated to reßect the 
raw OD data without subtracting the plate blank.

B) Click the [Display] button in the Plate section tool bar. The Display dialog 
box will open.

Figure 7.27: Display Dialog Box

The current display selection is shown as a depressed button (Raw, in the 
example above). In this tutorial example, the display is set to raw OD values 
without a reduced number.
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Click the [Reduced] button. The following options will appear:

Figure 7.28: 

Choose ÒGrayscaleÓ from the drop-down menu that appears when you click 
the Display options menu. The dialog box will update to show the low and 
high limits for grayscale display values (which are automatically set to the 
minimum and maximum data values).

Figure 7.29: Display Dialog Box Updated with Low and High Limit Settings

Low and High
Limit Settings
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Click [OK]. The dialog box will close, and the data display in the Plate section 
will update to show the data represented by shades of gray as shown in Fig-
ure 7.30.

Figure 7.30: Plate Display with Data Displayed as Gray Scale

Step 8: Data AnalysisÑGroup Sections

Group sections are created automatically by SOFTmax PRO when you deÞne 
groups in the Template Editor. In this tutorial, some groups were already cre-
ated when you started the new Þle and a new one was added when you cre-
ated the new group, Sam w/dil. The content of Group sections changes 
depending on the wells that are assigned to these groups in the Template Edi-
tor. Before a plate is read, these sections show no data for the wells. After a 
reading, Group sections contain information about the values for the wells 
contained within the groups.

Scroll down until the Standards Group is visible. It should look like this:

Figure 7.31: The Group Section for Standards

The columns in this group are set up as follows, from left to right:

¥ Sample: the seven sample names assigned for the Standards group

¥ Concentration: the concentrations assigned to each sample in the template
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¥ BackCalcConc: Returns the curve Þt associated with the plot of Standards 
from the Standard Curve against the Values column.

¥ Values: raw OD values obtained for each sample

¥ MeanValue: the mean of data from the Value column for each sample

¥ StdDev: standard deviation for each sample value

¥ CV%: coefÞcient variation percent for each sample value

In the following part of this tutorial, you will view formulas associated with 
columns and summaries, resize individual columns, autosize all the columns, 
add a column, and hide replicates.

A) Viewing Formulas. To view the formulas associated with all columns in the 
Standards Group section, hold down the CTRL+Shift keys while this group is 
active. A second row will appear beneath the column titles, showing the for-
mulas for each column. Depending on the size of the column, all or only part 
of the formula may be shown.

Figure 7.32: A Portion of the Standard Group Section with Formulas Shown 
(by Pressing the CTRL+Shift Keys)

If column formulas are long, as in this tutorial example, they may be seen in 
their entirety in the default column size. To see the complete formula for a par-
ticular column, click once on a column to highlight it. The formula for that col-
umn will be shown in the tool bar.

Figure 7.33: Standards Group Section with Formula Shown for Highlighted
Column (BackCalcConc). Click the button to modify or change a formula.

B) Resize and then Autosize a Column. Position the pointer on the line dividing 
the columns named ÒConcentrationÓ and ÒBackCalcConc.Ó The pointer will 
change to a double-headed arrow. Click and drag the line dividing these col-
umns to the right. Figure 7.34 shows these actions and the resulting wider 
Concentration column.
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Figure 7.34: Sizing the Standard Value Column Wider

To shrink this column to the minimum size needed to display the complete 
title, click once in the Concentration column to highlight it. Then choose 
Autosize from the Group menu. The column will be reduced in width as 
shown in Figure 7.35.

Several columns can be Autosized at one time by highlighting 
(dragging across) multiple columns in the Group and then choosing 
Autosize.

Double-
Headed
Arrow
Pointer

Resulting
Column is
Wider

Dividing
Line

Dragging
Right

NOTE:
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Figure 7.35: Columns Before and After Autosize

C) Add a Column. The columns that are created by default with various Group 
sections may not always meet all the needs of a particular experiment. You 
can add a column to any Group section and deÞne the purpose of this column 
in your data analysis. By default, new columns are added to the right of any 
selected (highlighted) column or, if no columns are selected, after the last col-
umn in the Group.

To add a new column to the right side of the Standards Group, make sure this 
section is active. Then deselect any highlighted columns by clicking outside 
the column area. Click the Create Column button ( ) or choose Create 
Column from the Group menu. A dialog box will open, asking you to enter 
information for the new column.

Figure 7.36: Calculation Dialog Box

Before

After
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In this tutorial example, the new column will show the maximum value 
obtained for each sample. Type over the default column name, entering 
MaxValue in the box next to ÒName.Ó Now enter Max(Values) in the box next 
to ÒFormulaÓ and click [OK]. (Be sure to enter the formula exactly as shown.) 
The dialog box will close and a new column will be shown at the right of the 
previous columns, showing the maximum value obtained for each sample.

Figure 7.37: New MaxValue Column Appended to Group Section

D) View an ÒIfÓ Statement in a Column Formula. The Samples section contains 
a columns called ÒOutliers.Ó This column is made up of an ÒIfÓ statement that 
calls upon data from another Group section to report when data points lie 
outside the range of the minimum and maximum Standard values.

An ÒIfÓ statement in a formula deÞnes a condition that, if found to be true, 
causes a certain result and, if not true, causes a different result. The basic 
structure of an If statement is:

If (condition,result1,result2)

LetÕs take a closer look at the individual elements that make up the Outliers 
formula:

If(Values>=MinStd@Standards and Values<=MaxStd@Standards,ÓÓ,ÓOutlierÓ)

This statement says that, if the data shown in the Values column is greater 
than or equal to the calculation of ÒMinStdÓ found in the Standards group 
section and less than or equal to the calculation of ÒMaxStdÓ found in the 
Standards Group section, then show nothing (signiÞed by two quotation 
marks with nothing between them); otherwise show the word ÒOutlier.Ó

Looking at the Standards section, you will not immediately see the MinStd or 
MaxStd calculations used by this If statement. They are there, but their names 
are hidden. Look at the bottom of the Standards section and you will see two 
summaries as shown in the following Þgure.
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Figure 7.38: Summaries in the Standards Section

Double-click the Þrst summary, ÒSmallest standard value:Ó. A Calculation 
dialog box will appear:

Figure 7.39: Calculation Dialog Box from Summary in Standards Section

This dialog box contains a checkbox for ÒHide NameÓ which is currently 
enabled. Unchecking the box will allow you to view the name of the sum-
mary to the left of its text in the Standards section.

The formulas for MinStd and MaxStd are:

Min(MeanValue)        Max(MeanValue)

The MeanValue column is derived from the average of the well values found 
in the Values column (the Standard replicates). The minimum and maximum 
values from the MeanValue column in the Standards Group are used to create 
the summaries which is what the Outliers column formula uses to name its 
ÒOutliers.Ó Such a formula might be useful in Þnding points that might be 
better masked (not used in the calculations), for example.

Basic information regarding formulas and the information they can contain 
can be found in Chapter 5, ÒDisplaying and Analyzing Data.Ó For a complete 
discussion of writing formulas in SOFTmax PRO, as well as detailed exam-
ples of formulas and customized protocols, refer to the Formula Reference 
Guide.
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E) Hide Replicates. While the Standards section is active, choose Hide Repli-
cates from the Group menu. The display before and after hiding replicates is 
shown in Figure 7.40.

Figure 7.40: Standard Section Before and After Hide Replicates

More information about modifying group sections can be found in Chapter 5, 
ÒDisplaying and Analyzing Data.Ó

Step 9: Data AnalysisÑStandard Curve

The Default Protocol used to create this tutorial example Þle contains the pre-
deÞned groups Standards, Samples, and Controls; during the course of this 
tutorial, you also created a new group called Sam w/dil (with dilution). In 
addition, it contains a Graph section which has been created to display a stan-
dard curve.

Scroll down within the SOFTmax PRO window until you see the section tool 
bar for ÒGraph #1.Ó This section is closed; click the indicator on the left side of 
the tool bar to open it. This graph contains a single plot as shown in Figure 
7.41.

Standards
Section

Showing
Replicates

(Default)

After
Hiding

Replicates
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Figure 7.41: Standard Curve Graph SectionÑNo Fit Applied

This graph is set to show concentration on the X-axis and mean value on the 
Y-axis. If you are continuing with simulated data, no Þt will have been applied; 
the Endtut.pdf Þle has a linear Þt applied. With simulated data, apply a linear 
Þt by clicking in the menu next to ÒFit:Ó and choosing Linear. Releasing the 
mouse button causes SOFTmax PRO to redraw the graph based on its evalua-
tion of the Þt of the data to the new curve choice. The Þgures below show a lin-
ear Þt followed by a 4-parameter Þt.

Figure 7.42: Standard Curve Graph Section with Linear and 4-Parameter Fits 
Applied
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You can also display the data in a bar-graph or another format by clicking the 
graph options button  which opens a dialog box like that shown in the fol-
lowing Þgure.

Figure 7.43: Graph Options Dialog Box

This dialog box allows you to choose rename the graph, choose the type of 
graph that will be shown, and to format the text used in the graph. You can add 
or remove plots (click the [New] or [Delete] buttons) and you can also edit 
existing plots. See Chapter 5, ÒGraph Section,Ó for more information regarding 
the graphing options that are available.
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Step 10: Print a Report

SOFTmax PRO allows you to print several types of information. In addition 
to printing a copy of the template, you can print the active section, the sec-
tions that have been designated to be included in the report, or all sections.

The default setting in SOFTmax PRO is for all sections to be included in the 
report. You can exclude sections from printing as described in Chapter 6, ÒFile 
Management and Printing.Ó Otherwise, choosing Print... from the File menu 
and choosing ÒPrint reportÓ will print all of the sections that are designated to 
be included in the report, regardless of whether or not they are open.

A standard Print dialog box will appear (the appearance of this box depends 
upon the type of computer and printer you are using). Select the appropriate 
settings for your printer and then click [Print] or [OK].

Figure 7.44: Print Dialog Box for Macintosh

Figure 7.45: Print Dialog Box for Windows (HP DeskJet 1200C Shown)

You have completed this tutorial!Ñbut SOFTmax PRO has many other features 
that you will Þnd useful. The next chapter describes in detail items only 
brießy discussed up to this point and will provide information regarding cus-
tomizing and using the rest of the features of SOFTmax PRO.



Chapter 7: Tutorials

7-32 SOFTmax PRO UserÕs Manual



Chapter 8: Troubleshooting

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-3
Message Boxes and Alerts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-3

One or More Points Lost Message . . . . . . . . . . . . . . . . . . . 8-4
#Low or #Sat Messages (Plate Section Data) . . . . . . . . . . 8-5
Points Saturated Message . . . . . . . . . . . . . . . . . . . . . . . . . . 8-5
Points Lost and Saturated Message . . . . . . . . . . . . . . . . . . 8-6

Error Message Boxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-6
Communication Problems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-7

Macintosh Cable Connections  . . . . . . . . . . . . . . . . . . . . . 8-10
PC Cable Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-11

Display Problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-12
Printing Problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-12
General Problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-13



Chapter 8: Troubleshooting

8-2 SOFTmax PRO UserÕs Manual



Chapter 8: Troubleshooting

SOFTmax PRO UserÕs Manual 8-3

Introduction

When alerts, message boxes, or error boxes appear while you are using SOFT-
max PRO, they usually contain information describing the situation. In some 
circumstances, however, the information may not be complete enough to 
indicate what you should do to remedy the problem. At other times, errors 
may occur that are not directly associated with SOFTmax PRO but affect its 
operation. The information in this chapter is provided to assist you if an error 
occurs for which you do not have a solution or if you donÕt know the source 
of a problem.

This chapter presents general information regarding problems you may 
encounter Þrst, followed by speciÞc types of problems grouped by kind: dis-
play issues, printing errors, etc. Within each group is general information 
regarding such problems, sometimes followed by a table containing speciÞc 
problems and their suggested remedies. If you encounter a problem during 
operation of SOFTmax PRO, Þrst check to see if a table is associated with that 
type of problem and see if a remedy is listed there. When remedies require 
more space than the table can allow, a reference to a numbered text section 
will be listed in the table. Refer to that text section (by number) beneath the 
table to learn more about solving the problem.

If you need additional assistance or if you encounter a problem with SOFT-
max PRO that is not listed here, in the U.S., call Molecular Devices Technical 
Services group at 1-800-635-5577; elsewhere, call your local representative. 
For problems with an instrument that do not relate to the use of SOFTmax 
PRO, please see the instrument manual for more information.

Message Boxes and Alerts

Message boxes typically appear to inform you that the action you are attempt-
ing needs adjustment in some way. Message boxes contain only an [OK] but-
ton that you can click to remove the message after you have read the 
information.

Alerts inform you that the action you are about to take will have conse-
quences that may not be reversible or may make a signiÞcant change within 
the program. Alerts are indicated by an alert symbol ( ); typically, alerts do 
not prohibit an action but warn you about a condition that may cause a prob-
lem. 

One common example of an alert occurs when you are deÞning instrument 
settings for a kinetic assay and the read interval is too short. The message 
might look like this:

Figure 8.1: Example of an Alert Message

!
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One or More Points Lost Message

This error appears only with the SPECTRAmax PLUS, PLUS384, 190, 
340PC, GEMINI (in kinetic or spectrum mode only), or VERSAmaxÑ
other instruments are unable to continue after generating this error 
and will simply stop the reading.

A problem may exist with the instrument or the computer, or a communica-
tion problem may exist between the instrument and the computer. This error 
message means that no signal was recorded for a given wavelength in a given 
well (for an endpoint or spectral scan) or at one or more timepoints for a given 
well and wavelength (for a kinetic run). The instrument sent a placeholder 
(ÒNANÓ Ñ stands for ÒNot A NumberÓ) in lieu of a number and continued to 
collect data.

Depending on the type of assay(s) conducted, it may be very easy or difÞcult 
to see which wells were not read. During a multiple-wavelength endpoint 
reading, it might be quite easy to spot a missed data point; Þnding one during 
a long kinetic reading might be quite difÞcult, however. Follow the instruc-
tions below for the type of reading that was performed when the error 
occurred in order to assist you in Þnding lost data points.

Lost Data with a Multiple-Wavelength Endpoint Reading

If you get such an error message during a multiple-wavelength endpoint 
reading, try displaying raw signal at all wavelengths and visibly inspect the 
plate data for missing readings.

Lost Data with a Single-Wavelength Kinetic Reading

If the error occurs during a single-wavelength kinetic run, access the Reduc-
tion dialog box (click the [Reduction] button) for the plate section that was 
read. Choose ÒCustomÓ for the Wavelength reduction and then click the for-
mula button that appears ( ) to bring up the Reduction dialog box. For 
the kinetic reduction, enter the formula !numpointsread and then close the dia-
log box. In the Plate section, set the display (click the [Display] button) to 
raw data plot with reduced number. Compare the number shown in the Plate 
display with the number of Vmax Points listed at the right-hand side of the 
Plate section. The numbers should be the same. If a time point was not col-
lected in a well, the Plate display number will be lower.

Lost Data with a Multiple-Wavelength Kinetic Reading

If the problem occurs during a multiple-wavelength kinetic run, you can fol-
low the procedure outlined above, changing the wavelength reduction in turn 
to each of the wavelengths read (Lm1, Lm2, etc.) and then checking the num-
ber of points read at each wavelength. Once you know which wells have a 
missing time point, you can look at a Well Graph with points connected and 
determine if the missing points will adversely affect data analysis.

NOTE:
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#Low or #Sat Messages (Plate Section Data)

These reports appear in the Plate section of the SPECTRAmax 
GEMINI and only during endpoint mode.

The error #Sat appears when the well is saturated (i.e., too much signal). Try 
lowering the PMT setting and re-read the data. If the well is still saturated 
after the PMT is set to ÒLow,Ó try diluting the sample.

The error #Low appears if the ßash lamp missed the ßash for that well. 
Reread the affected strip(s).

Points Saturated Message

This error appears only with the SPECTRAmax GEMINI and only 
during kinetic or spectral mode.

A speciÞc timepoint in a given well (for a kinetic run) or a speciÞc wavelength 
in a given well (for a spectral scan) is reported as saturated. Check the indi-
vidual wells for saturation. If the saturation occurs at the time or wavelength 
of interest, you will need to reread at a lower PMT setting. If the saturation 
does not occur in the time segment or wavelength of interest, you may ignore 
the message and proceed with data analysis.

Wells
reporting
Ò#LowÓ
and Ò#SatÓ
errors

NOTE:

NOTE:
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Points Lost and Saturated Message

This error appears only during kinetic or spectral mode with the 
SPECTRAmax GEMINI.

This error message appears if a speciÞc timepoint in a given well (for a kinetic 
run) or a speciÞc wavelength in a given well (for a spectral scan) is saturated 
and points are also missed (see ÒOne or More Lost Points,Ó above). Check the 
individual wells for saturation. If the saturation occurs at the time or wave-
length of interest, you will need to reread at a lower PMT setting. If the satu-
ration does not occur in the time segment or wavelength of interest, you may 
ignore the message and proceed with data analysis.

For points missed, see the earlier section, ÒOne or More Points Lost MessageÓ 
on page 8-4, for information on how to Þnd lost points.

Error Message Boxes

Error boxes contain a stop graphic ( ) and text explaining the error, if the 
software can report it. Some errors are not recoverable and require that you 
perform the action or assay again. Others, such as an obstruction of the 
drawer of the microplate reader, report the problem and allow you to correct 
it and then proceed with the assay.

You have attempted to paste values from an external Þle containing ASCII 
tab-delimited data into a Plate section or CuvetteSet section, but the number 
of Þelds of data that you have copied does not match those required by the 
setup of that Plate section or CuvetteSet section.
For Plate section data, the format of the copied information must match the 
Instrument Settings of the target Plate section and the settings chosen in the 
Export Format in the Preferences. Check that all the required Þelds are 
present and that you have highlighted all of these Þelds prior to copying the 
data and try pasting again.

NOTE:
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Communication Problems

Communication #1 Instrument Icon Shown with an ÒXÓ

If the instrument icon shown in the upper left corner of the SOFTmax PRO 
window has an ÒXÓ through it, check whether the MAXline instrument is 
turned on. If it is, then check the SOFTmax PRO Preferences settings (see Set-
ting Preferences below) to ensure that the proper communications port 
(modem or printer for the Macintosh; COM1 or COM2, typically, for the PC) 
is selected. This setting should agree with the physical port to which the cable 
from the instrument is connected to the computer. If the port setting is correct, 
the instrument is on, and communication is still not functioning properly, quit 
SOFTmax PRO, turn off power to both the computer and the MAXline instru-
ment, and check that the cable connections between the instrument and com-
puter are secure. Turn both machines on again and restart SOFTmax PRO. If 
an ÒXÓ still appears over the icon, it may be that you are using the wrong type 
of cable.

Symptom Possible Cause/Solution

The instrument icon shown 
in the upper left corner of the 
SOFTmax PRO window has 
an ÒXÓ through it

1) Is the MAXline instrument turned on?
2) If the icon also has the words ÒNo port selectedÓ through it along 

with an ÒX,Ó open the SOFTmax PRO Preferences settings and select 
the proper communications port (setting should agree with the 
physical port to which the cable from the instrument is connected to 
the computer).

3) Quit SOFTmax PRO, turn off power to both the computer and the 
MAXline instrument. Check that cable connections between the 
instrument and computer are secure. Turn both machines on again 
and restart SOFTmax PRO. If an ÒXÓ still appears over the icon, it 
may be that you are using the wrong type of cable. See ÒCommuni-
cation #1Ó (following) for more information.

The Macintosh computer has 
only one serial port and canÕt 
connect to a MAXline instru-
ment and printer at the same 
time.

You can purchase a serial switch that will allow you to choose between 
communication with the MAXline instrument or the printer. See 
ÒCommunication #2Ó (following) for more information.
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Communication #2 Macintosh Computers Having a Single Serial Port

Some Macintosh computers have only a single 8-pin DIN serial port which 
serves as both the printer and modem port. Please check to see if your model 
is listed as compatible hardware on the SOFTmax  PRO for Macintosh Version 
System Requirements and Compatible Hardware sheet. If your computer is not 
listed, the performance of SOFTmax PRO version 3.0 for Macintosh cannot be 
guaranteed when using this model.

When running SOFTmax PRO, the single serial port Macintosh can either 
communicate with the MAXline instrument or print through the single serial 
port, but both printer and instrument cannot remain connected to the serial 
port at the same time. To avoid uncabling the instrument in order to attach 
the printer, you must either print across a network using the ethernet port of 
the computer, or the instrument and printer can be connected to an A/B 
switch box (one 8-pin DIN input port with two 8-pin DIN output ports) avail-
able from MacWarehouse (1/800/255-6227, part number BND0199, Din-8 
A/B switch box). This switch box can then be attached to the single serial port 
of the computer. The A/B switch of the switch box is used to physically 
switch the connection between the instrument and the printer. Because of the 
limitations of the single serial port Macintosh, the Autoprint feature of SOFT-
max PRO cannot be used unless you use the ethernet port of the computer for 
printing.

To print from SOFTmax PRO for Macintosh using the single serial port Mac-
intosh, connect to an AppleTalk-compatible printer such as the Hewlett-Pack-
ard DeskWriter C or 550C using an AppleTalk cable connection and the 
AppleTalk printer driver. Serial printers such as the Apple StyleWriter which 
use an Apple 
8-pin DIN to 8-pin DIN peripheral cable and a serial printer driver cannot be 
used with SOFTmax PRO for Macintosh on a Macintosh with a single serial 
port. 

ConÞguration for Reading

The computer, SOFTmax PRO for Macintosh, and switch box must be conÞg-
ured as follows in order to establish communication with the MAXline instru-
ment: AppleTalk Inactive in the Chooser dialog, serial port set to modem in 
the SOFTmax PRO Preferences dialog, and the switch box set to communicate 
with the MAXline instrument (to access the Chooser or Preferences dialogs, 
refer to ÒTo Switch from Printing to Reading,Ó below).

ConÞguration for Printing

The computer, SOFTmax PRO for Macintosh, and switch box must be conÞg-
ured as follows in order to print from SOFTmax PRO: AppleTalk active in the 
Chooser dialog, serial port set to modem in the SOFTmax PRO Preferences 
dialog, and the switch box set to communicate with the printer (to access the 
Chooser or Preferences dialogs, refer to ÒTo Switch from Reading to Printing,Ó 
below).
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Connecting to the Switch Box

These instructions are for connecting to the A/B switch box available from 
MacWarehouse (800-255-6227, part number BND0199, DIN-8 A/B switch 
box).

1) Attach one end of the 8-pin DIN to 8-pin DIN serial cable provided with the 
switch box to the single 8-pin DIN serial port of the computer.

2) Attach the other end of the cable to the input port (I/O) of the A/B switch 
box.

3) Attach one end of the 8-pin DIN to 8-pin DIN serial cable provided in the 
SOFTmax PRO software package to one of the two output ports (A or B) of 
the A/B switch box.

4) Attach the other end of the cable to the MAXline instrument.

5) Attach one end of the 8-pin DIN to 8-pin DIN AppleTalk cable to the remain-
ing output port of the switch box.

6) Attach the other end of the cable to the AppleTalk printer.

7) Place a note on the top of the switch box indicating the identity of each output 
port.

To Switch from Reading to Printing

1) ConÞgure the computer, SOFTmax PRO, and the switch box as described 
above for reading a microplate.

2) Read the microplate.

3) Set the switch box to communicate with the printer.

4) Quit SOFTmax PRO.

5) In the Finder, select Chooser from the Apple menu to bring up the Chooser 
dialog.

6) Set AppleTalk to active.

7) In the box on the left side of the Chooser dialog, choose the AppleTalk driver 
for the printer. The printer name should appear in the box on the right side of 
Chooser dialog.

8) Close the Chooser dialog.

9) Start SOFTmax PRO.

10) Print the desired sections.
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To Switch from Printing to Reading

1) ConÞgure the computer, SOFTmax PRO, and the switch box as described 
above for printing.

2) Print the desired sections.

3) Select Chooser from the Apple menu to bring up the Chooser dialog.

4) Set AppleTalk to Inactive.

5) Set the switch box to communicate with the instrument.

6) Select Preferences from the Edit menu.

7) Without changing any settings, click OK.

8) Read the microplate.

Macintosh Cable Connections
For a MAXline instrument connected to a Macintosh, one end of the cable 
should end with an 8-pin DIN connector. This connector is small and round 
and should be connected to either the modem or printer port of the Macintosh.

Figure 8.2: 8-Pin Din Connection to Macintosh Computer

If you are connecting the Macintosh to a MAXline instrument, the other end 
of the cable should also be an 8-pin DIN connector.

Figure 8.3: 8-Pin DIN to 8-Pin DIN Serial Cable

You should use a double-shielded, straight-through serial cable. If you are 
unsure of the quality of the cable you are using, Molecular Devices suggests 
that you purchase a cable of known quality and try the connection again.

Printer Modem
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PC Cable Connections
For a PC that will be connected to a MAXline instrument, one end of the cable 
should end with an 8-pin DIN connector. This connector is small and round 
and should be connected to the MAXline instrument.

The connector required to attach to your PC will depend upon the type of 
serial port(s) available on your computer. Typically, at least one 9-pin or 25-
pin serial port is available on a PC; most have two, which are known as 
COM1 and COM2, respectively. The connector for your computer may be a 9-
pin or 25-pin connector (or you can use an adapter that converts from 9-pins 
to 25-pinsÑsee Figure 8.4).

Figure 8.4: 25-Pin DIN to 25-Pin or 9-Pin Serial Cable

The cable itself should be a double-shielded, straight-through serial cable. If 
you are unsure of the quality of the cable you are using, Molecular Devices 
suggests that you purchase a cable of known quality and try the connection 
again.

9-pin to 25-pin
adapter 9-pin25-pin

25-pin 25-pin
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Display Problems

Printing Problems

Symptom Possible Cause/Solution

A large Group section table 
becomes gray or disappears.

You are attempting to display more than 2500 data points in a group.
1) From the View menu, choose Minimize. Delete the large Group 

table; then create a new, smaller table.
2) If this does not work, from the View menu, select the large group; 

then choose Delete groupname from the Edit menu. Save the Þle; 
close the Þle; reopen the Þle.

Checkbox for Plate blank 
subtraction in the reduction 
dialog box is not visible.

This option is not visible until after data has been collected.

Y-axis units on a graph (either 
Well Graph or Graph section) 
are repeated.

This can occur when the range on the Y-axis is very small. Increase the 
height of the Y-axis.

A red ÒhandÓ appears in the 
instrument information por-
tion of a Plate section or 
CuvetteSet section.

A Visioneer PaperPort extension (Macintosh) is in conßict with SOFT-
max PRO. Disable or remove the PaperPort extension and restart the 
computer.

Text appears Òtoo largeÓ for 
wells in plate on Windows 
platform.

In the Windows Control Panel, check the settings for Display. Ensure 
that you are using Òsmall fonts.Ó

General display problems in 
Windows

Change the video display settings to 16-bit and high color, or better.

Symptom Possible Cause/Solution

Text in the header Þeld of the 
print dialog box ÒdisappearsÓ 
if you press the return or 
enter key.

The text is still there but is not visible. It will print. If you click in the 
box and drag the mouse to the left, it will reappear.

The Notes section is longer 
than one page. The bottom 
line of the Þrst page and the 
top line of the second page 
are partially printed.

Insert a linefeed into the Notes section at the appropriate place.
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General Problems

General Problem 
#1

InsufÞcient Memory in a Macintosh

If errors occur while using SOFTmax PRO for the Macintosh, it may be that 
the amount of memory allocated for the program is insufÞcient. Two items 
need to be checked: the amount of memory your Macintosh has available for 
use, and the amount of memory allocated to SOFTmax PRO.

To see the amount of memory available within the Macintosh, Þrst quit all 
open applications, then go to the Finder, and choose About This Macintosh... 
from the Apple ( ) menu.

The information box that opens will list the amount of memory used by the 
System Þle and the amount of memory remaining (under the heading, ÒLarg-
est unused blockÓ) that can be assigned to applications (such as SOFTmax 
PRO). The amount of memory available should be equal to or greater than 
minimum amount required by SOFTmax PRO.

Figure 8.5: About This Macintosh Dialog Box

Symptom Possible Cause/Solution

Data from a CuvetteSet sec-
tion reference or reading 
doesnÕt seem Òright.Ó

Check that the cuvette is oriented properly in the cuvette port of the 
instrument: the clear sides of the cuvette must face left and right when 
you are in front of the instrument. If the cuvette is oriented improperly, 
remove it, replace it in the correct orientation, and repeat the reference 
or reading.

 Macintosh ÒbombsÓ or 
gives errors that cause SOFT-
max PRO to crash.

The amount of memory available in your Macintosh or the amount of 
memory allocated for SOFTmax PRO may be insufÞcient. See ÒGeneral 
Problem #1Ó below for more information.

 Double-clicking a Þle 
with the Ò.pdaÓ extension 
launches the Printshop appli-
cation.

Printshop (from Br¿derbund) uses the Ò.pdaÓ extension to identify its 
Þles (as does SOFTmax PRO). See ÒGeneral Problem #2Ó below for 
more information.
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If you open many Þles simultaneously, or if you open SOFTmax PRO while 
other applications are open in the background, memory errors can occur. 
Also, if you make a kinetic run with a large number of data points, you may 
not have enough memory with a typical allocation. SOFTmax PRO requires a 
minimum of 7223K (over 7 megabytes) of memory to run, but this is not opti-
mal. The preferred size is 8223K (over 8 megabytes) or larger. Try increasing 
the amount of memory allocated to the program. To do this, quit SOFTmax 
PRO (if it is running). Then highlight the SOFTmax PRO program icon (click 
it once), and then choose Get Info (zI) from the File menu. The dialog box 
that opens lists suggested and minimum memory allocations (see Figure 8.6).

Figure 8.6: SOFTmax PRO Info Dialog Box

Enter a larger amount of memory in the box next to ÒSuggested sizeÓÑthe 
amount you enter may be limited by the total amount of memory available. 
The next time you start SOFTmax PRO, it will use the larger memory size you 
have allocated. You may also enter a different number into either the mini-
mum or preferred size boxes. It is suggested that you do not reduce the num-
ber in the ÒMinimum sizeÓ box (you may increase it, however). The 
ÒPreferred sizeÓ can be as large as you wish, depending on the amount of 
memory available. 
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General 
Problem #2

Printshop Launches instead of SOFTmax PRO (Windows only)

Both Printshop (an application from Br¿derbund) and SOFTmax PRO use the 
extension Ò.pdaÓ to identify Þles. If Printshop is already installed when you 
install SOFTmax PRO on your computer, the Ò.pdaÓ extension will have 
already been registered with Windows as a Printshop Þle, and SOFTmax PRO 
Þles will appear with the Printshop icon. Double-clicking any Þle ending with 
the Ò.pdaÓ extension will launch Printshop instead of SOFTmax PRO.

There are two ways to Þx this problem: 1) you can launch the SOFTmax PRO 
program and open the data or protocol Þle from within the program; 2) you 
can change the program that starts when you open a Þle. To perform this sec-
ond option, do the following:

1) In My Computer or Windows Explorer, click the View menu, and then click 
Options.

2) Click the File Types tab.

3) In the list of Þle types, click Printshop. The settings for Printshop will be 
shown in the File Type Details box (ÒPDAÓ will appear as the extension used).

4) Click [Edit].

5) In the actions box, click [Open].

6) Click [Edit], and then specify SOFTmax PRO as the program you want to 
open Þles that have this extension. To do this, click the [Browse...] button 
and locate the SOFTmax PRO executable Þle.

Doing this will cause Ò.pdaÓ Þles to be associated with SOFTmax PRO instead 
of Printshop. In order to open Printshop Þles, you will need to open the Print-
shop application and open Ò.pdaÓ Þles relating to Printshop from within that 
application (double-clicking a Ò.pdaÓ Þle will open SOFTmax PRO).
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Introduction

SOFTmax PRO 3.0 can be controlled by other Windows applications by means 
of a simple ASCII string-based messaging system. A command string such as 
ÒReadÓ or ÓSaveAs:myFileÓ is sent to SOFTmax PRO which then parses and 
executes the command.

Interprocess communication is implemented by using the Windows Send-
Message/PostMessage system. When SOFTmax PRO 3.0 starts up, it uses 
RegisterWindowMessage to register a unique message tag. Other applications 
can retrieve this message tag by using the same mechanism:

smaxMsg=RegisterWindowMessage(“SOFTMaxPROMsg”);

ASCII commands are sent to SOFTmax PRO using the WM_SETTEXT message, 
a special message used for interprocess Windows messages because it allows 
character strings from the address space of one process to be accessed (read-
only) by a process running in another address space.

All messages must be sent to the SOFTmax PRO main window. To get the 
proper HWND: 

hwnd = FindWindow(“SOFTMaxPROMainWnd”, “SOFTmax Pro”);

Finally to send the message:

SendMessage(hwnd,WM_SETTEXT,smaxMsg,(LPARAM)myCmd);

Notes:

¥ The smaxMsg tag MUST be sent as the wParam so that SOFTmax PRO 
knows this is an external command and not a Windows generated message. 

¥ The tag and hwnd should be checked for non-zero values before sending 
the message. 

SOFTmax PRO Responses

Most commands that are sent to SOFTmax PRO are just that: commands that 
tell SOFTmax PRO to do something. However, a few SOFTmax PRO com-
mands respond with ASCII results. Examples are ÒReturnStatusÓ and 
ÒReturnDataÓ.

Two response modes are available. In the Þrst mode, SOFTmax PRO responds 
by putting the requested information on the clipboard. The data can then be 
pasted into other applications, such as into Excel spreadsheets. For many 
other applications, however, the clipboard mechanism is not appropriate for 
retrieving data from SOFTmax PRO. Because of this, SOFTmax PRO can also 
send the response strings back in a separate message, using the MFC C++ 
WinProc. This mechanism is discussed in detail later in the Appendix.
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SOFTmax PRO Commands

SOFTmax PRO commands are single words. If parameters are required with 
the command, a colon is used between the command and the parameters.

Close
Close the current document.

If the data has not been saved, the document is closed any-
way with no user warning.

CloseDrawer
Tell SOFTmax PRO to close the instrument drawer.  

Copy
This is equivalent to pressing CTRL-C or selecting Copy from the Edit menu.

Notes: 

¥ If a plate section has just been read or is the only selected section, the 
plate data will be copied to the clipboard.

¥ The data copied will follow the display settings for the current plate 
(normally Raw Data).

¥ Other sections such as Groups can also be copied. The SelectAll command 
should be used Þrst.

ExportAs:XXX
Tell SOFTmax PRO to export data in the standard SOFTmax PRO format.

ImportTemplate:XXX
Have SOFTmax PRO import a template Þle. The Þle should comply with 
SOFTmax PROÕs template Þle format. A plate section should be selected 
prior to importing a template.

NameCurSection
This (re)names the current selected section. If no section is selected, nothing 
happens.

Notes: 

¥ This command is used typically to identify different plates in an auto-
mated environment.

¥ The data copied will follow the display settings for the current plate 
(normally Raw Data).

Example:

“NameCurSection:Plate#002345”

! CAUTION:
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New
Have SOFTmax PRO send a New command. This creates a new document and 
reads in the values contained in the ÒDefault Protocol.pprÓ protocol Þle.

OpenAssay:XXX
Have SOFTmax PRO open a protocol Þle. The Þle should be in SOFTmax 
PROÕs Assays folder which is set using the Assays menu. Protocols can also 
be stored in subdirectories of the Assays folder.

Notes: 

¥ Only protocol Þles can be opened.

¥ SOFTmax PRO will append .ppr to any Þlename passed in.

¥ If the Þle is not found, SOFTmax PRO does nothing.

Examples:

“OpenAssay:myFile”

“OpenAssay:\mySubDirectory\myFile”

OpenDrawer
Tell SOFTmax PRO to open the instrument drawer.  

Read
Select a plate section and send SOFTmax PRO a read command.  

Notes:

¥ If more than one plate section exists in the current document, the Þrst 
selected plate will be read. If no plate is selected, the Þrst plate after the 
currently selected section will be read. If nothing is selected, the Þrst 
plate in the document will be read (typical case).

¥ If the plate already has data, the data will be overwritten without con-
Þrmation.

¥ If Autosave is turned on, the document will be saved normally after the 
read is complete.

¥ Pre-reads of plates should not be performed.

ReturnData
This command is used to ask SOFTmax PRO to send back the data from the 
currently selected plate. Generally this is used to send the data directly to 
the caller instead of using the clipboard.

In the Visual Basic or Excel environments, this command functions like the 
SOFTmax PRO ÒCopyÓ command if a plate is the currently selected section.

ReturnStatus
This command sends back the current instrument status. The status is an 
ASCII string that has information about the instrument type and version, 
whether the instrument is busy or idle, its current temperature, and the 
state of its drawer. The exact format of this response depends on the type of 
instrument in use.
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ReturnTiming
This command sends back the number of seconds that it would take to read 
the current plate. For multi-plate documents, the plate used is chosen in the 
same way as described in the ÒReadÓ command above.

SaveAs:XXX
Have SOFTmax PRO save the current document Þle. The Þle will be saved 
in the current SOFTmax PRO Autosave directory which is set in the Prefer-
ences dialog accessed through the Edit menu. Data Þles can also be saved to 
subdirectories of the Autosave directory. 

Notes:

¥ SOFTmax PRO will append .pda to any Þlename passed in to it.

¥ If a Þle with the same name already exists, SOFTmax PRO will automat-
ically overwrite the Þle with NO warning.

¥ If the subdirectory does not exist, the Þle will not be saved.

Examples:

“SaveAs:myFile”

“SaveAs:\mySubDirectory\myFile”

SelectAll
This is equivalent to pressing CTRL-A or choosing Select All from the Edit 
menu. This can be used to select data in group tables for copying (not needed 
for copying plate data).

SelectSect
Select a section by name. This can be useful for multi-plate protocols or for 
selecting Group tables for copying.

Examples:

“SelectSect:Plate#0023499”

“SelectSect:Group#1”

SelectSectNum
Select a section by its order in the document. This can be useful for multi-
plate protocols or for selecting Group tables for copying.

Example:

“SelectSectNum:3 ”

SetTemp:XX.X
Send a command to set the current instrument incubator temperature.

Stop
Send SOFTmax PRO a command to stop reading. This is equivalent to press-
ing the Stop button on the SOFTmax PRO tool bar. This should be sent before 
any Close or Quit command if there is a possibility that the instrument is 
still reading.
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Quit
Tell SOFTmax PRO to close all documents and Quit.

If the data has not been saved, the application quits any-
way with no user warning.

Visual Basic (Excel Macro) Example
' First some housekeeping code: 

Private Declare Function FindWindow Lib “user32” Alias _

“FindWindowA” (ByVal lpClassName As String, _

               ByVal lpWindowName As String) As Long

Private Declare Function SendMessage Lib “user32” Alias _

“SendMessageA” (ByVal hWnd As Long, ByVal wMsg As Long, _

                ByVal wParam As Long, _

                ByVal lParam As String) As Long

                    

Private Declare Function RegisterWindowMessage Lib “user32” Alias _

“RegisterWindowMessageA” (ByVal mgsName As String) As Long

'-----------------------------------------------------------------------------

Const WM_SETTEXT = 12 ' define a windows message value

Function SendMsgToPRO(ByVal msgStr As String) As Long

    hWnd = FindWindow(“SOFTMaxPROMainWnd”, “SOFTmax Pro”)

    If hWnd = 0 Then    ' one beep means Pro is not running.

        Beep

    Else

        ' Pro is running so use the SendMessage API

        softmaxMsg = RegisterWindowMessage(“SOFTMaxPROMsg”)

        If softmaxMsg = 0 Then  

            ' This version of PRO does not understand external msgs

            Beep

            Beep

        Else

                      SendMessage(hWnd, WM_SETTEXT, softmaxMsg, msgStr)

        End If

    End If

End Function

'-----------------------------------------------------------------------------

' This is an example of how to use the above routine

! CAUTION:
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Sub SendNewMsgToPRO()

    SendMsgToPRO (“New”)

End Sub

MFC C++ Interface to SOFTmax PRO Remote Commands that 
Return Values

Some SOFTmax PRO IPC commands return values. By default they put the 
data in the clipboard, but optionally they will use the WM_COPYDATA 
mechanism to return data directly to the caller. 

In order to have the SOFTmax PRO response returned in this fashion, the 
commands must be sent using WM_COPYDATA so that SOFTmax PRO 
knows what to send the response to.

SOFTmax PRO will then reply with another WM_COPYDATA message 
that contains the response.

MFC Example Code:

long cmdStr;

CString cmdStr;

smaxMsg=RegisterWindowMessage(“SOFTMaxPROMsg”);

cmdStr=“OpenDrawer”;

cd.dwData=(DWORD)GetSafeHwnd();; // pass our hwnd for return messages

cd.cbData=cmdStr.GetLength()+1;  // add one for /0

cd.lpData=cmdStr.GetBuffer(0);

::SendMessage(hwnd,WM_COPYDATA,smaxMsg,(LPARAM)&cd);

Later, SOFTmax PRO will reply with a WM_COPYDATA message. To get it in MFC, cre-
ate a routine like this:

BOOL XXXXXXX::OnCopyData(CWPropWnd, COPYDATASTRUCT* pCopyDataStruct){

UINTmsgTag;

CString aStr;

msgTag=RegisterWindowMessage(“SOFTMaxPROReplyMsg”); // get tag

if (pCopyDataStruct->dwData==msgTag) {

aStr= pCopyDataStruct->lpData,pCopyDataStruct->cbData);

// do whatever

return(TRUE);

} else {

return(FALSE); // message is for someone else

}

}
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Cutoffs 4-32
CuvetteSet

menu 3-34
menu commands/buttons 3-17
reduction options 5-4
resizing the display 5-11, 5-12
section 1-16, 3-17, 5-4

data display 5-4
CuvetteSet section 1-16
CuvetteSet Settings (command) 3-35

D
Data

exporting 6-17, 6-21
importing 6-21

Data display 1-16, 4-59, 5-3, 5-4, 5-5, 5-42, 7-19
Gray Scale 5-15, 5-17
Group section 5-42
limits 5-15
Ranged 5-15, 5-16
reduced number 5-14
Threshold 5-15
well graph 4-59, 5-18

Data file 1-16, 5-3, 6-5
locating 6-5

Data mode (%T/Absorbance) 1-16, 5-38, 6-20
Data points 5-31, 5-32, 5-65, 5-68, 8-12

one or more points lost 8-4
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Data reduction 1-3, 5-24
calculation, hierarchical 5-24

Default protocol 1-16, 6-3
Delete (command) 3-9, 3-10, 4-37
Delete Section (command) 3-28
Density (setting) 4-16
Desktop 1-16
Dialog box 1-16
Dilution factor 1-17
Dimmed 1-17
Display

command 3-33, 3-34
default settings 5-6, 5-12
dialog box 5-6
options 6-17
parameters 5-3
problems 8-12
reduced number 5-14

Drawer button 3-8
Dual wavelength 5-40
Duplicate 6-25
Duplicate (command) 1-17

E
Edit Column (command) 3-37
Edit Summary (command) 3-35, 3-37
Emax

connection to Macintosh 2-4
connection to PC 2-6

Emission scan (spectral) 1-17
Emission spectral scan 1-17
End (wavelength) nm 5-37
End Time 5-29, 5-32
Endpoint 1-3, 4-13, 4-27, 5-28

display defaults 5-6
reduction 5-28

Enlarged well graphs 5-18
Error bars 5-54
Error messages 8-6

pasted text 8-6
Excitation scan (spectral) 1-17
Experiment

active 3-8, 3-30
Experiment menu 3-30
Experiment section 3-8
Exponential (curve fit) 1-18, 5-64

Export 6-21
command 3-26, 6-17
data 6-21
format 2-15

Preferences setting 2-14
Export command

format
Preferences setting 6-17

Exporting data 6-17

F
File

autosaving 6-11
creating 6-3, 6-5
cross-platform 6-7
data 6-5
management 6-3, 6-5
menu 3-26
opening 6-6

SOFTmax 6-6
protocol 6-5
saving 6-10, 7-17
saving manually 6-10
stationery 7-18

Files
opening

SOFTmax PRO 1.x 6-6
Fill (pattern) 4-15
Filter wavelengths 2-15
Fluorescence 4-54
Fluorophore 1-18
Format text 6-15
Formula 5-68

column 5-46
copy 6-25
custom 5-68
custom reduction 5-39
editing 5-44
help 1-9
plot 5-48
summary 5-47

Formula (button) 5-39
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G
Glossary of Terms 1-13
Graph 5-48

command 3-33, 3-34
connect points 5-66
copying 6-23
curve fit 5-54, 5-55
error bars 5-54
formulas 5-48
options 5-66

axes 5-68
bar 5-67
button 5-19
defaults 5-66
scatter 5-66

standard curve 7-28
summary 5-48

Graph menu 3-36
Graph section 3-9, 3-21, 5-48, 5-55

curve fit 5-54, 5-55
menu commands/buttons 3-22
plots 5-55

Graph Settings 3-36
Graph Type (command) 3-36, 5-66
Graphing wells 5-18
Gray Scale display 5-15, 5-17
Group 3-9, 3-19, 7-22

blank (plate blank) 7-8
boundaries 4-37, 4-38
columns 7-22

adding 5-46
copy 6-25
formulas 5-44, 5-46
paste 6-25

customizing 3-9
sample descriptor 4-47
sample name 4-47
series 4-47
Template Editor 4-36
text format 6-15
units 7-8

Group menu 3-37
Group section 5-42

menu commands/buttons 3-20
Group Settings (command) 3-37

Group Settings (dialog box)
assign area 4-45
sample area 4-44
sample descriptor 4-41

Group-associated blanks 1-14, 4-49, 4-50

H
Help 1-9, 1-10

formula 1-9
hypertext links 1-12
search function (Windows) 1-11

Hide (command) 3-37, 5-43
Hide Formulas (command) 5-44
Hide Replicates (command) 3-37
Highlight 1-18
H-line (pattern) 4-15

I
Icon, instrument 2-14
Import/Export 6-21
Importing data 6-21
Incubator (command) 3-31
Incubator button 3-8
Installation 2-9
Instrument settings 3-23, 4-4, 7-6

mode 4-13, 4-27
read type 4-30
summary 4-5
wavelengths 4-15

Instrument Setup (command) 3-31

K
Kinetic 1-3, 4-14, 4-28, 5-29

display defaults 5-6
interval 4-14, 4-28
limits 5-29
negative OD values 5-29
reduction 5-29, 5-34, 5-39
run time 4-14, 4-28

Kinetic limits 5-29
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L
Lag Time 5-29, 5-31
Lambda at Maximum 5-38
Lambda at Minimum 5-38
Large Display 1-19
Limits

data display 5-15
MaxOD 5-29, 5-37
MinOD 5-37

Linear (curve fit) 1-20, 5-56
Log-Log (curve fit) 5-58
Log-Logit (curve fit) 1-20, 5-60
Luminescence 1-20

M
Macintosh

computer 2-7
problems 8-13
software 2-9

Mask 5-22
button 5-22
wells or cuvettes 5-22

Mask (command) 3-33, 3-34, 5-22
Max Lambda 5-38
Maximum 5-37
Maximum (reduction) 1-20
MaxOD 1-20, 5-29, 5-33, 5-37
MaxRFU 1-20
MaxRLU 1-20
Memory

insufficient (Macintosh) 8-13
Menu

Assay 3-32
bar 3-4
CuvetteSet 3-34
Experiment 3-30
File 3-26
Graph 3-36
Group 3-37
Notes 3-35
Plate 3-32
View 3-30

Message boxes 8-3
Minimize (command) 3-30
Minimum 5-38
Minimum (reduction) 1-21
MinOD 1-21, 5-29, 5-31, 5-37
MinRFU 1-21

MinRLU 1-21
Mode 4-13, 4-27

Endpoint 4-13, 4-27
Kinetic 4-14, 4-28

interval 4-14, 4-28
run time 4-14, 4-28

Spectrum 4-15, 4-29
Well scan 1-4, 4-15

Modem port 2-15
Molecular Devices Technical Service 8-3

N
New (command) 3-26, 6-5
New Window (command) 3-33, 3-35, 3-36, 3-38
Non-Volatile RAM 1-21
Normal Display 1-21
Notes menu 3-35
Notes section 3-9, 3-13, 5-48

text format 6-15
Notes Settings (command) 3-36
NVRAM 1-21

O
OD values, absolute 5-18, 5-32, 5-33
Onset Time 4-14, 4-28, 5-36
Open (command) 3-26, 6-6
Optical density (OD) 1-13, 1-21, 4-53
OPTImax

connection to Macintosh 2-3
connection to PC 2-4

Option button (radio button) 1-22

P
Page Setup (command) 3-6, 3-27, 5-46
Parallel Port (Windows) 1-22
Partial plate read 4-24, 4-35
Password protection 6-27

changing 6-28
setting 6-28

Paste 1-15, 6-23
command 3-28, 6-23
Group columns 6-25
pre-read data 4-21

PathCheck 4-20, 5-27, 5-28
Pathlength correction 4-20, 5-27, 5-28
Plate blanks 1-14, 4-49
Plate menu 3-32
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Plate section 3-9, 3-15, 5-4
data display 4-59, 5-4, 5-5, 7-19
instrument settings

summary 4-5
menu commands/buttons 3-16
reduction options 5-4

Plate Settings (command) 3-33
Plots 5-48, 5-55

command 5-48
Point-to-Point (curve fit) 1-22, 5-62
Port 1-22
Preferences 2-14

command 3-29, 6-11
Pre-read plate blanks 1-14, 4-25, 4-49

copy/paste data 4-21
Print (command) 3-27, 6-15
Print Section (command) 3-27
Printing 6-12

Autoprint 6-12
options 6-12
problems 8-12
report 6-12, 6-13, 7-31

including/excluding sections 6-13
section 6-12

order 6-13
setup 6-12
template 6-12
well graph 5-21, 6-12

PrintShop
Conflict with SOFTmax PRO 8-13

Protocol
default 1-16

Protocol file 6-4, 6-5
default 6-3
locating 6-5
saving 7-17

Q
Quadratic (curve fit) 1-23, 5-59
Quit (command) 3-27

R
Radio button (option button) 1-22
RAM (Random Access Memory) 1-23
Ranged display 5-15, 5-16

Read 4-54, 7-18
button 3-7
command 3-31, 4-54
cuvette 4-53, 4-55
entire plate 4-24, 4-35
microplate 4-53, 4-54
mode 4-13, 4-27

Endpoint 1-3, 4-13, 4-27
Kinetic 1-3, 4-14, 4-28
Spectrum 1-3, 4-15, 4-29
Well scan 1-4, 4-15

partial plate (Strips) 4-24, 4-35
priority 4-58
strips 4-24, 4-35

Read type 4-30
Reader (pop-up menu) 2-15
Recalculate Now (command) 3-29, 5-41
Recalculation options 5-41
Reduced Number (display) 5-14
Reduction 1-3, 5-4, 5-24, 5-27

command 3-32, 3-34
custom formula 5-39
defaults 5-28, 5-29, 5-34, 5-37, 5-39
kinetic 5-34
options 5-4
parameters 5-3
spectrum 5-37

Ref (Cuvette Set) 4-49
Ref button 3-7
Reference

problems 8-13
reading 4-55

Registration dialog box 2-12
Replicates 4-46
Report 6-13

customizing 6-13
default setting 7-31
printing 6-12, 6-13, 7-31

including/excluding sections 6-13
RFU/RLU values, absolute 5-18, 5-32
ROBOmax 6-11

S
Sample descriptor 4-41
Save (command) 3-26, 6-5, 6-10, 7-17
Save As (command) 3-26, 6-5, 6-10
Saving files manually 6-10
Scroll 1-24
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Scroll bar 3-10
Section 3-9

active 1-13, 3-10, 3-24, 3-27, 3-28, 3-30, 3-33
changing order 6-14
creating 3-10
CuvetteSet 3-17
deleting 3-9, 3-10
Graph 3-9, 3-21, 5-48, 5-55

curve fit 5-54, 5-55
options 5-66
plots 5-55

Group 3-9, 3-19, 5-42, 7-22
columns 7-22
customizing 3-9
text format 6-15

inactive 3-10
Notes 3-9, 3-13, 5-48

text format 6-15
order 6-14
Plate 3-9, 3-15
printing order 6-13
relationship 5-3
Standard Curve 7-28
tool bar 3-10

Sections
opening/closing 3-11

Select All (command) 3-28
Semi-Log (curve fit) 1-24, 5-56, 5-57
Serial port 1-24, 2-15, 8-7
Series 4-46, 4-47

replicates 4-46
Show All (command) 3-37, 5-43
Show Formulas (command) 3-36, 3-37, 5-44, 

5-47, 5-48
Size box 5-21
Slope 1-24, 5-36
SOFTmax files 6-6
SOFTmax PRO 1.x files 6-6
SOFTmax PRO Version 2

WhatÕs New 1-4
Specifications

Macintosh computer requirements 2-7
Windows-compatible computer 2-8

Spectral emission scan 1-17
Spectral excitation scan 1-17
SPECTRAmax

connection to Macintosh 2-3
connection to PC 2-4

Spectrum 1-3, 4-15, 4-29, 5-37
display defaults 5-6

Speed Read 4-20
Standard curve 5-65, 7-28
Standards, minimum number 5-65
Start and End (wavelengths) 5-37
Stationery file 7-18
Status bar 3-4, 3-7, 4-57
Stokes shift 1-25
Strips 4-24, 4-35
Summary 5-47, 5-48

adding/editing 5-42, 5-47
aligning 5-47
formula 5-47
line up with column 5-47
moving 5-47
plot 5-48

Suspend Recalculation (command) 3-29, 5-41

T
Temperature display 3-7
Template 3-9, 4-38

blanks 4-50
clear 1-14, 6-24
command 3-32, 3-34
copy/paste 4-51, 6-23
groups 4-36, 4-37
hierarchy 4-37
import/export 6-21
samples 4-37
selecting wells 4-38
series 4-46

fill direction 4-47
Template Editor 3-32, 3-34, 4-36, 4-38, 7-8

Group area 4-39
tool bar 4-39

Text
format 6-15

Text Style (command) 3-29, 6-15
THERMOmax

connection to Macintosh 2-4
connection to PC 2-6

Threshold display 5-15
Time at 1/2 Maximum 5-36
Time at Half Maximum 1-25
Time at Maximum 1-25, 5-36
Time at Minimum 1-25, 5-36
Time to Vmax 4-14, 4-28, 5-35
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Time-resolved fluorescence 1-25
Title Bar 1-26
Title screen 2-12, 2-13, 3-3
Tool bar 3-10
Transmittance (%T) 1-16, 4-13, 4-15, 4-23, 5-12, 

5-18, 5-25, 5-37, 5-38, 6-20
Transmittance(%T) 1-4, 1-16, 1-24, 1-26
Troubleshooting

Technical Services 1-12

U
Undo (command) 1-26, 3-28
Uninstall 2-11
Units (group) 7-8
UVmax

connection to Macintosh 2-4
connection to PC 2-6

V
Vertical Display 1-26
View menu 3-30
V-line (pattern) 4-15
Vmax 4-14, 4-28, 5-34

connection to Macintosh 2-4
connection to PC 2-6

Vmax (kinetic reduction) 5-34
Vmax Points 5-18, 5-30, 5-31, 5-34, 5-35

W
Wavelengths 4-15

Spectrum 4-19, 4-31
Well graph 5-18, 5-21

printing 5-21, 6-12
Well scan 1-4, 4-15

Density setting 4-16
pattern 4-15

Wells
graphing 5-18
masking 5-22
selecting in template 4-38

Window
active 1-13, 3-26, 3-33
Page Setup command 3-6
scroll bar 3-10
size 3-6, 3-12
sizing 5-21

Windows-compatible computer 
requirements 2-8

X
X-axis (command) 3-36, 5-68

Y
Y-axis (command) 3-36, 5-68

Z
Zoom box 5-21


